WinCC, SIMATIC, SINEC, STEP are Siemens registered trademarks.

All other product and system names in this manual are (registered) trademarks of their respective owners and must be treated accordingly.

(We have checked the contents of this manual for agreement with the hardware and software described. Since deviations cannot be precluded entirely, we cannot guarantee full agreement. However, the data in this manual are reviewed regularly and any necessary corrections included in subsequent editions. Suggestions for improvement are welcomed.)

© Siemens AG 1994 - 1999 All rights reserved  Technical data subject to change

C79000-G8276-C139-01  Siemens Aktiengesellschaft
# Table of Contents

## 1 Configuration Manual

1.1 Configuration Manual - Information about Structure and Application .......................... 1-2

## 2 WinCC - General Information

2.1 WinCC - The Concept ................................................................................... 2-2
2.2 WinCC - Terms and Abbreviations ......................................................... 2-6

## 3 Configuration - General Subjects

3.1 Before beginning the project ........................................................................... 3-2
3.2 Specifications in detail.............................................................................. 3-3
3.2.1 Specification: WinCC project name ..................................................... 3-4
3.2.2 Specification: tag names .................................................................. 3-5
3.2.3 Specification: picture names ............................................................ 3-7
3.2.4 Specification: scripts and actions ....................................................... 3-10
3.2.5 Specification: the user interface ......................................................... 3-11
3.2.6 the control concept ....................................................................... 3-17
3.2.7 Specification: color definition .......................................................... 3-19
3.2.8 Specification: the update cycles ......................................................... 3-20
3.2.9 Specification: the user rights ............................................................ 3-21
3.2.10 Specification: alarm message reporting .......................................... 3-22
3.2.11 Specification: implementation ....................................................... 3-23

3.3 Peculiarities of configuration using WinCC ........................................... 3-24
3.3.1 Update cycles - how and where you set them ..................................... 3-25
3.3.1.1 Updating in the picture ................................................................ 3-25
3.3.1.2 Types of update cycle .................................................................. 3-27
3.3.1.3 What the update cycles mean ...................................................... 3-28
3.3.1.4 Instructions on how to use the update cycles ............................... 3-30
3.3.1.5 Executing background scripts (Global Script) ............................... 3-35
3.3.2 Dynamization in WinCC ................................................................. 3-39
3.3.2.1 Dynamizing the properties ............................................................ 3-39
3.3.2.2 Dynamizing the events ................................................................. 3-40
3.3.2.3 Types of dynamization for objects ................................................ 3-41
3.3.3 WinCC system environment ............................................................. 3-43
3.3.3.1 Folder structure of the WinCC system .......................................... 3-43
3.3.3.2 WinCC project environment ........................................................ 3-47
3.3.3.4.1 WinCC project folder structure ............................................ 3-47
3.3.4 Automatic WinCC project startup ..................................................... 3-50
3.3.6 Coordinated exiting of WinCC .......................................................... 3-53
3.3.7 Data backup ................................................................................ 3-54
3.3.8 Copying a backed-up WinCC project to a new destination computer ......................................................... 3-56
Table of Contents

| 3.3.9 | Reuse - reusing parts of a project in a new or existing project | 3-59 |
| 3.3.9.1 | Taking over pictures | 3-60 |
| 3.3.9.2 | Taking over symbols and bit maps | 3-62 |
| 3.3.9.3 | Taking over a project library (with preconfigured symbols and user objects) | 3-63 |
| 3.3.9.4 | Taking over global actions | 3-65 |
| 3.3.9.5 | Taking over tags | 3-66 |
| 3.3.9.6 | Taking over multilingual texts (from pictures, in messages) | 3-75 |
| 3.3.9.7 | Taking over messages | 3-76 |
| 3.3.9.8 | Taking over measured values | 3-79 |
| 3.3.9.9 | Taking over print layouts | 3-80 |
| 3.3.9.10 | Taking over global actions | 3-80 |
| 3.3.9.11 | Taking over project functions | 3-80 |
| 3.3.9.12 | Using standard functions | 3-80 |
| 3.3.9.13 | Taking over user administration | 3-80 |

| 3.3.10 | Working without a mouse | 3-81 |
| 3.3.10.1 | Working with a keyboard | 3-81 |
| 3.3.10.2 | Moving around by means of control objects (input fields and control fields) | 3-86 |
| 3.3.10.3 | Alarm Logging function keys for the toolbar buttons | 3-89 |
| 3.3.10.4 | Alarm Logging - toolbar buttons designed specifically for a plant | 3-92 |
| 3.3.10.5 | Tag Logging function keys for the toolbar buttons | 3-93 |
| 3.3.10.6 | Starting a print job | 3-95 |
| 3.3.10.7 | Logging in or out | 3-97 |

| 3.3.11 | Module technology | 3-98 |
| 3.3.11.1 | Process box as a picture module | 3-99 |
| 3.3.11.2 | Picture module with indirect addressing | 3-101 |
| 3.3.11.3 | User objects | 3-103 |
| 3.3.11.4 | Dynamic instance (linking prototype to a structure) | 3-104 |
| 3.3.11.5 | Prototype pictures | 3-105 |
| 3.3.11.6 | OCX objects | 3-110 |

| 3.3.12 | Online configuration (runtime) - notes and restrictions | 3-111 |

4 WinCC - C Course ........................................................................ 4-1

| 4.1 | The development environment for scripts in WinCC | 4-3 |
| 4.1.1 | Functions and actions in WinCC | 4-4 |
| 4.1.2 | The editors for functions and actions | 4-9 |
| 4.1.3 | Creating functions and actions | 4-12 |
| 4.1.4 | Testing functions and actions | 4-14 |
| 4.1.5 | Importing/exporting functions and actions | 4-16 |

| 4.2 | Tags in C | 4-17 |
| 4.2.1 | Example 1 - Using tag types | 4-21 |
| 4.2.2 | Example 2 - C tags in connection with WinCC tags | 4-23 |
| 4.2.3 | Example 3 - Using tags | 4-25 |

| 4.3 | Operators and mathematical functions in C | 4-27 |
4.3.1 Boolean algebra ................................................................. 4-29
4.3.1.1 Basic logic functions ....................................................... 4-29
4.3.2 Example 1 - Using operators of the basic arithmetic operations ... 4-31
4.3.3 Example 2 - Mathematical functions ...................................... 4-33
4.3.4 Example 3 - Operators for bit operations .............................. 4-35

4.4 Pointers in C .............................................................................. 4-37
4.4.1 Example 1 - Pointers ............................................................ 4-39
4.4.2 Example 2 - Pointers in connection with WinCC tags ............ 4-41
4.4.3 Example 3 - Pointers in connection with string processing ...... 4-43

4.5 Loops and conditional statements in C ......................................... 4-44
4.5.1 Example 1 - while loop ......................................................... 4-47
4.5.2 Example 2 - do - while loop ................................................. 4-49
4.5.3 Example 3 - for loop ............................................................ 4-51
4.5.4 Example 4 - Conditional statement with if ......................... 4-53
4.5.5 Example 5 - Conditional statement with switch and case ...... 4-55
4.5.6 Example 6 - Using static tags with conditional statement and return value .................................................. 4-57
4.5.7 Example 7 - Using static tags with conditional statement and return value .................................................. 4-58

4.6 File operations in C ..................................................................... 4-59
4.6.1 Example 1 - Opening, writing to and closing a file .................. 4-61
4.6.2 Example 2 - Opening, appending to and closing a file ............ 4-63
4.6.3 Example 3 - Opening, reading and closing a file ..................... 4-65
4.6.4 Example 4 - Deleting a file .................................................... 4-67

4.7 Structures in C ............................................................................ 4-68
4.7.1 Example 1 - Structures in C ................................................... 4-70
4.7.2 Example 2 - C structures in connection with WinCC ............. 4-72

4.8 Global Scripts ............................................................................. 4-74
4.8.1 Example 1 - Using a project function .................................... 4-75
4.8.2 Example 2 - Using project functions, further examples ........... 4-77

4.10 Displaying the source code by clicking the right mouse button ...... 4-80

5 Appendix .................................................................................... 5-1
5.1 Tips and tricks ............................................................................. 5-2
5.1.1 Standard input/output at I/O field ............................................ 5-3
5.1.2 Object-specific actions upon Open Picture ............................. 5-4
5.1.3 WinCC Scope ......................................................................... 5-5
5.1.4 Accessing the database .......................................................... 5-6
5.1.4.1 Accessing the database from Excel/MSQuery .................. 5-6
5.1.4.2 Accessing the database from Access .................................. 5-9
5.1.4.3 Accessing the database from ISQL ..................................... 5-10
5.1.4.4 Accessing the database from WinCC Scope ...................... 5-11
5.1.4.5 Exporting from a database using C actions ..................... 5-12
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1.4.6 Database selections</td>
<td>5-13</td>
</tr>
<tr>
<td>5.1.5 Serial connection</td>
<td>5-14</td>
</tr>
<tr>
<td>5.1.6 Color table</td>
<td>5-15</td>
</tr>
<tr>
<td>5.2 Documentation of S5 Alarm Logging</td>
<td>5-16</td>
</tr>
<tr>
<td>5.2.1 List of software blocks</td>
<td>5-17</td>
</tr>
<tr>
<td>5.2.2 Hardware requirements</td>
<td>5-18</td>
</tr>
<tr>
<td>5.2.3 Embedding S5 alarm logging in the SIMATIC-S5 user program</td>
<td>5-19</td>
</tr>
<tr>
<td>5.2.4 General description of S5 alarm loggings</td>
<td>5-21</td>
</tr>
<tr>
<td>5.2.4.1 Structure of offset data block</td>
<td>5-22</td>
</tr>
<tr>
<td>5.2.4.2 Basic message number</td>
<td>5-23</td>
</tr>
<tr>
<td>5.2.4.3 Offset message number/signal conditions of messages</td>
<td>5-23</td>
</tr>
<tr>
<td>5.2.4.4 Signal condition block</td>
<td>5-25</td>
</tr>
<tr>
<td>5.2.4.5 Address of the last signal condition block</td>
<td>5-25</td>
</tr>
<tr>
<td>5.2.4.6 Signal conditions</td>
<td>5-26</td>
</tr>
<tr>
<td>5.2.4.7 Idle conditions</td>
<td>5-27</td>
</tr>
<tr>
<td>5.2.4.8 Acknowledgement bits</td>
<td>5-27</td>
</tr>
<tr>
<td>5.2.4.9 Edge-triggered flags</td>
<td>5-27</td>
</tr>
<tr>
<td>5.2.4.10 Structure of the parameter data block</td>
<td>5-27</td>
</tr>
<tr>
<td>5.2.4.11 Message block structure</td>
<td>5-29</td>
</tr>
<tr>
<td>5.2.4.12 Message number</td>
<td>5-30</td>
</tr>
<tr>
<td>5.2.4.13 Message status</td>
<td>5-30</td>
</tr>
<tr>
<td>5.2.4.14 Date/time stamp</td>
<td>5-30</td>
</tr>
<tr>
<td>5.2.4.15 Process variable</td>
<td>5-30</td>
</tr>
<tr>
<td>5.2.4.16 Job number/batch identifier</td>
<td>5-31</td>
</tr>
<tr>
<td>5.2.4.17 Reserve</td>
<td>5-31</td>
</tr>
<tr>
<td>5.2.4.18 Construction of a message block</td>
<td>5-31</td>
</tr>
<tr>
<td>5.2.4.19 The internal FIFO buffer</td>
<td>5-31</td>
</tr>
<tr>
<td>5.2.4.20 The send mailbox - data transfer to the higher-level WinCC system</td>
<td>5-32</td>
</tr>
<tr>
<td>5.2.5 Interface description</td>
<td>5-33</td>
</tr>
<tr>
<td>5.2.5.1 System data block 80</td>
<td>5-33</td>
</tr>
<tr>
<td>5.2.5.2 Offset data block</td>
<td>5-33</td>
</tr>
<tr>
<td>5.2.5.3 Parameter data block</td>
<td>5-33</td>
</tr>
<tr>
<td>5.2.5.4 Send mailbox/transfer mailbox</td>
<td>5-34</td>
</tr>
<tr>
<td>5.2.6 Assigning parameters to S5 alarm logging/system DB 80</td>
<td>5-35</td>
</tr>
<tr>
<td>5.2.7 S5 alarm logging configuration example</td>
<td>5-41</td>
</tr>
<tr>
<td>5.2.7.1 Parameter assignment DB 80</td>
<td>5-41</td>
</tr>
<tr>
<td>5.2.7.2 Creating data blocks</td>
<td>5-42</td>
</tr>
<tr>
<td>5.2.7.3 Initializing offset data blocks</td>
<td>5-43</td>
</tr>
<tr>
<td>5.2.8 Documentation of the SIMATIC S5 command blocks</td>
<td>5-46</td>
</tr>
<tr>
<td>5.2.8.1 List of software blocks</td>
<td>5-46</td>
</tr>
<tr>
<td>5.2.8.2 Hardware requirements</td>
<td>5-47</td>
</tr>
<tr>
<td>5.2.8.3 Call parameters of FB 87: EXECUTE</td>
<td>5-47</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>5.2.9</td>
<td>Interface description</td>
</tr>
<tr>
<td>5.2.9.1</td>
<td>Example configuration for the S5 command blocks</td>
</tr>
<tr>
<td>5.2.10</td>
<td>Purpose and function of S5-time synchronization</td>
</tr>
<tr>
<td>5.2.10.1</td>
<td>List of software blocks</td>
</tr>
<tr>
<td>5.2.10.2</td>
<td>Hardware requirements</td>
</tr>
<tr>
<td>5.2.11</td>
<td>Call parameters of FB 86: MELD:UHR</td>
</tr>
<tr>
<td>5.2.12</td>
<td>Data formats for date and time</td>
</tr>
<tr>
<td>5.2.12.1</td>
<td>Time data area CPU 944, CPU 945</td>
</tr>
<tr>
<td>5.2.12.2</td>
<td>Time data area CPU 928B, CPU 948</td>
</tr>
<tr>
<td>5.2.12.3</td>
<td>Time data area CPU 946, CPU 947</td>
</tr>
<tr>
<td>5.2.12.4</td>
<td>Clock data format for message blocks</td>
</tr>
<tr>
<td>5.2.13</td>
<td>Interface description</td>
</tr>
<tr>
<td>5.2.14</td>
<td>Interaction with WinCC alarm logging</td>
</tr>
<tr>
<td>5.3</td>
<td>Format DLL interface to AlarmLogging and TagLogging</td>
</tr>
<tr>
<td>5.3.1</td>
<td>Shared interface to AlarmLogging and TagLogging</td>
</tr>
<tr>
<td>5.3.2</td>
<td>TagLogging-specific extras</td>
</tr>
<tr>
<td>5.3.3</td>
<td>API functions of a WinCC Format DLL</td>
</tr>
<tr>
<td>5.3.3.1</td>
<td>Initialization of the Format DLL</td>
</tr>
<tr>
<td>5.3.3.2</td>
<td>Polling the properties of a Format DLL</td>
</tr>
<tr>
<td>5.3.3.3</td>
<td>Polling the name of the Format DLL</td>
</tr>
<tr>
<td>5.3.4</td>
<td>Shutting down the Format DLL</td>
</tr>
<tr>
<td>5.3.4.1</td>
<td>Configuration add-ins</td>
</tr>
<tr>
<td>5.3.4.2</td>
<td>Dialog box extension when configuring S7PMC messages</td>
</tr>
<tr>
<td>5.3.4.3</td>
<td>Dialog box extension when configuring archive tags</td>
</tr>
<tr>
<td>5.3.4.4</td>
<td>Online services</td>
</tr>
<tr>
<td>5.3.4.5</td>
<td>Register all archive tags</td>
</tr>
<tr>
<td>5.3.4.6</td>
<td>Language change</td>
</tr>
<tr>
<td>5.3.5</td>
<td>Formatting</td>
</tr>
<tr>
<td>5.3.5.1</td>
<td>Derivation of single messages</td>
</tr>
<tr>
<td>5.3.5.2</td>
<td>Acknowledging, disabling/to enabling messages</td>
</tr>
<tr>
<td>5.3.5.3</td>
<td>Processing upon change of status</td>
</tr>
<tr>
<td>5.3.5.4</td>
<td>Message update of the S7PMC Format DLL</td>
</tr>
<tr>
<td>5.3.5.5</td>
<td>Formatting archive tags</td>
</tr>
<tr>
<td>5.3.5.6</td>
<td>Derivation of individual archive tag values</td>
</tr>
<tr>
<td>5.3.5.7</td>
<td>Disabling/enabling archive tags</td>
</tr>
<tr>
<td>5.3.5.8</td>
<td>Processing upon change of status</td>
</tr>
<tr>
<td>5.4</td>
<td>Creating picture modules for WinCC</td>
</tr>
<tr>
<td>5.5</td>
<td>Global Library</td>
</tr>
<tr>
<td>5.5.1</td>
<td>Shut-off devices</td>
</tr>
<tr>
<td>5.5.2</td>
<td>Shut-off valves</td>
</tr>
</tbody>
</table>
## Table of Contents

### 5.5.3 Smart objects
- 5.5.3.1 Displays
- 5.5.3.2 Slider panels
- 5.5.3.3 Incr_Decr buttons
- 5.5.3.4 Pipes
- 5.5.3.5 Tanks
- 5.5.3.6 Toggle buttons
- 5.5.3.7 Valves
- 5.5.3.8 Meters

### 5.5.4 Button pictures

### 5.5.5 Buttons 3D

### 5.5.6 Buttons language

### 5.5.7 DIN30600

### 5.5.8 E symbols

### 5.5.9 Windows

### 5.5.10 Conveyors

### 5.5.11 ISA symbols
- 5.5.11.1 isa_s55a
- 5.5.11.2 isa_s55b
- 5.5.11.3 isa_s55c
- 5.5.11.4 isa_s55d
- 5.5.11.5 isa_y32a
- 5.5.11.6 isa_y32b
- 5.5.11.7 isa_y32c
- 5.5.11.8 isa_y32d
- 5.5.11.9 isa_y32e
- 5.5.11.10 isa_y32f
- 5.5.11.11 isa_y32g
- 5.5.11.12 isa_y32h
- 5.5.11.13 isa_y32i

### 5.5.12 Keyboards

### 5.5.13 Motors

### 5.5.14 Motors 3D

### 5.5.15 PC / PLC

### 5.5.16 Pumps

### 5.5.17 Controller

### 5.5.18 Pipes

### 5.5.19 Scaling

### 5.5.20 Text fields

### 5.5.21 Valves

### 5.5.22 Valves 3D
Preface

Purpose of this Manual

This manual introduces you to the configuration possibilities of WinCC using the following sections:

- a general section about WinCC and its configuration
- an introduction to script processing
- an appendix

The table of contents and the index allow you to quickly find needed information. All the information can also be found in the online documentation (HTML format) which includes additional search functions.

Descriptions of sample projects for an effective and efficient configuration with WinCC can be found in the *WinCC Configuration Manual Volume 2*.

Prerequisites for using this Manual

Knowledge of WinCC (Getting Started) or practical configuration experience using WinCC.

Additional Support

For technical questions, please contact your local Siemens representative at the responsible branch office.

Their addresses can be found at the "Siemens World Wide Appendix" of the "S7-300 Programmable Controller System, Hardware and Installation Manual", in catalogs, and at CompuServe ("go autforum").

You can also direct your questions to our Hotline, which can be reached at: +49 (911) 895-7000 (Fax 7001).

Additional information can be found on the Internet at the address: www.aut.siemens.de/coros/html_00/coros.htm.
Information about SIMATIC Products

Continuously updated information about SIMATIC products can be obtained:

- from the Internet at http://www.aut.siemens.de/
- via fax back service at 08765–93 02 77 95 00

Additionally, the SIMATIC Customer Support provides you with current information and downloads helpful for the application of SIMATIC products. They can be reached:

- from the Internet at http://www.aut.siemens.de/support/html_00/index.shtml
- via the SIMATIC Customer Support Mailbox at +49 (911) 895–7100
- To access the mailbox, use a modem up to V.34 (28.8 kBaud). Set its parameters as follows: 8, N, 1, ANSI, or dial-in via ISDN (x.75, 64 kBit).

The SIMATIC Customer Support can be reached by phone at +49 (911) 895–7000 and by fax at +49 (911) 895–7002. Inquiries can also be made via Internet mail or to the above mailbox.
1 Configuration Manual

The configuration manual is part of the WinCC documentation and is primarily concerned with the practical application of WinCC in projects.

Introduction

This introduction provides you with general information about procedures for realizing HMI projects (Human Machine Interface). Only a few years ago, HMI systems were referred to as operations and monitoring systems.

In the last few years, the requirements for a system that monitors and controls production processes, as well as archives and processes production data, have increased dramatically. To meet those requirements, new HMI systems have been developed.

One of these new systems is WinCC. WinCC certainly is unique, considering its functionality, openness, and up-to-dateness of software technology.

Older generation HMI systems often provided only one way to solve a task. WinCC, on the other hand, almost always gives you multiple solution options. This configuration manual has been written to illustrate the best solution approaches taking into account performance and extent of configuration work.

This description provides you with solution suggestions for the effective utilization of WinCC in plant projects.

We have realized these solution suggestions in WinCC sample projects. These sample projects are contained on the WinCC CD-ROM. You can directly incorporate these solution suggestions into your projects and save valuable time.
1.1 Configuration Manual - Information about Structure and Application

Prerequisite

You should already have practical experience with WinCC before working with this configuration manual. For WinCC newcomers, the Getting Started is an ideal introduction. The "Getting Started" covers the most important topics and illustrates them in a sample project. This configuration manual is an addition to the WinCC help system (online and documentation). Special features of objects, properties, and topics are described by the help system, if they were not explained in the configuration manual.

| Note: | The project environment and dynamization types of WinCC 3.3 Peculiarities of configuration using WinCC are explained in the chapter. |

Contents and Structure

The configuration manual is divided into six main chapters.
- The first chapter contains the preface, introduction, and general information about this manual.
- The second chapter contains general information about WinCC.
- The third chapter contains general and specific information for a structured and effective implementation of HMI projects.
- The fourth chapter contains a WinCC C language course. For beginners, it contains the most important rules for the application of the WinCC script language. For C experts, the special characteristics of the development environment are described.
- The sixth chapter contains the appendix with subjects, from WinCC Solutions and Tips & Tricks, that have not been explained in the sample projects.
Conventions

The configuration manual uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Important</td>
<td>Important text passages are shown in bold.</td>
</tr>
<tr>
<td>Names</td>
<td>Dialog box names, buttons, and field names are shown in italics.</td>
</tr>
<tr>
<td>Inputs</td>
<td>Inputs are shown in italics and blue.</td>
</tr>
<tr>
<td>Menu → Sub Menu → etc.</td>
<td>Selections via menus are shown in italics and blue. The arrow indicates the operating sequence.</td>
</tr>
<tr>
<td>Program</td>
<td>C-scripts are always shown in this format:</td>
</tr>
<tr>
<td>int</td>
<td>In C-scripts, keywords are shown in blue.</td>
</tr>
<tr>
<td>&quot;Text&quot;,&quot;z&quot;</td>
<td>In C-scripts, the character strings and individual characters are shown in red.</td>
</tr>
<tr>
<td>Comments</td>
<td>In C-scripts, the comments are shown in a smaller and cyan colored font.</td>
</tr>
<tr>
<td>By the System</td>
<td>Program parts that are preset by the system can not be changed.</td>
</tr>
<tr>
<td>✓</td>
<td>Operation with the left mouse button.</td>
</tr>
<tr>
<td>✓ R</td>
<td>Operation with the right mouse button.</td>
</tr>
<tr>
<td>✓ D</td>
<td>Double click with the left mouse button.</td>
</tr>
<tr>
<td>Note</td>
<td>Notes are shaded in gray.</td>
</tr>
</tbody>
</table>

How to find Information

The table of contents is organized by subject.

Information by keyword can be found from the index.

In the online documentation, the Find tab contains almost all words listed in alphabetical order. A ✓ D on the desired word displays all chapters containing the word.
2 WinCC - General Information

This section describes the structure, concept, and working method of WinCC in greater detail.
2.1 WinCC - The Concept

In general, WinCC offers you three solution approaches for a configuration:

- using WinCC standard tools
- using existing Windows applications with WinCC via DDE, OLE, ODBC, and ActiveX
- using Visual C++ or Visual basic to develop your own applications embedded into WinCC

For some, WinCC is the HMI system for fast and cost-effective configurations, for others it is an infinitely expandable system platform. The modularity and flexibility of WinCC gives you completely new possibilities for planning and implementing automation tasks.

The Operating System: Basics Of WinCC

WinCC is based on Microsoft’s 32-bit operating systems (currently Windows 95 and Windows NT 4.0). These are the standard operating systems of the PC platform.

The modular Structure of WinCC

WinCC offers system modules for the visualization, messaging, acquisition, and archiving of process data, as well as for the coordinated integration of user defined application routines.
You can also integrate your own modules.
2.1.1 The Interfaces of WinCC

The Openness of WinCC

WinCC is completely open to any user add-on. This openness is accomplished through WinCC's modular structure and its powerful programming interface.

The following picture illustrates the connection possibilities of various applications.

Integration of External Applications into WinCC

WinCC gives you options to integrate other applications and application modules **uniformly into the operator interface of the process**.

As pictured below, OLE application windows and OLE Custom Controls (32-bit OCX objects) / ActiveX Controls can be integrated into WinCC applications as if they were WinCC objects.
WinCC Data Maintenance

In the following diagram, WinCC makes up the entire middle section. The diagram shows that the **Sybase SQL Anywhere standard database** is subordinate to WinCC. This database is used to store (transaction-secured) list-oriented configuration data (e.g. tag lists, message texts), as well as current process data (e.g. messages, measured values, user data records). The database has server functionality. WinCC can access the database via ODBC or the open programming interface (C-API) as a client.

Other programs can, of course, do the same. This gives a **Windows spreadsheet** or a **Windows database** direct access to the data of the WinCC database, regardless of whether the application is executed on the same computer or on a networked station. With the help of the database query language SQL and the appropriate Connectivity Tools (e.g. ODBC driver), other clients (for example **UNIX based databases** like Oracle, Informix, Ingres, etc.) can have access to the WinCC database. This also works the other way around. Nothing should stand in the way of **integrating WinCC into a process or company wide concept**.
2.2 WinCC - Terms and Abbreviations

This section contains a collection of terms about WinCC in alphabetical order. Many of these terms are probably already known to you:

- **HMI**: Human Machine Interface
- **PLC**: Programmable Logic Controller
- **CS**: Configuration System
- **RT**: Runtime
3 Configuration - General Subjects

In this section, you will find a great deal of information, instructions and ideas on how to manage projects using WinCC. Some of this information is not specific to WinCC. Ideally, these stipulations (configuration rules) should have the same quality as a style guide for configuring and designing runtime projects.
3.1 Before beginning the project

Before you begin with configuration, you should lay down a number of specifications and conduct some structuring work. This:

- simplifies configuration
- improves the clarity of the project
- simplifies working as a team
- improves stability and performance
- simplifies maintenance of the projects

Clear specification of the structural guidelines is a basic prerequisite for the setting-up or expansion of a corporate standard.

These specifications can be divided into two categories:

Specifications for configuration

Before you configure, you should specify the following:
- specify the name of the WinCC project
- specify the names of the tags.
- specify the names of the WinCC pictures.
- specify rules for creating the scripts and actions.
- specify rules for configuration (corporate standards, library function, working in a team).
- specify the mode and method of documenting the project.

Specifications for runtime project

Specifications which relate to the runtime project (result of configuration). These specifications depend heavily on the application (e.g. automobile industry, chemicals, machinery manufacturers). The following specifications should be performed:
- specify the user interface (screen layout, font and font size, language in runtime, representation of the objects).
- specify the control concept (picture hierarchy, control philosophy, user rights, valid keys).
- specify the colors to be used for messages, limit values, states, text etc.
- specify the modes of communication (type of connection, type of and cycles for updating).
- specify the typical application specification (number of alarms, archive values, trends, clients etc.).
- specify the logging and archiving methods.
3.2 Specifications in detail

In this section of the manual, we will lay down specifications which we will use in our sample projects. These specifications are intended to be used as a type of template when creating your own projects.

**Note:**
In our sample projects, the names of projects, pictures, tags and comments in the scripts are in English.

Defaults of the configuration tools

In most of the editors in WinCC, certain properties can be set by means of defaults. In this way, WinCC supports your own particular style of configuration and can therefore be optimally configured for specific tasks.

**Note:**
An example of this are the options under *Graphics Designer → Tools → Settings...*. You can find a detailed description of this topic in the online Help of the *Graphics Designer*. 
3.2.1 Specification: WinCC project name

General
The name of a WinCC project is also suggested as the default name for the folder in which all the data is stored. You can change the folder name when initially creating the project or at a later stage (in Windows Explorer).

Parameters / limits
With the exception of certain special characters - for example, \ ? ' ; / - all characters are allowed. Numerical values from 0 to 9 are likewise allowed.

Specification
In the example projects described in the second part of the Configuration Manual, the following specification applies to the project name:

a...a_nn
where:

a Type designation (a-z, A-Z, no special characters).
_n Serial number to distinguish between a number of projects of one type; numbers 0 to 9, range 00 to 99.

Example: cours_00.mcp or pictu_01.mcp

Notes on general use
The WinCC project name can be used, for example, to distinguish between different sections of plant.

Note:
When updating the documentation, you can print out the project name in the printouts. This makes it easier to associate and find information.
3.2.2 Specification: tag names

General

Tag names are no longer restricted to a maximum of 8 characters. Despite this, you should avoid making them too long. If you adhere to strict rules when allocating tag names, you will find this to be tremendously advantageous during configuration.

When creating WinCC projects, structuring tag management is one of the key tasks necessary to ensure quick and effective configuration and high-performance processing during runtime (in scripts).

Before defining the tag names, you must take a number of special characteristics relating to the structuring of tag management in WinCC into consideration. Creating groups only affects the way in which tags are displayed in the tag management during configuration. Group names in now affect the uniqueness of the tag names. The tag names used in a WinCC project must be unique. Their uniqueness is verified by the system.

WinCC helps you select tags in many different ways, e.g. through sorting according to columns (names, creation date, etc.) or through the use of filters. However, you may find it useful if the tag name contains additional information.

Specification

The following specifications apply to tag names used in the sample projects dealt with in this manual:

```
xxxy_z...z_a...a_nn
```

where:

<table>
<thead>
<tr>
<th>x</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIN</td>
<td>Binary tag</td>
</tr>
<tr>
<td>U08</td>
<td>Unsigned 8-bit value(unsigned)</td>
</tr>
<tr>
<td>S08</td>
<td>Signed 8-bit value(signed)</td>
</tr>
<tr>
<td>U16</td>
<td>Unsigned 16-bit value</td>
</tr>
<tr>
<td>S16</td>
<td>Signed 16-bit value</td>
</tr>
<tr>
<td>U32</td>
<td>Unsigned 32-bit value</td>
</tr>
<tr>
<td>S32</td>
<td>Signed 32-bit value</td>
</tr>
<tr>
<td>G32</td>
<td>Floating-point number 32-bit IEEE 754</td>
</tr>
<tr>
<td>G64</td>
<td>Floating-point number 64-bit IEEE 754</td>
</tr>
<tr>
<td>T08</td>
<td>Text tag 8-bit character set</td>
</tr>
<tr>
<td>T16</td>
<td>Text tag 16-bit character set</td>
</tr>
<tr>
<td>ROH</td>
<td>Raw data type</td>
</tr>
<tr>
<td>TER</td>
<td>Text reference</td>
</tr>
<tr>
<td>STU</td>
<td>Structure types</td>
</tr>
</tbody>
</table>
y Origin
r pure read tag from the PLC (read)
w write and read tag from the PLC (write)
i internal tag in WinCC without link to PLC
x Tag with indirect addressing (a text tag containing a tag name)

_z Group (corresponds to plant sections or buildings)
_Lack ... e.g. name of the plant section
_a Tag name - for example, name of measurement point
_EU0815V10 ... e.g. name of the measurement point
_n Serial number of the instance; numbers 0 to 9, range 00 to 99.

Parameters / limits
The following restrictions apply when assigning tag names:
• The special character @ should be reserved for WinCC system tags, the use of this character is possible in principle, however.
• The special characters ’ and % cannot be used.
• The special character " and the character string // should not be used since they have a special meaning in C scripts (introduction or termination of a character string and introduction of a comment).
• no spaces.
• no distinction is made between uppercase and lowercase letters in tag names.

Notes on general use
The tag names assigned in our examples are only suggestions.
When using the tags in scripts and Excel, you may find it useful to keep to a fixed length for the separate parts of the tag name (if necessary, using 0 or x as a filler).
Large quantities of tags can be created and maintained very effectively and simply in, for example, Excel. If the tag names have a fixed structure, it is considerably easier to create the tag lists in Excel. You can then import these tag lists created in Excel into the current WinCC project using the program \SmartTools\CC_TagImportExport\Var_exim.exe which is on your WinCC CD.
3.2.3 Specification: picture names

General

If you want to address pictures in scripts or external programs, you will find it very helpful to use a fixed structure when assigning the picture names. You should also put some thought into deciding on the length of the picture names. Names (file names) that are too long are more likely to hinder clarity (making selections in list boxes, calls in scripts, etc.). Experience has shown a maximum length of 40 characters to be advisable.

Parameters / limits

The following restrictions apply when assigning picture names:

- maximum length of 255 characters.
- any characters apart from specific special characters - for example, / " \ ? < >.
- no distinction is made between uppercase and lowercase letters in picture names.

Specification

The following specifications apply to picture names used in the projects dealt with in this manual:

aaaaa_k_x...x_nn

where:

a     Picture identification (a-z, A-Z, no special characters) for grouping of the pictures. course... e.g. name of the pictures in the C course

_k    Picture type, identification of the picture type 0 to 99
   _0   Start picture
   _1   Overview picture
   _2   Button picture
   _3   Plant picture
   _4   Detail picture
   _5   Message picture
   _6   Trend picture
   _7   ...
   _8   ...
   _9   Diagnostic pictures (for testing or commissioning only)

_x    Name for describing the picture function (a-z, A-Z, no special characters), maximum of 30 characters long.
   _chapter ... e.g. name of the chapters in the C course

_n    Serial number of the type; numbers 0 to 9, range 0 to 99.
Notes on general use

The picture names assigned in our examples are only suggestions. You must, however, use the name convention we use for some of the scripts supplied.
3.2.4 Specification: scripts and actions

General
You can create your own scripts and actions in WinCC projects. The names you assign should be of an explanatory nature. This makes things a lot easier when using scripts later.

Using a proportional font tends to be a nuisance when configuring in the Global Script (editor). For this reason, choose a font with a constant character width (e.g. Courier) to make things easier to read.

The scripts should be accompanied by appropriate and adequate comments. The amount of time spent writing comments is out of all proportion compared with the amount of time you need to comprehend a badly commented program. Although this fact is well appreciated by all, it is still often ignored.

Specification
The following specifications apply to scripts used in the projects dealt with in this manual:
We use the proportional font Courier New in size 8;
all tag names and comments are in English.

Notes on general use
You will find a detailed description of how to use scripts, actions and editors in Section 4.1 The development environment for scripts in WinCC.
3.2.5 Specification: the user interface

General

It is essential that you take the greatest of care when setting up the user interface. All objects created in the Graphics Designer are displayed on the screen in the user's office. The pictures created are the only interface between the machine and the user. For this reason, you must take great care creating them since they play an important role in ensuring the success of a project. It goes without saying that operation of the plant is more important than the appearance of the screen but in the long term sloppily created pictures can mar the impression made by and possibly even increase the costs of maintaining plant that has otherwise been well thought out.

These are the pictures that the users (customers) see every day.

In a screen display system, information about the current status of the plant is presented to the users solely by means of the pictures displayed. This interface must, therefore, provide information in as comprehensive and easily understood a manner as possible.

WinCC allows you to configure the user interface precisely as you want it. How you lay out the user interface of your own particular system depends on the hardware you use, on the demands during processing and on specifications that already exist.

The users

When you are configuring the user interface, you must make the users, for whom configuration is after all being performed, the focus of your contemplations.

If you succeed in giving the users the information they need and do so in a clear manner, the result will be a higher level of quality in production and fewer failures. The amount of maintenance work necessary will also be reduced.

The users need as much information as they can get. Using this data as the foundation, the users can take the decisions that are essential to keeping the process running and with a high level of quality. The main job of the users is not to respond to alarms (the process has then already been thrown off balance), but to use their experience, knowledge of the process and the information provided by the operating system to predict the direction in which the process is developing. The users should be able to counteract irregularities before they arise. WinCC gives you the ability to edit and display this information to the users effectively.

How much information should you pack into a picture?

When deciding on the amount on information that should be incorporated into a picture, there are two aspects that must be weighed against each other to achieve a balanced relationship:

- if a picture contains too much information, it will be difficult to read and searching for information will take too much time. The probability of errors being made by the users is also increased.

- if a picture contains too little information, the amount of work the users have to do is increased. They lose track of the process and have to change picture frequently in order to find the information required. This leads to delayed responses, control inputs and instability of the process being controlled.
Investigations have shown that experienced users want as much information as possible in every picture, so they don’t have to change picture as often. In contrast, beginners become confused and uncertain of what to do when a lot of information is packed into one picture. They either can’t find the right information or can’t find it in time. But experience has taught us one thing: a beginner soon becomes experienced, but an experienced user will never again become inexperienced.

**Hiding information**

The information displayed should be important and easily understood. You can hide (mask out) certain pieces of information (e.g. the tag numbers, measurement point identifiers) until they are needed.

**Displaying the information**

When displaying analog values, combine them with pointer instruments with digital values. Graphical representation of values (e.g. pointer instruments, bar graphs ...) makes it far easier and quicker for users to identify and grasp information. In order to avoid problems from arising in the unlikely but possible event of a user being color-blind, important changes to an object (state) should be indicated by using not only a different color but also a different format. Important information must always be immediately recognizable as such in a picture. This means good use of contrasting colors is essential.

**Color coding**

The human eye picks up colors quicker than e.g. text. Working with color coding can make you far quicker at establishing the current status of the various objects, but it is important that you set up and at all times observe a consistent color coding scheme. Uniform color specifications for displaying states in a project (e.g. red for error/fault) are already standard. Corporate conventions already in force at the customers’ must be taken into account.

**Displaying text**

To make text easier to read, you should keep to a number of simple rules.

- The size of the text must be matched to the importance of the information contained in the text, but also to the distance the user will probably sit away from the screen.
- Lowercase letters should be preferred. They require less space and are easier to read than uppercase letters, even if the latter are easier to read from a distance.
- Horizontal text is easier to read than vertical or diagonal text.
- Use different fonts for different types of information (e.g. measurement point names, notes, etc.).
**Stick to your concept**

Whatever concept you decide to use, you must always stick to it throughout the entire project. In this way, you support intuitive control of the process pictures. User errors become less likely. This also applies to the objects used. A motor or pump must always look the same whichever picture it is depicted in.

**Screen layout**

If standard PC monitors are being used, experience has shown that it makes sense to split the screen into three sections: the overview section, the workspace section and the keys section.

If, however, your application runs on a special industry PC or operator panel with integral function keys, this method of sectioning the screen contents doesn't always make sense.

**Pictures occupy the entire area of the screen**

The screen is split into the overview, keys and plant pictures sections
Example of an operator panel

Parameters / limits

The size of the individual pictures can be set as you wish within fixed limits (min 1 x 1, max. 4096 x 4096 pixels). In the case of single-user systems with a 17” monitor, we recommend you use a maximum resolution of 1024 x 768 pixels. With multi-user systems (multi-VGA), you may find a higher resolution useful.
In the case of operator panels, the technology used usually restricts the resolution available (TFT from 640 x 480 through 1024 x 768).

Specification

The following specifications apply to pictures used in the projects dealt with in this manual:

Resolution

In our sample projects, we use a resolution of 1024 x 768 and 800 x 600 pixels in exceptional cases. The color setting of your PC must be set to a minimum of 65536 colors for our sample projects to be displayed correctly.

Texts

Different types of texts are written in different fonts: the names of measurement points are written in Courier, pure descriptions and all other texts and text displays in Arial. MS Sans Serif and System fonts are used in Windows-style information boxes.
The font size is adjusted when and as necessary.
Information in the picture

Whenever it seems to make sense, we hide certain pieces of information in pictures. This information is only displayed when it is required (manual operation or automatic). We also use a number of different screen layouts in our projects. If a picture contains a large number of controllable objects, we provide information on how to use them in the form of tool tips.

Screen layout

We will configure the basic options for laying out the screen. In the other projects, however, we apply the subdivision into header, working area and key area.

Notes on general use

You can reuse the basic layout of the concepts used for your own projects.
3.2.6 the control concept

General

You control your process application under WinCC by means of the usual inputting means: a keyboard, mouse, touch screen or industry joystick. If your computer is located in an industrial setting with extreme conditions and where it would be impossible to use a mouse, you can use tab orders and the alpha cursor. The tab orders move you through controllable fields, while the alpha cursor moves you to the input fields. Every operation can be locked against access by unauthorized persons.

Opening pictures

The concept for opening pictures depends on a number of factors. Crucial to this concept is the number of pictures and the structure of the process that is to be displayed. In small applications, the pictures can be arranged as a ring or FIFO buffer.

If you are working with a large number of pictures, a hierarchical arrangement for opening the pictures is imperative. Select a simple and permanent structure so that the operators can quickly learn how to open the pictures.

Of course, it goes without saying that pictures can be opened directly, and this may well make good sense for very small applications (e.g. a cold-storage depot).

Hierarchy

A hierarchical structure makes the process easily comprehensible, simple to handle and provides, if necessary, rapid access to detailed information. A common and frequently used hierarchical structure consists of three layers.

Layer 1

Categorized under Layer 1 are the overview pictures. This layer mainly contains information about the different system sections present in the system and about how these system sections work together. This layer also indicates whether an event (message) has occurred in lower layers.

Layer 2

Categorized under Layer 2 are the process pictures. This layer contains detailed information about a specific process section and shows which plant objects belong to this process section. This layer also indicates which plant object an alarm refers to.
Layer 3

Categorized under Layer 3 are the detail pictures. This layer provides you with information about individual plant objects, e.g. controllers, valves, motors etc. It displays messages, states and process values. If appropriate, it also contains information concerned with interaction with other plant objects.

Specification

The following specifications apply to projects developed in the course of creating this manual:
We will be using a number of different control concepts in our projects and will point out the differences.

Notes on general use

Our projects should only be regarded as a stimulus when you create your own control concept. When extending plant, you must take the existing control concepts into account. Many users will find that their company already has corporate conventions and standards that must be adhered to when conducting configuration.

**Note:**
The optional WinCC package known as Basic Process Control offers a ready-made control concept. This optional package also contains other useful and powerful functions (e.g. storage).
3.2.7 Specification: color definition

General

The subject of colors is a very popular point of discussion with respect to HMI systems. WinCC allows you to freely select the colors used for lines, borders, backgrounds, shading and fonts. You have the choice of all those colors supported by Windows. Naturally, the colors, and the other graphic elements too, can be changed during runtime in WinCC. Color definition is particularly important in ensuring that configuration is inexpensive and that the processes are represented clearly.

Colors should always be defined for the following areas. The colors can be defined in accordance with DIN EN 60073 which corresponds to VDE 0199, but this must always be agreed on together with the user:

- colors for messages (arrived / departed / acknowledged)
- colors for states (on / off / faulty)
- colors for character objects (leads / fill levels)
- colors for warning and limit values

Specification

The following specifications apply to colors used in the projects dealt with in this manual:

The color setting of your PC must be set to greater than 256 colors for the sample projects to be displayed correctly.

To make it easier for you to find your bearings, we will use a different background color for the separate topics (tags, C course, picture configuration) dealt with in the sample projects. The background color in the overview and keys sections is darker.

In alarm logging, a specific color code is assigned to every message class and to every message type assigned to a message class.

Notes on general use

After defining the colors, you should if necessary adjust the default settings of WinCC.

You will find a table for coding the color values in \textit{C Actions} in the Appendix, Section 5.1.6 Color table.
3.2.8 Specification: the update cycles

General
When specifying the mode of updating, it is crucial that the overall system is looked at. What is updated and how often updating is carried out. Choosing the wrong update cycles can have negative effects on the performance of the HMI system. When looking at an overall system (PLC - communication - HMI), changes should be detected where they occur, namely in the process (PLC). In many cases, it is the bus system that poses the bottleneck for data transmission.

When specifying the mode of updating measured values, you must pay attention to how quickly the measured value actually changes. It makes absolutely no sense at all to update the actual value for the temperature control of a boiler with a capacity of approx. 5,000 l with a 500 ms cycle.

32-bit HMI system
WinCC is pure 32-bit HMI system based on Windows 95 and Windows NT. These operating systems are optimized for event-driven control action. If you take this principle into account when configuring with WinCC, performance problems will be a rarity, even when your are handling very large volumes of data.

Specification
The following specifications apply to updating in the projects dealt with in this manual: Insofar as the task definition permits, updating is performed driven by events. Since we work predominantly with internal tags, we often trigger change of the tags. When using external tags, this can lead to increased system load depending on the process driver connection. If communication allows event-driven transfer, it has to be chosen for time-critical data. Non-critical data can then be fetched by the HMI in suitable cycles (polling procedure).

Notes on general use
You will find a detailed description of the use of update cycles in Section 3.3.1 Update cycles - how and where you set them.
3.2.9 Specification: the user rights

General

When operating plant, it is necessary to protect certain operator functions against unauthorized access. A further requirement is that only certain persons have access to the configuration system. You can specify users and user groups and define various authorization levels in the User Administrator. These authorization levels can be linked to the control elements in the pictures. The user groups and users can be assigned different authorization levels on an individual basis.

Specification

In sample projects course_00 and varia_00, every user is authorized to control operation of the project. In sample project pictu_00, users can only control operation of the project after logging on. The password is the same as the project name (pictu_00). The buttons used for selecting the individual topics are linked to the authorization level known as Project control.

Notes on general use

You will find a description of how to assign user rights in the Configuration Manual, Part 2, in the example project pictu_00 of Section 3.3 Shutdown WinCC / access enable.
3.2.10 Specification: alarm message reporting

General

WinCC supports two different message procedures:

- The **bit message procedure** is a universal procedure which permits messages to be reported from any automation system. WinCC monitors the signal edge change of selected binary tags itself and derives message events from it.

- **Sequenced reporting** requires that the automation systems generate the messages themselves and send them in a predefined format to WinCC with a time stamp and possibly with process values. It is this message procedure which makes sequenced ordering of messages from different automation systems possible. Refer to Section 5.2 *Documentation of S5 Alarm Logging*.

What is to be reported?

When specifying which events and states are to be reported, many people follow what they see as the safest route and set the software to report all events and changes in state. This leaves it up to the users to decide which messages they look at first.

If too many events are reported in a plant, experience shows us that important messages are only picked up too late.

Notes on general use

How the messages are displayed and which messages are selected for archiving can be changed and customized to suit your own requirements.
3.2.11 Specification: implementation

General

It makes particularly good sense if you use a fixed structure for storing data when implementing a project. Specification begins with deciding which drive the WinCC project is to be created. The next step concerns setting up the folder structure etc. Experience has shown us that it makes sense to store all the data of a project under one folder which contains corresponding subfolders. You will find this method advantageous when processing a project, but even more so when backing up data.

Note:

PC configurations differ greatly. To avoid any problems this may cause when assigning the drive on which a project is to be processed, we suggest you use virtual drives. Assignment of a folder to a virtual drive can be changed at any time.

Specifying folders

In addition to the folders that are created by WinCC, create further folders for Word, Excel and temporary files if required.
3.3 Peculiarities of configuration using WinCC

The following chapters deal with topics which cut across all aspects of configuration using WinCC. These topics supplement the online help in WinCC.
3.3.1 Update cycles - how and where you set them

Specifying the update cycles is one of the most important setting procedures performed in the visualization system. The settings influence the following properties:

- picture buildup
- updating the objects of the picture currently open at the visualization station (Graphics Designer)
- editing background scripts (Global Script)
- activating the data manager and process communication

Other time variables are set during measured value processing (Tag Logging) under the archiving times.

Data manager

The instantaneous tag values are requested by the data manager, the main administrator for tag management, in accordance with the update cycles set. See Chapter 3.3.2 Dynamization in WinCC.

The data manager acquires the new process data via the communication channels and supplies these values to the applications. This requesting of data therefore means there is a switchover between different tasks (Graphics Designer, Data manager etc.). Depending on the configuration, this can lead to very different system loads.

3.3.1.1 Updating in the picture

Picture updating

Updating of the individual properties of the objects in the picture refers to the objects that are dynamized after the picture is opened. The task of the updating cycle is to establish the current state of the particular object in the picture. The update cycle of the dynamic objects can be set by the person configuring the system or by the system itself for the following types of dynamization:

<table>
<thead>
<tr>
<th>Dynamization type</th>
<th>Default setting</th>
<th>Configuration customization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration dialog</td>
<td>Tag trigger, 2 sec. or event trigger (e.g. control)</td>
<td>Customizing the time cycles</td>
</tr>
<tr>
<td>Dynamic Wizard</td>
<td>You can choose from the following depending on the type of dynamization: event trigger, time cycle, tag trigger</td>
<td>Customizing the time cycles, events or tags</td>
</tr>
<tr>
<td>Direct link</td>
<td>event trigger</td>
<td></td>
</tr>
<tr>
<td>Tag link</td>
<td>Tag trigger, 2 sec.</td>
<td>Customizing the time cycles</td>
</tr>
<tr>
<td>Dynamic dialog</td>
<td>Tag trigger, 2 sec.</td>
<td>Customizing the time cycles, tag triggers</td>
</tr>
</tbody>
</table>

WinCC Configuration Manual
C79000-G8276-C139-01
### 3.3.1.2 Types of update cycle

We distinguish between the following types of update cycles:

<table>
<thead>
<tr>
<th>Type</th>
<th>Default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default cycle</td>
<td>Time cycle of 2 seconds</td>
</tr>
<tr>
<td>Time cycle</td>
<td>2 seconds</td>
</tr>
<tr>
<td>Tag trigger</td>
<td>2 seconds</td>
</tr>
<tr>
<td>Picture cycle</td>
<td>2 seconds</td>
</tr>
<tr>
<td>Type</td>
<td>Default setting</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Window cycle</td>
<td>upon change</td>
</tr>
<tr>
<td>User-defined time cycles</td>
<td>User cycle 1: 2 sec.</td>
</tr>
<tr>
<td></td>
<td>User cycle 2: 3 sec.</td>
</tr>
<tr>
<td></td>
<td>User cycle 3: 4 sec.</td>
</tr>
<tr>
<td></td>
<td>User cycle 4: 5 sec.</td>
</tr>
<tr>
<td></td>
<td>User cycle 5: 10 sec.</td>
</tr>
</tbody>
</table>

**User cycle**

Up to 5 project-related user cycles can be defined. If the project name has been selected in the left tree structure in the Control Center, you can use the button on the toolbar to open the Project properties dialog box. The Project Properties dialog box presents, on the Update Cycles tab, user cycles 1 to 5 for the project-related definition at the end of the list of set standard update cycles. Only these user cycles can be parameterized.

![Project properties dialog box](image)

These user cycles enable you to define time cycles other than the ones already available (e.g. 200 ms).

You can define user cycles for any length of time between 100 ms and 10 hours. You can give user cycles any name you wish.

These project-related units of time can be used for selected objects whose update cycle must be modified at a later time. Once reason for changing the time cycles could be to...
effect an optimization. The user-defined update cycles also make it possible for you to subsequently modify the set time cycle from a single central point. In this case, the individual objects of the pictures no longer have to be adjusted as well. This is why this method of defining user cycles should be preferred if you want your projects to be maintenance-friendly.

### 3.3.1.3 What the update cycles mean

Before you begin putting the possible update cycles to use, we must first take a look at what the various update cycles mean.

We distinguish between the following types of update cycles:

<table>
<thead>
<tr>
<th>Type</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default cycle</td>
<td>time cycle</td>
</tr>
<tr>
<td>time cycle</td>
<td>The property or action of the individual object is updated after the time set. This means that each of the tags is requested <em>individually</em> by the data manager.</td>
</tr>
<tr>
<td>tag trigger</td>
<td>In accordance with the cycle time set and once the time interval has elapsed, the tags are determined by the system and checked for value changes. If the value of at least one selected tag changes during the time frame set, this acts as a trigger for the properties or actions dependent on this. <strong>All tag values are requested together</strong> by the data manager.</td>
</tr>
<tr>
<td>Picture cycle</td>
<td>Updating of the properties of the current picture object and all objects that are triggered by means of the Picture Cycle update cycle.</td>
</tr>
<tr>
<td>Window cycle</td>
<td>Updating of the properties of the window object and all objects that are triggered by means of the Window Cycle update cycle.</td>
</tr>
<tr>
<td>User-defined time cycle</td>
<td>Time units that can be defined specifically for a project.</td>
</tr>
<tr>
<td>C action for direct reading from the PLC</td>
<td>Values can be read directly from the PLC by means of internal functions in the C actions. Further editing of the subsequent instructions in the C action is only continued after the process values have been read (synchronous reading).</td>
</tr>
</tbody>
</table>

**Note:**

Requesting of the current tag value by the data manager leads in each case to a change of task and to a data exchange between the individual tasks. In addition, the tag values must be requested by the data manager via the communication channel of the programmable controllers connected. Depending on the type of communication, this is done by means of request telegrams sent to the communication interface (FETCH) and data telegrams sent back from the programmable controller to WinCC.
### 3.3.1.4 Instructions on how to use the update cycles

We recommend the following settings when using the update cycles, depending on the respective type of cycle:

<table>
<thead>
<tr>
<th>Type</th>
<th>Default setting</th>
<th>Recommendation for configuration</th>
</tr>
</thead>
</table>
| Default cycle             | Time cycle of 2 seconds | *Dynamic dialog or C action:*  
  if tags are interdependent, you should at all events make use of tag triggering. This reduces the number of task changes and communication between the tasks.  
  Tag triggering *upon change* may only be used selectively, since it can lead to greater system load! The tags are then checked constantly for changes. This polling mechanism always leads to a greater load on the system.  
  We recommend a cycle of 1 to 2 seconds for standard objects.                                                                                                                        |
| time cycle                | 2 seconds        | Make each time cycle dependent on the object type or the object property. The inertia of process components (tank fillings or temperatures in contrast to switching operations) should likewise be taken into account.  
  We recommend a cycle of 1 to 2 seconds for standard objects.                                                                                                                                                                                    |
| Tag trigger               | 2 seconds        | If this update option is configurable (depends on the dynamics type), *preference* should be given to using it!  
  If tags are interdependent, always taken into account all tags that are responsible for a change to the property or for execution of the action. Only those tags contained in the list act as triggers for updating of the dynamized property or action.  
  **Tag triggering upon change** should only be used selectively. As soon as one of the selected tags has changed, the trigger for this property or action is tripped. This polling mechanism leads to a greater load on the system. |
| Picture cycle             | 2 seconds        | This cycle should only be shortened if the dynamized properties of the picture object themselves change in a shorter time interval and therefore have to be updated. Lengthening the picture cycle reduces the load on the system.                                                                                                           |
| Window cycle              | upon change      | This setting makes sense if you are dealing with a picture window that is opened, for example, for adjusting process variables (process box).  
  If the picture window is displayed constantly for informational purposes (e.g. screen layout), updating of the window and its contents should be set to tag triggering or a time cycle.                                                                                                                                 |
| C action for direct reading from the PLC |                      | The internal functions (e.g. GetTagWordWait) for synchronous reading of process values (direct from the PLC) should only be used selectively. Application of these functions requires polling by the system (script... |
The following examples show where each of the update cycles is set:

**Configuration dialog**

This dialog box appears when you configure a *Smart Object → I/O Field*. It can also be opened by means of the key above the object concerned, however.

**Dynamic Wizard**

This page appears when you select *Dynamize Properties* on the *Standard Dynamics* tab in the *Dynamic Wizard* with the key.
Tag link for object property

This menu appears when you select the Update column with the object R in the event of a tag-dynamized object property.

Dynamic dialog

If you select the trigger button when in a dynamic dialog box, you select the dialog box for changing the update cycle.

C action for property

If you select the trigger button in the editor while handling a C action, you select the dialog box for changing the update cycle.

The update cycles set by default can be changed as follows:
Picture cycle

Changing the picture cycle

Window cycle

Changing the window cycle
3.3.1.5 Executing background scripts (Global Script)

The execution of background scripts (Global Script) is dependent on various variables depending on the configuration:

- **time trigger** (cyclic execution, exception: acyclic = single (or non-recurrent))
  - time cycle
  - time
- **Event trigger**

or only once
The configured time factor of the global action defines **when** the defined sequence of actions must be processed. Besides the standard cycle already described and the corresponding time settings from 250 ms through 1 h (or user cycles 1 through 5), you can also select from the time triggers:

- **Hourly** (minute and second)
- **Daily** (hour, minute, second)
- **Weekly** (day of week, hour, minute, second)
- **Monthly** (day, hour, minute, second)
- **Yearly** (month, day, hour, minute, second)
Tag trigger

If the action is activated dependent on one or more tags, the event trigger must be set as a tag trigger. You do this in the same way as for the tag trigger for object properties.

The 2-second cycle is set by default. The person configuring the system can, however, choose from the following time factors instead of the default value:
At the start and at the end of the set time frame, the values of the tags selected are determined. If the value of at least one of the tags has changed, the trigger for the global action is tripped.

Note the high system load when triggering upon change. This setting is not always appropriate. The same advice applies here as does for the Update object.

All actions you define as global actions are not checked and activated object-linked, i.e. only dependent on the time cycles or event triggers set. For this reason, only use the global actions selectively and avoid unnecessary action steps, in order not to put too heavy a load on the system. Neither use too many nor too many short time cycles for executing your actions.
3.3.2 Dynamization in WinCC

Definition

The concept of dynamization in WinCC refers to the changing of states (e.g. position, color, font, etc.) and the response to events (e.g. mouse action, keyboard action, value change, etc.) during runtime.

Each element in the graphics window is viewed as an independent object. The graphics window itself is likewise an object of the object type known as Picture Object. Each object in the WinCC Graphics System has Properties and Events. With just a few exceptions, these properties and events can be dynamized. The small number of exceptions mainly concerns properties and events that have no effect during runtime and they do not have a symbol which indicates they can be dynamized.

3.3.2.1 Dynamizing the properties

The properties of an object (position, color, font, etc.) can be set static and be changed dynamically during runtime.

All properties with a light bulb in the Dynamic column can be dynamized. Once a property has been dynamized, a colored symbol, which depends on the type of dynamization, is displayed instead of the white light bulb. Topics (e.g. Geometry) that have been dynamized are shown in bold type.
3.3.2.2 Dynamizing the events

The events of an object (e.g. mouse action, keyboard action, value change, etc.) can be requested during runtime and evaluated dynamically. All events with a lightning bolt symbol in the Action column can be dynamized. Once an event has been dynamized, a colored lightning bolt, which depends on the type of dynamics, is displayed instead of the white lightning bolt. Topics (e.g. Miscellaneous) that have been dynamized are shown in bold type.
3.3.2.3 Types of dynamization for objects

The objects of a plant picture can be dynamized in a number of different ways. The separate standard dialog boxes in which dynamization is performed are oriented to different target areas and to some extent lead to different results.

Overview

<table>
<thead>
<tr>
<th>Type of dynamization</th>
<th>A</th>
<th>B</th>
<th>Advantage</th>
<th>Disadvantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Wizard</td>
<td>x</td>
<td>x</td>
<td>Standard prompted method when configuring</td>
<td>Only for certain types of dynamization. Always generates a C action!</td>
</tr>
<tr>
<td>Direct link</td>
<td>x</td>
<td></td>
<td>The quickest method of dynamizing in the picture; maximum performance during runtime</td>
<td>Restricted to one link and can only be used in a picture.</td>
</tr>
<tr>
<td>Tag link</td>
<td></td>
<td>x</td>
<td>Simple to configure</td>
<td>Limited options for dynamization</td>
</tr>
<tr>
<td>Dynamic dialog</td>
<td>x</td>
<td></td>
<td>Quick and easy to understand and use; for ranges of values or a number of alternatives; high performance during runtime</td>
<td>Cannot be used for all types of dynamization.</td>
</tr>
<tr>
<td>C action</td>
<td>x</td>
<td>x</td>
<td>Almost unlimited possibilities for dynamization thanks to the powerful script language (Ansi-C)</td>
<td>Possibility of errors due to wrong C instructions; slower performance compared with other types of dynamization, therefore always check whether or not you can achieve your aim through a different type of dynamization.</td>
</tr>
</tbody>
</table>

Legend:

A  Dynamizing the object property
B  Dynamizing the object event
Opening the dialog boxes for dynamization

<table>
<thead>
<tr>
<th>Dialog box</th>
<th>Open command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration dialog</td>
<td>Not all objects have such a dialog box. Automatic when creating these objects. Select object in picture → Press and hold down SHIFT key → D. Select object in picture → D Open pop-up menu with → Configuration Dialog</td>
</tr>
<tr>
<td>Dynamic wizard</td>
<td>Select object in picture → Select property or event → Select wizard and start with D. The dynamic wizard must have been selected via View → Toolbars...</td>
</tr>
<tr>
<td>Direct link</td>
<td>Select object in picture → Display object properties → Select Events tab → in the Action column, open pop-up menu with D → Select Direct Connection.</td>
</tr>
<tr>
<td>Tag link</td>
<td>Select object in picture → Display object properties → Select Events tab → in the Dynamic column, open pop-up menu with D → Select Tag... → In dialog box, select relevant tag and click OK.</td>
</tr>
<tr>
<td>Dynamic dialog</td>
<td>Select object in picture → Display object properties → Select Properties tab → in the Dynamic column, open pop-up menu with D → Select Dynamic Dialog. → In dialog box, configure appropriate dynamics and click Apply.</td>
</tr>
<tr>
<td>C action</td>
<td>Select object in picture → Display object properties → Select Properties or Events tab → in the Dynamic or Action column, open pop-up menu with D → Select C Action... → In dialog box, configure appropriate C action and click OK</td>
</tr>
</tbody>
</table>

Results and presentation

<table>
<thead>
<tr>
<th>Dialog box</th>
<th>Result</th>
<th>Presentation (symbol)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Wizard</td>
<td>A C action is always generated.</td>
<td>Green lightning bolt</td>
</tr>
<tr>
<td>Direct link</td>
<td></td>
<td>Blue lightning bolt</td>
</tr>
<tr>
<td>Tag link</td>
<td></td>
<td>Green light bulb</td>
</tr>
<tr>
<td>Dynamic dialog</td>
<td>Automatically generated C action (InProc); this C action can be subsequently expanded but the performance advantage is lost in the process</td>
<td>Red lightning bolt, Upon change in C action; switch to Green lightning bolt</td>
</tr>
<tr>
<td>C action</td>
<td>Configured C script</td>
<td>Green lightning bolt, Yellow lightning bolt - the action still has to be created</td>
</tr>
</tbody>
</table>
3.3.3 WinCC system environment

WinCC is installed under the default installation path C:\Siemens\WinCC. You can however change the path during installation.

3.3.3.1 Folder structure of the WinCC system

The folder structure of WinCC looks as follows (without options and examples):

- Siemens
  - Common
  - WinCC
    - aplib
    - bin
      - Diagnose
      - projects
    - setup
    - systay
    - utools
    - WinCCProjects
    - wscripts

Files in the default WinCC folder

In the default WinCC path, the following folders and files are important for the persons configuring and commissioning the system:

<table>
<thead>
<tr>
<th>Folder</th>
<th>File name, extension</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics</td>
<td>License.log</td>
<td>Current logbook entries regarding the license checks and/or violations.</td>
</tr>
<tr>
<td></td>
<td>License.bak</td>
<td>The logbook file with the license information from the last startup.</td>
</tr>
<tr>
<td></td>
<td>WinCC_Op_01.log</td>
<td>Operator messages generated by WinCC during runtime.</td>
</tr>
<tr>
<td></td>
<td>WinCC_Sstart_01.log</td>
<td>System messages generated by WinCC on startup. An important file when troubleshooting. The file contains messages about missing tags and wrongly executed scripts.</td>
</tr>
<tr>
<td></td>
<td>WinCC_Sys_01.log</td>
<td>System messages generated by WinCC during runtime. An important file when troubleshooting. The file contains messages about missing tags and wrongly executed scripts.</td>
</tr>
<tr>
<td></td>
<td>S7chn01.log</td>
<td>System message of the channel used (in this case S7)</td>
</tr>
<tr>
<td>aplib</td>
<td>Library path</td>
<td>The header files, all standard functions and all internal functions are stored in subfolders.</td>
</tr>
</tbody>
</table>
Files in the default WinCC folder

In the default WinCC path, the cross-project functions and symbols are stored under the following folders:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Subfolder, file name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>aplib</td>
<td>library.pxl</td>
<td>Symbols of the default library of WinCC.</td>
</tr>
<tr>
<td></td>
<td>Report, Wincc, Windows</td>
<td>Folders for standard functions; they can be adjusted at any time.</td>
</tr>
<tr>
<td></td>
<td>Allocate, C_bib, Graphics, Tag</td>
<td>Folders for internal functions; they cannot be adjusted.</td>
</tr>
<tr>
<td>syslay</td>
<td></td>
<td>All print layouts that are automatically copied by WinCC to the project path into the folder prt when creating a project.</td>
</tr>
<tr>
<td>wscripts</td>
<td>Dynwiz.cwd</td>
<td>Dynamic Wizard of the Graphics Designer. You can write your own scripts at any time. These scripts are given the extension .wnf</td>
</tr>
<tr>
<td></td>
<td>wscripts.deu</td>
<td>This path contains the script files for German. This path depends on the language installed.</td>
</tr>
<tr>
<td></td>
<td>Wscripts.enu</td>
<td>This path contains the script files for English. Since English is the default language, this path is always created.</td>
</tr>
<tr>
<td></td>
<td>Wscripts.fra</td>
<td>This path contains the script files for French. This path depends on the language installed.</td>
</tr>
</tbody>
</table>
When you install WinCC, the following application programs are stored in the folders shown below:

<table>
<thead>
<tr>
<th>Folder\file</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>\sqlany\sql.exe</td>
<td>Interactive program used for looking at the data in the database of a WinCC project.</td>
</tr>
<tr>
<td>\bin\Wunload.exe</td>
<td>Assistant (wizard) used for emptying the online tables in the database of the WinCC project, e.g. removing the messages and measured value data stored. The wizard automatically sets the runtime tables for unloading; additional tables can however be added or removed from the list by the user at any time. This tool must be used offline with a WinCC project. It cannot be used in runtime mode. Messages and measured values can be swapped during runtime by means of the optional STORAGE package.</td>
</tr>
<tr>
<td>\bin\Wrebuild.exe</td>
<td>Wizard for reconstructing the database; it cannot be used in runtime mode!</td>
</tr>
<tr>
<td>\SmartTools\CC_GraficTools\metaVw.exe</td>
<td>Viewer for graphics files (e.g. print jobs, exported symbols) in EMF format (extended meta file).</td>
</tr>
<tr>
<td>\SmartTools\CC_GraficTools\wmfdcode.exe</td>
<td>Viewer for graphics files in WMF format (windows meta file).</td>
</tr>
<tr>
<td>\SmartTools\CC_OCX_REG\ocxreg.exe</td>
<td>For registering or canceling registration of additional OLE Control components (OCX).</td>
</tr>
<tr>
<td>\SmartTools\CC_OCX_REG\Re gsvr32.exe</td>
<td>Is called by ocxreg.exe.</td>
</tr>
</tbody>
</table>
### 3.3.4 WinCC project environment

**Note:**
Create a special project folder for WinCC projects, e.g. WinCC_Projects. In this way, you keep the WinCC system and the configured data totally separate from each other, simplifying the task of data backup in the process. You also avoid the danger of losing danger (through operator errors) if you need to uninstall WinCC at some time.

### 3.3.4.1 WinCC project folder structure

A project under WinCC consists of a complete folder structure with corresponding content. Once a new project has been created in the Control Center (by choosing File → New from the menu), a folder structure is generated as follows:

<table>
<thead>
<tr>
<th>WinCC as standard</th>
<th>WinCC with options</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Folder Structure" /></td>
<td><img src="image2.png" alt="Folder Structure" /></td>
</tr>
</tbody>
</table>

- **Folder Structure**:
  - **Cours_01**
    - GraCS
    - Library
    - Meld
    - Pass
    - Pass
    - Pde
    - Prt
    - PrtSync
    - Textbib
  - **Zip-win1**
    - GraCS
    - Meld
    - Pass
    - Pass
    - Pde
    - Prt
    - Textbib
  - **Cours_00**
    - GraCS
    - Library
    - Meld
    - Pass
    - Pass
    - Pde
    - Prt
    - PrtSync
    - Redundancy
    - Textbib
  - **Zip-win8**
    - GraCS
    - Meld
    - Pass
    - Pass
    - Pde
    - Prt
    - Redundancy
    - Textbib
## Contents of the project folders

<table>
<thead>
<tr>
<th>Folder</th>
<th>Extension</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project path</td>
<td>.db</td>
<td>The database with the configuration data.</td>
</tr>
<tr>
<td></td>
<td>rt.db</td>
<td>The database with the runtime data, measured values and messages</td>
</tr>
<tr>
<td></td>
<td>.mcp</td>
<td>Main file of the WinCC project. The project is opened with this file.</td>
</tr>
<tr>
<td></td>
<td>.pin</td>
<td>Project.pin</td>
</tr>
<tr>
<td>GraCS</td>
<td>.pdl</td>
<td>The configured pictures.</td>
</tr>
<tr>
<td></td>
<td>.sav</td>
<td>Backup files of the picture files with the last configuration state</td>
</tr>
<tr>
<td></td>
<td>.bmp</td>
<td>Picture files</td>
</tr>
<tr>
<td></td>
<td>.wmf</td>
<td>Picture files</td>
</tr>
<tr>
<td></td>
<td>.emf</td>
<td>Picture files</td>
</tr>
<tr>
<td></td>
<td>.act</td>
<td>Exported actions</td>
</tr>
<tr>
<td></td>
<td>.pdd</td>
<td>Default.pdd setting parameters for the graphic editor (default settings of the individual objects in the Object Palette)</td>
</tr>
<tr>
<td>library</td>
<td>.h</td>
<td>Ap_pbib.h (project function declarations)</td>
</tr>
<tr>
<td></td>
<td>.pxl</td>
<td>Library.pxl (project symbol library)</td>
</tr>
<tr>
<td></td>
<td>.fct</td>
<td>Project functions</td>
</tr>
<tr>
<td></td>
<td>.dll</td>
<td>Own function libraries that have been created in a C development environment.</td>
</tr>
<tr>
<td>Meld</td>
<td>.pas</td>
<td>Project actions that run as background actions dependent on the trigger set.</td>
</tr>
<tr>
<td>Pass</td>
<td>.pas (action definition)</td>
<td></td>
</tr>
<tr>
<td>Pde</td>
<td>.rpl</td>
<td>Page layouts for print jobs</td>
</tr>
<tr>
<td>Prt</td>
<td>.rpl</td>
<td>Page layouts for print jobs</td>
</tr>
<tr>
<td></td>
<td>.rp1</td>
<td>All the predefined WinCC default layouts begin with @. All system variables (including tags) are identified by this prefix.</td>
</tr>
<tr>
<td>Computer name e.g. Zip-ws1</td>
<td>.GraCS\GraCS.ini</td>
<td>Initialization file for the graphic editor</td>
</tr>
</tbody>
</table>
**Optional: files which can be created during configuration**

<table>
<thead>
<tr>
<th>Folder</th>
<th>Extension</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>To some extent freely definable</td>
<td>.ini</td>
<td>Initialization file for the simulator with information for the call.</td>
</tr>
<tr>
<td></td>
<td>.sim</td>
<td>Internal tags with settings for simulation</td>
</tr>
<tr>
<td></td>
<td>.csv</td>
<td>Exported texts from the text library.</td>
</tr>
<tr>
<td></td>
<td>.txt</td>
<td>Exported messages from the message system <em>(Alarm Logging)</em></td>
</tr>
<tr>
<td></td>
<td>.emf</td>
<td>Print jobs that write your print results to a file.</td>
</tr>
<tr>
<td></td>
<td>.log</td>
<td>Log files</td>
</tr>
<tr>
<td></td>
<td>.xls</td>
<td>Files that have been created using other applications but are used in the WinCC project.</td>
</tr>
<tr>
<td></td>
<td>.doc</td>
<td></td>
</tr>
<tr>
<td></td>
<td>.wri</td>
<td></td>
</tr>
</tbody>
</table>
3.3.5 Automatic WinCC project startup

Requirement

The HMI system (WinCC) on the system should start automatically when Windows is started. The HMI station operator does not need to know anything about using the version of Windows loaded (e.g. calling WinCC under Windows 95 or Windows NT).

Solution

WinCC is started automatically in the startup routine of the PC on startup. This function is set in the *Startup* folder of Windows.

Create a link

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure in NT 4.0:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In Windows Explorer, change to the <code>WinNT\Profiles\All Users\Startmenu\Programs\Startup</code> folder. WinNT is the folder in which Windows NT has been installed.</td>
</tr>
<tr>
<td>2</td>
<td>Create a new link in the folder with <code>CTRL + NEW</code> Link.</td>
</tr>
<tr>
<td>3</td>
<td>Establish the link to the program called <code>mep.exe</code> (Master Control Program) in the <code>\bin</code> folder of WinCC.</td>
</tr>
<tr>
<td>4</td>
<td>Give the link a name.</td>
</tr>
</tbody>
</table>

As a result, the WinCC Control Center starts automatically. WinCC itself starts automatically with the project that was processed or activated last.

To start a system in runtime mode, the project must therefore be exited while active.

**Note:**

If the key combination `CTRL + SHIFT` is not locked (barred) and it is pressed during startup of WinCC, WinCC starts in configuration mode even if the project was exited in active mode.

The operator now sees the familiar start screen of the system. To prevent operators from being able to inadvertently or intentionally switch to configuration (which is running in the background) or use Windows applications they should or must not use, it is necessary to take appropriate precautionary measures. Operators must also not be able to open the database runtime window, since they can close the WinCC database link from there.
Barred selection functions:

Operators should have no way of switching from WinCC runtime to:

- the Control Center of WinCC (configuration environment).
- the runtime window of the SQL database of WinCC (Sybase SQL Anywhere), since they could use this route to close the WinCC database link. WinCC would then no longer be able to continue working.
- the Windows task bar, since this can be used to start all of the programs installed.
- the current task window, since the application can be closed.

Settings required for the computer

The following key combinations must be locked so that operators do not have these options open.

Locking is performed in the Control Center in the Computer Properties dialog box. Please refer to the online help of WinCC or the operating system you are using for the exact meaning of the key combinations.
Settings required for runtime

The plant picture could also be closed by means of the standard Windows keys; i.e. this route could also be used to exit WinCC. To prevent this, the following settings must be made for the properties of the plant picture:

![Computer properties](image)

Locking is performed in the Control Center at Computer Properties. Please refer to the online help of WinCC or the operating system you are using for the exact meaning of the key combinations.

- If *Resize* and *Minimize* are not deactivated, access can be gained to the user interface of the operating system.
- *Close* (not shown in the figure above) must also be deactivated. Otherwise users can exit runtime and access the Configuration System.

**Note:**

If all or some of the keys cited above are locked, the person configuring the system and Service personnel must be enabled to access the configuration system by means of defining a particular key configured precisely for this purpose. The same is also the case to enable the system to be shut down properly.

These functions must not be readily operable. You must therefore also **secure access** to this key, e.g. for Service personnel, under the property *Password*. 
3.3.6 Coordinated exiting of WinCC

Controlled exit

A WinCC station must never be switched off without shutting down the operating system. The use of an EMERGENCY SHUTDOWN switch is not suitable for the HMI system. For this reason, an appropriate button must be configured to enable operators to exit the system correctly without requiring any additional knowledge.

Power failure

In order to prevent data from being lost in the event of power fluctuations or a complete power failure, a detailed data backup concept must be worked out and applied for the HMI system.

At all events, a UPS (uninterruptible power supply) should be included in your plans for the WinCC station. This can be provided by connecting the station to the plant’s own UPS or by connecting a separate UPS to the WinCC server. This applies both to single-user and multi-user systems, irrespective of the operating system being used (Windows 95 or Windows NT). The UPS used must also include special shutdown software for Windows 95 or Windows NT (as appropriate), so that the operating system and all active applications are exited automatically without any loss of data in the event of a power failure and shutdown after a specified time interval; e.g. APC UPS 600 with power shutdown software for Windows 95 and Windows NT.

Notes on how to install a UPS

The WinCC station must have a serial interface to which a UPS with appropriate test software can be connected. If there isn’t a serial interface free on the station (e.g. they are all occupied by a printer or PLC), you must install an additional interface card. Serial interfaces that are used for connecting two or more peripherals (e.g. via switches) are not supported by the majority of UPS systems and are certainly not recommended, since the system needs to be monitored constantly.

An appropriate monitoring service is installed in the operating system. This monitoring service then has to be assigned shutdown parameters, so that coordinated and orderly exiting of the system is guaranteed. The shutdown process for application software must be activated under all circumstances, so that WinCC is closed without any loss of data in the event of a shutdown. You must choose a Save time before shutdown, that is sufficiently long enough for all the applications that are active to be exited properly.

Most software packages for UPS systems offer time-controlled shutdown, e.g. for the weekend or for nighttime. This function can be used to obtain definite exiting of the WinCC system without the operator performing a single control action.
3.3.7 Data backup

When is data to be backed up?

A WinCC project must be repeatedly saved and backed up at the following times and for the following reasons:

- during the configuration phase.
- before exporting or importing data (e.g. when importing tags, multilingual picture texts, message texts and multilingual message texts).
- before rebuilding or unloading the WinCC database.
- before editing the database using tools such as interactive SQL access.
- the configuration data must be backed up for installation on the destination system at the end user.
- before taking over data for a similarly structured project.

What media are suitable?

<table>
<thead>
<tr>
<th>Medium</th>
<th>Advantage</th>
<th>Disadvantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Floppy disks</td>
<td>Can be read by almost any system.</td>
<td>Insufficient capacity (even when data is compressed).</td>
</tr>
<tr>
<td>ZIP disks</td>
<td>Inexpensive, adequate capacity, direct and quick access possible via Windows; simple to install; portable, for use on the plant.</td>
<td></td>
</tr>
<tr>
<td>Streamers (e.g. in the network)</td>
<td>Automatic backup possible (daily), very high capacity.</td>
<td>Mostly available only in office environment, no direct access to the data due to the special format used for saving.</td>
</tr>
<tr>
<td>Hard disk on another PC (e.g. laplink)</td>
<td>No need to deal with other media, data can be used directly.</td>
<td>Slow, unsuitable for large volumes of data.</td>
</tr>
<tr>
<td>MOD</td>
<td>High level of data integrity, reusable, backup of messages and measured value possible in runtime mode.</td>
<td>A special drive is required for reading and writing.</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>High capacity, can be read by almost any system, suitable for long-term archiving.</td>
<td>A special drive is required for writing, medium not reusable.</td>
</tr>
</tbody>
</table>
Reducing the project before data backup

In order to be able to back up the project in a state that is as reduced as possible before actually backing up data for the end user or for taking over project data, the following data can be deleted or reduced by means of auxiliary programs beforehand.

- All backup files in the \Gracs\*.sav folder of the project.
- If you haven’t created any layouts of your own (Report Designer) for the documentation, the system layouts can be deleted from the \Prt folder. When a new project is created, all system layouts are automatically copied from the \Siemens\Wincc\ystay folder to the project folder.

What data must be backed up?

If only the data of a WinCC project are to be backed up, the following individual files and folders with all the files contained in them must be backed up from the project folder:

- the files *.mcp, *.pin and *.db
- the folders \Gracs and \Library
- if you have created your own actions, the folder \Pas
- if you have created your own print layouts, the folder \Prt.

If you have created cross-project components (standard functions, objects in the project library), the following files must also be backed up from the default WinCC folder:

- the files \Siemens\Wincc\aplib\*.fct
- the file \Siemens\Wincc\aplib\library.pxl

This data is not generated when WinCC is reinstalled.
3.3.8 Copying a backed-up WinCC project to a new destination computer

Installing the system software

The WinCC software is installed on integral systems either by means of the Configuration dialog which is called automatically or by means of the Installation CD supplied with the WinCC package and the licensed disks that belong to it.

Supplements

If special supplementary packages (e.g. options packages or add ons) or special communication interfaces or interfaces to other Windows programs (e.g. WORD, EXCEL etc.) are used in your project, these packages must also be installed on the new destination computer. The relevant authorizations for options packages, add ons or communication interfaces (channel DLLs) must also be installed on the destination computer. Note that all the necessary authorizations (for all channel DLLs used) must be imported on the new computer to enable you to work with the WinCC project.

Windows software

If OLE links to other Windows programs, e.g. to WORD, ClipArts or EXCEL, are used in the WinCC pictures, the corresponding software package, depending on the type of the OLE link, must likewise be installed on the destination computer, i.e. entered in the Windows registration.

OXC, ActiveX

If other OCX components (OLE Control, ActiveX) from bought-in software packages are used, they must also be stored in the Windows registration. Register or check the registration entries of these OCX components, e.g. using the tool \SmartTools\CC_OCX_REG\ocxreg.exe supplied with the WinCC CD. If a registration to OLE objects or to OCX objects is not found on startup of the WinCC project in runtime mode (as well as during configuration using the Graphics Designer), this object is displayed in the picture with the remark Unknown Object.

Network

If the project has been configured for a multi-user system, the network must be fully installed on the WinCC destination computer before the WinCC data is copied. Make a note of the necessary computer names in the configured computer environment, since you will need them when assigning the parameters of the project copied. The computer name is also required as a parameter for a single-user system. Therefore, you must know the name of the destination computer or find its name by means of the Windows Control Panel. If the computer in question is a single-user system that is not connected to a network, the Windows computer name will be set.
Copying the data and starting the project

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure when taking over data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a project folder (e.g. <em>WinCC_Projects</em>)</td>
</tr>
<tr>
<td>2</td>
<td>Copy the complete backed-up path to this project folder as a subfolder (e.g.: <em>WinCC_Projects\Varia_00</em>). The name of the WinCC project folder can be changed if desired. When renaming the files in the project folder (<em>varia_00.mcp, varia_00.db, varia_00.pin, varia_00.log</em>), make sure that all the files are given the same name (with the exception of the extension).</td>
</tr>
<tr>
<td>3</td>
<td>Open the project in the WinCC Control Center.</td>
</tr>
<tr>
<td>4</td>
<td>If necessary, change the project-specific settings. If the type has to be changed, additional adjustments must also be made to the <em>Computer properties</em>. These adjustments are described in the WinCC Help.</td>
</tr>
</tbody>
</table>

### Project properties

- **General Information**
  - **Type:** Single-User System
  - **Creator:** mb
  - **Creation Date:** 1997-6-29 12:15:51.0
  - **Changed By:** hl
  - **Last Change:** 1997-12-3 10:28:43.0
  - **Version:** 1.1
  - **GUID:** CC_varia_00_97-08-22_17:19:55
  - **Comment:** Project to configuration manual
  - **Topic tags**

5 Check the computer name and modify it, if necessary, in the *Computer Properties* dialog box on the *General Information* tab. If the computer name in the WinCC project does not match up with the computer name of this destination system, an error message is displayed when you activate the project, i.e. when you start it up in runtime mode.

6 If you have used your own *standard functions* (*.fct*) in the project, the backed-up standard functions must be copied to the default WinCC path *Siemens\WinCC\aplib* and then made known in the function tree.
   - With the project open, call the *Global Script* editor.
   - Recreate the declaration structure by choosing *Options → Regenerate Header*
The new functions can now be seen in the function tree.

Activate the project in order to check that it starts up correctly.

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure when taking over data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>from the menu.</td>
</tr>
<tr>
<td></td>
<td>The new functions can now be seen in the function tree.</td>
</tr>
<tr>
<td>7</td>
<td>Activate the project in order to check that it starts up correctly.</td>
</tr>
</tbody>
</table>
3.3.9 Reuse - reusing parts of a project in a new or existing project

The reason for reusing data

A WinCC project can be generated in different ways. The chief aspects in this regard are the reusability of existing project parts from similar projects and the taking over of data from preconfigured sample projects.

Project team

Similar tasks are specified in this regard for a configuration team, since a WinCC project must in the end be merged again to form one project.

A WinCC project consists of individual files (e.g. pictures) and the configuration data in the database (Alarm Logging, Tag Management).

Data in the database

Data that is stored in the configuration database cannot be created in two separate projects and subsequently merged together.

For this reason, a basic project, which is used for this type of configuration, must be created when configuring database information (e.g. the structure of Alarm Logging). This basic project must be backed up before every change to the database (for intermediate steps, too). If something goes wrong when making a change, you can retrieve the status that prevailed before the change was made.

Note:

Note that every change made in the database may influence the structure and accessing of the database. Lots of unnecessary changes (possibly with deletions) can lead to the WinCC database no longer being optimally compiled and consequently to a loss of performance.

Single-user system

While the next configuration step, e.g. on Alarm Logging, is being carried out on the basic project, you must never under any circumstances make a change in the database at some other point (e.g. archiving – Tag Logging) in a WinCC single-use system.

Multi-user system

In contrast, a project is being configured on a multi-user system, changes can be made to the configuration in different areas of the database simultaneously. For example, one person configuring the system can edit Alarm Logging while another system configurer edits the archiving system (measured-value acquisition).

Conversion from single-user to multi-user system

Every project can be created on a WinCC multi-user configuration system and converted back to a single-user system on the destination computer. If a change of configuration between the configuration station(s) and the customer’s system is planned beforehand, no elements specific to WinCC, that are oriented to a multi-user system, may be used. For
example, no internal tags can be used on the local computer if the system being configured is actually for a single-user system at the customer.
When creating a new project (irrespective of whether it is for a single-user or multi-user system), you must know beforehand whether or not the project is to be based on an existing basic project with preconfigured Alarm Logging and/or archiving data. This data stored in the database can only be transferred to other projects through reconfiguring or, if possible, through export - import.

### 3.3.9.1 Taking over pictures

Configured pictures can be taken over at any time. You can copy the picture files (*.pdl) from the source folder to the target folder of the WinCC project path, *GraCS*, in two different ways. The first method is to do it directly using the Windows Explorer (useful if you have to copy several picture files).
Below is an extract from the project for picture configuration:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Type</th>
<th>Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>pictu_0_startpicture_00.PDL</td>
<td>16KB</td>
<td>WinCC.Graphics.Document</td>
<td>9/30/97 12:58 PM</td>
</tr>
<tr>
<td>pictu_1_overview_00.PDL</td>
<td>20KB</td>
<td>WinCC.Graphics.Document</td>
<td>9/30/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_2_keyboard_00.PDL</td>
<td>52KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 3:03 PM</td>
</tr>
<tr>
<td>pictu_3_chapter_00.PDL</td>
<td>9KB</td>
<td>WinCC.Graphics.Document</td>
<td>9/30/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_01.PDL</td>
<td>34KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_01a.PDL</td>
<td>35KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_02.PDL</td>
<td>35KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/8/97 8:37 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_03.PDL</td>
<td>30KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_03a.PDL</td>
<td>26KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_04.PDL</td>
<td>34KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_05.PDL</td>
<td>130KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_05a.PDL</td>
<td>111KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_05b.PDL</td>
<td>138KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_06.PDL</td>
<td>80KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 7:30 AM</td>
</tr>
<tr>
<td>pictu_3_chapter_06a.PDL</td>
<td>58KB</td>
<td>WinCC.Graphics.Document</td>
<td>10/7/97 7:30 AM</td>
</tr>
</tbody>
</table>

The second type of picture application functions by opening a picture file (*bild.pdl*) in *Graphics Designer* by choosing the option *File → File Open*. The picture is then stored in the current picture folder (*GraCS*) by choosing *File → Save As* from the menu. This procedure is suitable if the picture files are being used as a basis and will be customized immediately.
Restriction

With trend windows, message windows, table windows, application works, albeit to a limited extent.

Note:
The references relating to objects from the previous project no longer match up. The relevant references must be defined in the new project.

These references can be:

References in pictures

- Structures from the data type area
- Internal or external tags
- System:tags
- Message window
- Archive window templates (trend window or table window for process-value or user archives)
- Picture objects that are stored as a bit map or meta file (e.g. for status displays or graphic objects)
- Other pictures that are used as graphic or process boxes or as pop-up windows
- Project functions used
- Access authorization

The following references must also be defined:

- Definition of the structures under data types, e.g. controller or templates structures for user objects
- Definition of the communication channels and logical links with the definition of the tags (possibly with tag groups).
- Definition of the internal tags and system tag names (beginning with @).
• Definition of new or similar window templates and linking of the application windows (for Alarm Logging and Tag Logging).

• Transfer of the picture elements (*.bmp and/or *.emf) by copying them from the \GraCS folder.

• Transfer of picture window contents by copying the other picture files (*.pdl) from the \GraCS folder.

• The project functions used must be copied from the source project to the \library folder of the new project. In addition, these functions have to be stored in the function tree using the Global Script editor by choosing Generate Header. This approach has already been described in greater detail in Section 4.1 The development environment for scripts in WinCC.

• Access rights used (e.g. Open Picture) must be specified in the User Administrator editor. The access rights used (e.g. for control buttons) must be defined for the group specifications.

### 3.3.9.2 Taking over symbols and bit maps

**Copying**

Symbols for *status displays* or *graphic objects* in picture files are stored as separate files in the picture folder of the project. This is done by copying the desired symbol files (*.emf or *.bmp) to the target folder, \GraCS, of the new project. These pictures are now immediately available in the selection list for *status displays* or *graphic objects* (see the Object Palette in the Graphics Designer). Here is a section of the configuration dialog of the *status display.*
Importing

Symbols can be embedded in a picture using the method described above or they can copied directly into the graphic you are currently editing by choosing Insert → Import. In the latter case, you don’t have to copy a file; you import the symbol you want directly by accessing the path of the source project (GraCS) and then importing the symbol file you want (*.bmp, *.emf, *.wmf). After being imported, the symbol is then immediately displayed as an object in the picture (top left).

If symbols are stored in a project library, the project library can be used in another project by being taken over in its entirety. How this is done is described in the following chapter.

3.3.9.3 Taking over a project library (with preconfigured symbols and user objects)

Global library

If symbols are stored in a project library, this library can be used in another project by copying the file library.pxl to the \library path.

The preconfigured modules can now continue to be used at any time in the new project.
Please take into account the fact that linked symbols may refer you to unavailable references (or tags) that you must define first. Depending on the configuration of these symbols, the actions or links associated may have to be adjusted. For this reason, after using symbols from the library, check which properties/event links are already present and whether these may have to be adjusted.

### Individual symbols

If only a few specific symbols from the project library are used in the new project, these symbols are exported individually (symbol file *.emf).

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: taking over symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open library.</td>
</tr>
<tr>
<td>2</td>
<td>Select the symbol you want using the √ and press and hold down the mouse key to drag the symbol to the picture (Drag&amp;Drop).</td>
</tr>
<tr>
<td>3</td>
<td>Call the dialog box for saving the symbol by selecting File → Export... .</td>
</tr>
</tbody>
</table>
New project library

These exported symbols are now available as separate symbol files and can be used individually by being imported. If these symbols are used frequently in the project, they should be integrated again into the new project library. You do this by calling the symbol library, in particular the project library.

Create your own symbol folder, e.g. with the aid of the folder icon in the toolbar of the library window and copy the imported symbols to this folder by means of Drag&Drop. In this way, you can take over some of your symbols from projects and add additional specific symbols to create a new project-specific library again.

3.3.9.4 Taking over global actions

Actions that are frequently required in a project or that are to be copied from one object action to another object action are stored as separate files. These files are stored in the \GraCS folder with the extension .act. They can be taken over at any time by being copied from the source folder to the target folder.

An action file is saved using the C.Actions editor by means of the Export.Action button on the toolbar to the destination file you name (having the extension .act for action).
A stored action file is taken over for an object action in the picture of the new project by means of the Import Action button in the toolbar. Read the description carefully in Section 4.1 "The development environment for scripts in WinCC."

**Note:**
Actions used frequently can also be defined as project or standard functions.

### 3.3.9.5 Taking over tags

The tag management of WinCC can be supplemented in a number of different ways:
- By reading in S5 data tags or S7 data tags using the Assistant (*Dynamic Wizard*)
- By taking over S7 tags using the PCS7 *mapper*
- By importing and exporting text lists using the auxiliary tool known as *Var_Exim*
- By interactive accessing of the database tables (tag tables)
- By means of specially programmed assistants (*Dynamic Wizard*) or programs that create new data in tag management with WinCC API functions

The last two options cited require very good knowledge of working with SQL databases and of programming via the application interface. They should only be used by persons who have such knowledge.

Before the data is transferred to the destination project, you therefore have to clarify where the basis for the destination project is. If there is already a large number of tags present in the tag management of WinCC, the tag list of WinCC should be imported into the destination project. The *internal tags* must at all events be taken over from the tag management of WinCC. This is done using the tool *Var_Exim.exe*. 
Taking over S5-/S7 data tags using Dynamic Wizards

The data area definitions generated using STEP5/STEP7 software can be read into the tag management of WinCC with the aid of Dynamic Wizards. The following activities have to be performed:

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: taking over S5 or S7 data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Backup the data</strong> of the project. Changes are made in the database.</td>
</tr>
<tr>
<td>2</td>
<td>Export the assignment list using the STEP software. A file with the name <code>prj_zulf.SEQ</code> is created.</td>
</tr>
<tr>
<td>3</td>
<td>Remove any special symbols (e.g., for program calls) that are not required for import into WinCC from this exported file. You can do this with a typical text editor, such as Wordpad. The assignment list must not contain any blank lines.</td>
</tr>
<tr>
<td>4</td>
<td>Open the destination project in the WinCC <strong>Control Center</strong>. The project must be in configuration mode (Runtime not activated!).</td>
</tr>
<tr>
<td>5</td>
<td>Open the <strong>Graphics Designer</strong> editor. In any picture in the <strong>Dynamic Wizard</strong> (display by choosing <strong>View → Toolbars...</strong>), select the <strong>Import Functions</strong> tab. Then select the <strong>Import S7 – S5 Assignment List</strong> function. In the following you have to name the <em>source file (.seq)</em> with its folder (by means of the button ). You also have to specify the logical connection into which the tag descriptions of the assignment list have to be mounted. The data is now entered into the WinCC tag management. The tag names used in a WinCC project must be unique. The tags are added to the existing WinCC tag management. The tag name is the key to this.</td>
</tr>
</tbody>
</table>

Taking over tags using the auxiliary program

The links (channel DLL, logical link and link parameters) must already be defined before being imported into the destination project.

**Note:**
To achieve automatic generation of links and data entries in the WinCC database, you could compile a special program which carries out such definitions automatically via the WinCC API interface. In this way, existing plant data can be added to automatically. This program must be written by a specialist in WinCC API programming or SQL programming.

The tags defined in the tag management can be exported at any time as a text file to supplement the list of tags. Afterwards, this data generated must be imported back into the tag management of the project. The generated files are stored in CSV (comma separated values) format and can be read and processed further in any editing program.

For this there is a special application on the WinCC CD-ROM in the folder called `SmartTools/CC_VariablesImportExport`. This Windows program is provided as an auxiliary program:

- for transferring (exporting) the data of the tag management to external storage
- for importing tag data already generated externally
- for bulk data configuration
The following steps now have to be taken to export or import the data:

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: importing/exporting tags</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open your WinCC project in the WinCC Control Center.</td>
</tr>
<tr>
<td>2</td>
<td>Define links (channel DLL – logical link – link parameters) that are not currently available but that will later be required for importing. Only do this, however, in the new project. This may required a second export-import procedure.</td>
</tr>
<tr>
<td>3</td>
<td>Activate the program called Var_exim by means of ( \Box ). The user interface of this program is displayed in the following.</td>
</tr>
</tbody>
</table>

**Import - Export**

The following settings are necessary for exporting or importing the data:

<table>
<thead>
<tr>
<th>Location, action</th>
<th>Import</th>
<th>Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path</td>
<td>Select the project folder which contains the files for tag import by selecting the file named <code>&lt;project_name&gt;.mep</code>. The files which contain the data to be imported must be located in the same folder as the project file.</td>
<td>Enter the project folder for tag export by selecting the file named <code>&lt;project_name&gt;.mep</code>.</td>
</tr>
<tr>
<td>Action</td>
<td>Select <em>Import</em>. If you want existing tag data to be overwritten, select <em>Import overwrite</em>.</td>
<td>Select <em>Export</em>.</td>
</tr>
</tbody>
</table>
The dialog box then displayed shows the parameters set and executes the procedure after you have clicked OK. Due to the checks performed, import takes more time.

Status display
End export/import

Tag file
_Backbone
Name.ex.csv
Basis for import:
consists of a header and data records.
The tag list generated is stored in this file as text. You can open it directly by means of the _var button or edit it in a text editor (Notepad) or in EXCEL.

Tag file
Name.ex.csv
Basis for import:
consists of a header and data records (structural components).
This file contains the currently configured links which are referred to in the tag file. You can open it directly by means of the _con button or edit it in a text editor (Notepad) or in EXCEL.

Data structure file
_Name.dex.csv
Basis for import:
consists of a header and data records.
If tags with data structure types are included, this file containing structural information is also generated. You can edit its contents using a text editor (Notepad) or EXCEL.

Diagnostics file
Diag.txt
A diagnostics file containing information as to which tags were not able to be imported.

The program can be exited by clicking the _End button.

**List of tags**

The structure of the tag lists is explained in the table below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Varname</td>
<td>char</td>
<td>Tag name</td>
</tr>
<tr>
<td>Conn</td>
<td>char</td>
<td>Connection</td>
</tr>
<tr>
<td>Group</td>
<td>char</td>
<td>Group name</td>
</tr>
<tr>
<td>Spec</td>
<td>char</td>
<td>Internal tag or address (matching type of link)</td>
</tr>
<tr>
<td>Flag</td>
<td>DWORD</td>
<td>Tag type</td>
</tr>
<tr>
<td>Common</td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>Ctyp</td>
<td>DWORD</td>
<td>Tag type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 BIT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 SBYTE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 BYTE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 SWORD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5 WORD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6 SDWORD</td>
</tr>
<tr>
<td>Field</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7 DWORD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8 FLOAT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9 DOUBLE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 TEXT_8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 TEXT_16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12 Raw data type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>13 Field</td>
</tr>
<tr>
<td></td>
<td></td>
<td>14 Structure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>15 BITFELD_8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>16 BITFELD_16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>17 BITFELD_32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>18 Text reference</td>
</tr>
<tr>
<td>CLen</td>
<td>DWORD</td>
<td>Length of the tags</td>
</tr>
<tr>
<td>CPro</td>
<td>DWORD</td>
<td>Internal or external tag</td>
</tr>
<tr>
<td>CFor</td>
<td>DWORD</td>
<td>Format conversion</td>
</tr>
<tr>
<td>Protocol</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P1</td>
<td>BOOL</td>
<td>Error at upper limit</td>
</tr>
<tr>
<td>P2</td>
<td>BOOL</td>
<td>Error at lower limit</td>
</tr>
<tr>
<td>P3</td>
<td>BOOL</td>
<td>Conversion error</td>
</tr>
<tr>
<td>P4</td>
<td>BOOL</td>
<td>Write error</td>
</tr>
<tr>
<td>P5</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>P6</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>L1</td>
<td>BOOL</td>
<td>Substitute value on upper limit error</td>
</tr>
<tr>
<td>L2</td>
<td>BOOL</td>
<td>Substitute value on lower limit error</td>
</tr>
<tr>
<td>L3</td>
<td>BOOL</td>
<td>Start value</td>
</tr>
<tr>
<td>L4</td>
<td>BOOL</td>
<td>Substitute value on link error</td>
</tr>
<tr>
<td>L5</td>
<td>BOOL</td>
<td>Upper limit valid</td>
</tr>
<tr>
<td>L6</td>
<td>BOOL</td>
<td>Lower limit valid</td>
</tr>
<tr>
<td>L7</td>
<td>BOOL</td>
<td>Start value valid</td>
</tr>
<tr>
<td>L8</td>
<td>BOOL</td>
<td>Substitute value valid</td>
</tr>
<tr>
<td>LF1</td>
<td>double</td>
<td>Upper limit</td>
</tr>
<tr>
<td>LF2</td>
<td>double</td>
<td>Lower limit</td>
</tr>
<tr>
<td>LF3</td>
<td>double</td>
<td>Start value</td>
</tr>
<tr>
<td>LF4</td>
<td>double</td>
<td>Substitute value</td>
</tr>
<tr>
<td>Scaling</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCF</td>
<td>DWORD</td>
<td>1 when scaling is defined</td>
</tr>
<tr>
<td>SPU</td>
<td>double</td>
<td>Range of values, process from</td>
</tr>
<tr>
<td>SPO</td>
<td>double</td>
<td>Range of values, process up to</td>
</tr>
<tr>
<td>SVU</td>
<td>double</td>
<td>Range of values, tag from</td>
</tr>
<tr>
<td>SVO</td>
<td>double</td>
<td>Range of values, tag up to</td>
</tr>
</tbody>
</table>
Connection list

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conname</td>
<td>char</td>
<td>Logical tag name</td>
</tr>
<tr>
<td>Unit</td>
<td>char</td>
<td>Channel Unit</td>
</tr>
<tr>
<td>Common</td>
<td>char</td>
<td>General</td>
</tr>
<tr>
<td>Specific</td>
<td>char</td>
<td>Specific link parameter</td>
</tr>
<tr>
<td>Flag</td>
<td>DWORD</td>
<td></td>
</tr>
</tbody>
</table>

Data structure list

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datastructure</td>
<td>short</td>
<td>Data structure name or component name</td>
</tr>
<tr>
<td>Type ID</td>
<td>short</td>
<td>Identification (is used in tag list under Ctyp)</td>
</tr>
<tr>
<td>Creator ID</td>
<td>short</td>
<td></td>
</tr>
</tbody>
</table>

In order to be able to continue processing the text lists in EXCEL (Version 7.0 or 8.0), you must open the exported files of file type *Textfiles [*prn; *txt; *csv].

Specifications

Customization of the tag data in the text list is performed under the following special specifications:

<table>
<thead>
<tr>
<th>Type</th>
<th>In text list</th>
<th>In WinCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>General description</td>
<td>If not available, logical links <strong>must</strong> be redefined!</td>
</tr>
<tr>
<td></td>
<td>Special description of channel DLL</td>
<td>If not available, channel DLLs <strong>must</strong> be redefined!</td>
</tr>
<tr>
<td>Tag group</td>
<td>No group information</td>
<td>The group information is automatically generated when the first tag of a group.</td>
</tr>
<tr>
<td></td>
<td>If groups are defined in the project, which do not contain any tags, these groups are also not exported.</td>
<td></td>
</tr>
<tr>
<td>Tags</td>
<td>General description</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Specific description</td>
<td>Channel DLL or internal tag</td>
</tr>
<tr>
<td></td>
<td>Respective channel DLL or internal tag</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On export, the missing sections are replaced by *</td>
<td>Tags whose specific description is missing are not imported!</td>
</tr>
<tr>
<td>Tags of Data structure type</td>
<td>Assignment corresponding to the data structure definition of the structure list.</td>
<td>Is assigned to the data type.</td>
</tr>
<tr>
<td>Data structure definition</td>
<td></td>
<td>Must be defined by the person configuring the system.</td>
</tr>
<tr>
<td>Limits</td>
<td>Are not exported or imported via the text list.</td>
<td>Must be defined by the person configuring the system.</td>
</tr>
</tbody>
</table>
Before you import the modified or new tags, **backup the data** of your project. Changes are made in the database. These database changes cannot be undone in WinCC.

### 3.3.9.6 Taking over multilingual texts (from pictures, in messages)

#### Multilingual texts of the pictures

The multilingual texts stored in the pictures can be transferred to the new project by copying the picture itself.

The respective language must be added to the text library in the new project. Check the settings in the Text Library. Each language must have its own column!

Should only some of the languages be taken over in the new project? Since the entire text information per picture is stored, reconfiguring in the respective language must be carried per picture. You should consider whether or not it makes more sense to delete the texts already configured. Switching over to runtime is made possible only by means of specially configured keys and could consequently be restricted for the project. If you nevertheless want to delete the texts for a language that has already been included, we recommend you use the export and import function via the auxiliary tool known as **language**.
Taking over pictures with text references

If text references are used in the pictures taken over, the following data must also be taken over:

- the associated tags (export or redefinition) from the tag management of the WinCC project
- the texts from the text library
- The text reference tags must be provided with the valid text identification numbers (text IDs). Check whether the text IDs still match up with the associated texts.

Taking over texts from the text library

If only some of the texts from the text library are taken over, you must adjust the text IDs accordingly. Texts from the text library can be taken over by means of the export/import mechanism in the Text Library editor.

3.3.9.7 Taking over messages

The information basis for messages (alarms) requires

- modification and
- a great deal of configuration work due to the volume (bulk data).

For this reason, the option of taking over message data from previous projects is used very frequently. The following methods of taking over messages can be used depending on the source of the message data:

- taking over already configured message information from predecessor systems (e.g. COROS)
- importing (single) messages from an existing WinCC project
- importing message information from the concept phase
Taking over messages from COROS

The procedure for the sources quoted above looks as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: taking over existing COROS message texts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In COROS, export message information (<em>texte.txt</em>)</td>
</tr>
<tr>
<td>2</td>
<td>In WinCC, read in this message file using the <code>Dynamic Wizard Import Functions → Import Messages</code>. The data is now imported into the current WinCC project.</td>
</tr>
</tbody>
</table>

Taking over messages from a WinCC project

If messages are taken over from an existing project, you must first clarify whether or not the destination message system (Alarm Logging) has been set up in the database structure in the same way. The differences can be seen, for example, in the user and process value blocks. If possible, organize the destination data blocks according to sequence (as well as according to the length of the text elements) straight away. Otherwise you will have to made adjustments in the individual columns before importing.

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: taking over existing WinCC message texts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the <code>Alarm Logging</code> editor in the current project.</td>
</tr>
<tr>
<td>2</td>
<td>Call the message export procedure by choosing <code>Messages → Export Single Messages</code> from the menu.</td>
</tr>
<tr>
<td>3</td>
<td>Specify the destination text file in which the message information to be exported is to be stored. Under <code>Selection...</code>, select the messages to be exported; use the criteria, e.g. Number, Message class.</td>
</tr>
<tr>
<td>4</td>
<td>Start the export procedure by clicking <code>Export</code>. A text file containing items of message information separated by commas is now created.</td>
</tr>
<tr>
<td>5</td>
<td>Close the current project and open the new one. Open the <code>Alarm Logging</code> editor again and define the necessary message classes and message types. Define one message per message type, in order to retain the basic framework for the following import.</td>
</tr>
<tr>
<td>6</td>
<td>To export these basic messages, select <code>Messages → Export Single Messages...</code> Repeat steps 3 and 4.</td>
</tr>
<tr>
<td>7</td>
<td>Now open, e.g. in EXCEL, the message file of the source project and the message file of the destination project. The columns are separated by commas. Compare the structure of the message blocks and, if necessary, make adjustments by reorganizing or renaming columns.</td>
</tr>
</tbody>
</table>
### Procedure: taking over existing WinCC message texts

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Enter the index 0 in each of the blocks with the text IDs. This means that the texts are automatically organized in the text library when imported. Under no circumstances may the old ID numbers be retained! The modified file must once again be saved as a text file.</td>
</tr>
<tr>
<td>9</td>
<td>Now call the import procedure by selecting Messages → Import Single Messages....</td>
</tr>
<tr>
<td>10</td>
<td>Now specify the source text file with the exported message information. You now have to decide whether existing messages are to be overwritten during importing. The messages are assigned by means of the respective message number, which must be uniquely defined in the project. The messages are then imported and supplement your existing message system (Alarm Logging) with the message information already configured. Check the assignments imported.</td>
</tr>
</tbody>
</table>

#### Import Messages

- **File:**
- **Mode:**
  - Overwrite Messages and Import New Messages
  - Import New Messages Only
  - Delete Messages
- **Specify the file from which messages should be imported.**

#### Note:

If message data is taken over from a WinCC V 1.10 project, you must pay attention to the column headers in the message text file!
Importing message information from the concept phase by means of EXCEL tables

The message information is already available in an EXCEL table. These messages can be taken over by incorporating the columns into the message structure of the WinCC project. This must be done by building on a WinCC message file. This file is created in the following manner:

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: creating a message structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the new project in the WinCC Control Center. Open the Alarm Logging editor and define the necessary message blocks, message classes and message types. Define one message per message type, in order to retain the basic framework for the following import.</td>
</tr>
<tr>
<td>2</td>
<td>To export these basic messages, select Messages → Export Single Messages,...</td>
</tr>
<tr>
<td>3</td>
<td>Specify the destination text file in which the message information to be exported is to be stored.</td>
</tr>
<tr>
<td>4</td>
<td>Start the export procedure by clicking Export. A text file containing items of message information separated by commas is now created.</td>
</tr>
<tr>
<td>5</td>
<td>In EXCEL, open the message file and the freshly created message file of the destination project. The columns are separated by commas. In the table, create a copied line for the corresponding message class/message type. Take over the message texts etc. from the source data and enter them in the associated blocks. For example: Block 1 → Message text. Number all of the message lines, e.g. starting from 1. This can be done very quickly in EXCEL with the aid of the numbering in the message number column.</td>
</tr>
<tr>
<td>6</td>
<td>Enter the index 0 in each of the blocks with the text IDs. This means that the texts are automatically organized in the text library when imported. Under no circumstances may the old ID numbers be retained! The modified file must once again be saved as a text file.</td>
</tr>
<tr>
<td>7</td>
<td>In the Alarm Logging editor, call the import procedure by selecting Messages → Import Single Messages,...</td>
</tr>
<tr>
<td>8</td>
<td>Now specify the source text file with the exported message information. You now define the parameters in such a way that existing messages are overwritten. The messages are assigned by means of the respective message number, which must be unique in the project.</td>
</tr>
<tr>
<td>9</td>
<td>The messages are then imported and supplement your existing message system (Alarm Logging) with the message information already configured. Check the assignments imported.</td>
</tr>
</tbody>
</table>

3.3.9.8 Taking over measured values

Since the specifications for measurement points and the definitions of the process value archives and user archives together with their properties are integrated directly into the database structure, it is not possible to take over measured values (without direct accessing of the database, which requires a sound knowledge of the database). This means that either these archives and measurement points must be reconfigured or the data is taken over automatically at the start of configuration by copying an entire basic project.
3.3.9.9 Taking over print layouts

Copy the desired print layouts (*.rpl for page layouts or *.rpl for a line layout) from the source folder to the \PRT folder of the new project.

3.3.9.10 Taking over global actions

Copy the desired global actions or background actions (*.pas) from the source folder to the \PAS folder of the new project.

3.3.9.11 Taking over project functions

*.fct) from the source folder to the \library folder of the new project. To make these functions known to the project, you have to activate the option Options → Generate Header in the Global Scripts editor. You will find a detailed description of how to do this in Section 4.1 The development environment for scripts in WinCC.

3.3.9.12 Using standard functions

Contrary to project functions, standard functions don’t have to be copied. These functions are immediately available for the project, since they are known to all WinCC projects on the station.

3.3.9.13 Taking over user administration

Since the specifications for user groups, users and access rights are integrated directly into the database structure, it is not possible to take over user administration. This means that a reconfiguration is necessary.
There is one way round this: the data is taken over automatically at the start of configuration by copying an entire basic project.
3.3.10 Working without a mouse

Plant pictures are in many cases controlled under WinCC by means of the mouse. The mouse click or mouse action is the event among the respective types of dynamization, which is used most frequently and in the greatest number of different variants (left or right mouse button, press or release). There are, however, systems which are controlled using both a mouse and a keyboard or even just a keyboard. Operator panels, for example, are exclusively controlled by means of a keyboard.

3.3.10.1 Working with a keyboard

A keyboard offers the following input options:

- Function keys F1 through F12
- Special function keys (e.g. Operator panel function keys SF10)
- Standard keyboard inputs
- Moving around by means of input fields or control buttons, by means of arrow keys or special keys

Configuration of the control actions without a mouse must looked at separately for the following areas of configuration:

- Control buttons in the plant picture (e.g. for changing pictures)
  - by means of function keys
  - by means of special keys
  - by means of standard keys
- "Any key" control
- Moving around by means of control objects
- Input fields in the plant picture
  - input/output fields
  - special input objects (check box, ...)
- Alarm Logging (message windows)
  - control actions by means of function keys
  - control actions by means of specially configured keys
- Tag Logging (trend or table windows)
  - control actions by means of function keys
  - control actions by means of specially configured keys
- Starting a print job by means of a key
- Logging on or off by means of the keyboard

Control buttons are configured in the typical Windows style. This is why you will find the standard Windows control button in the Object Palette. You can add other graphical elements to this button at any time.
Control buttons

Control actions by means of function keys

Function keys F1 through F12 on the standard keyboard are frequently used as (additional) keyboard action for control buttons for changing pictures in the plant picture hierarchy. These function keys can be assigned at any time to the configured Windows buttons as hot keys. A hot key offers you the quickest way of initiating the function assigned to it.

Hot keys can be assigned, for example, to the functions keys mentioned. These keys are already displayed in the configuration dialog box as selection buttons.

If you need to combine a key with, for example, the SHIFT key or CTRL key, then simply enter the desired key sequence (e.g. SHIFT+F2) directly into the input field by pressing the respective keys. There is no need to enter any special codes. The key combination you have selected is displayed in the input field.
This key selection is stored in the properties of the object and can be modified either by means of the configuration dialog box or directly by means of the property Miscellaneous → Hot key.

**Action for hot key**

The action which is to be triggered by entering the function key (hot key definition) must be stored under the events of the Windows button, the event under which it must be stored being the Mouse Action. The event is triggered when the mouse button is released, but only when the mouse pointer is positioned over the object when pressed and released. If there is no action stored under the mouse action (click) event, but e.g. only under the (similar) event known as Press left (i.e. the left mouse button), the action will not be
triggered by the function key! When configuring, please also note that the function key can only be used once in the picture.

**Special function keys**

If you use special function keys, e.g. the operator panel buttons F13, S1 etc., for controlling the pictures, these keys must be reassigned to key combinations. The F13 key could, for example, be reassigned to the combination SHIFT+F1. In addition to the usage for the key combinations chosen in the visualization mechanism as described above, the combinations are also defined specific to particular devices. You will find special keyboard settings for this purpose, which depend on the respective devices used. For example, a file named FIL25.key is provided for the settings of the key codes for an industry PC. These device-specific files are used for storing the codes for the function keys. After adjusting the device keyboard definition - per function key with the respective hexadecimal code - and activating the new keyboard codes, these keys in the plant pictures can then be used for working in the pictures.

**Standard keys**

If the action is not assigned to a function key input but to a key on the standard keypad, e.g. the letter m, this key is stored as a hot key under the Windows button object.

**"Any key" control**

The design of the control buttons for the plant pictures can itself be created. You can find other control buttons, e.g. in the user library under 3D buttons or user objects. Objects you have designed yourself that are not based on the Windows button cannot be configured as hot keys. All other objects must be configured for button control by means of the Button event of the object. The following keyboard events are available per object:

- Press
- Release
This button event must be available to enable configuration of keyboard control actions. When using predefined buttons from the user library, you must therefore first check whether or not this button is suitable for working with only a keyboard and without a mouse. The shift buttons of the user objects, for example, are not always enabled for keyboard control actions. This means you may have to make adjustments.

Preconfigured button (key) actions (e.g. scrolling through the picture hierarchy) can be found in the optional packages (e.g. Basic Process Control - Picture Tree Manager etc.).

If one of these objects is used as a control element, the button (key) which triggers the action is configured to respond to either the Keyboard - Press or Keyboard - Release event. Either a direct link or a C action can be configured as the action. The triggering button event is either

- an "any key" action or
- a selected key on the standard keypad.

If the event is an "any key" event, a direct link can be used. In contrast, if a specific key input has to be checked, a C action must be used. The C action checks the key code entered, character for character, before continuing the actual sequence of the action:

```c
if (nChar==S)
    OpenPicture("Start.pdl");
```

If key combinations are queried, further checks must take place after the first keyboard code is queried. To this end, the special function „GetAsyncKeyState“ must be used in the following way:

```c
#include "apdefap.h"
void OnKeyDown(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName, UINT nChar, UINT nRepCnt, UINT nFlags)
{
    #pragma code("user32.d11")
    int GetAsyncKeyState(int vkKey);
    #pragma code();
    int nRet;
```
3.3.10.2 Moving around by means of control objects (input fields and control fields)

The mouse can be used to click directly onto every controllable object. Whether or not objects can be controlled is indicated by the mouse pointer changing. How can these objects be controlled without a mouse?

**Alpha cursor / Tab order**

You can move between the controllable objects in runtime mode by means of the movement keys. A distinction is made between:

- alpha cursor objects (I/O objects) and
- tab order objects.

Input/output objects are selected by means of the alpha cursor (the Tab key or SHIFT+Tab key combination).

All control elements (whether controllable by mouse, keyboard or both) can be integrated into control by means of the tab order. The I/O fields can be integrated into control by means of both the alpha cursor and the tab order.
### TAB sequence

Using the so-called **TAB order** (it can be set by choosing *Edit → TAB Order → Alpha Cursor or → Tab orders* from the menu) you can influence the order in which operator-controllable objects are addressed in RUNTIME mode. The object currently selected can be visualized in Runtime. This is the runtime cursor, which can also be turned off (*Computer properties → Graphics-Runtime*). Windows-style buttons are always shown with a dashed quadrangle on the button.

Moving around between the controllable elements depends on the settings for the Graphics Runtime (*Computer properties → Graphics-Runtime*).

<table>
<thead>
<tr>
<th>Movement</th>
<th>Standard keys</th>
<th>Key settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up, Down left, right</td>
<td>Cursor (arrow) keys or Tab (next) or SHIFT+Tab (previous)</td>
<td>Other key settings by means of <em>Computer properties → Graphics-Runtime → Cursor control: keys</em></td>
</tr>
<tr>
<td>Alpha cursor / Tab order</td>
<td>Tab order</td>
<td>Switching between alpha cursor and tab order by means of hot keys (<em>Computer properties → Graphics-Runtime → Hot keys</em>) or self-defined keys (using the internal function <em>SetCursorMode</em>).</td>
</tr>
<tr>
<td>Movement in tables (cursor group)</td>
<td>Normal, i.e. line-by-line editing</td>
<td>Changing the characteristics (behavior) by means of <em>Computer properties → Graphics-Runtime → Cursor control: characteristics</em></td>
</tr>
</tbody>
</table>

### Input/output fields

Configured input/output fields can be written in directly after being selected via the keyboard, i.e. you can enter your new data immediately. A pure output field (*Properties → Input/Output → Field Type → Output*) cannot be changed.

Input is confirmed as a function of the configured property (*Properties → Output/Input → Apply on Exit*) by means of ENTER. In contrast, the ESCAPE key (ESC) exits input without saving the changes (if any) made.

### Other input objects

In addition to the typical analog input fields, Windows applications offer other input options. These particular objects can be found in the Object Palette under *Windows Objects*:

- **Check Box**
- **Option Group**

The individual selection fields of the check box or option group are set by means of the spacebar, moving across the individual components in the box or group performed by means of the Up/Down keys (e.g. arrow keys). This is the key assignment already set by default.

Another input object is the **text list object**. You can make a selection by means of an opened list that is dependent on the entries configured:

This object can likewise be controlled by means of the standard keyboard. There is no need to store a special configuration for the keyboard control action.
The list is opened by pressing ENTER, moving around in the list performed by means of the Up/Down keys and confirmation of the current selection by pressing ENTER.

Further input objects could be used by means of the OCX elements in WinCC. Control and configuration of these objects depends, however, on the events and properties available which have been defined specific to the object. This must be clarified in each individual case.

### 3.3.10.3 Alarm Logging function keys for the toolbar buttons

In the message windows, different control buttons are set in the toolbar, which are controlled by means of the mouse (standard).

The most frequent control actions in a message window are
- selecting a message for acknowledgement
- moving up/down through the message list
- scrolling through the message list

**Note:**
When opening the message window or through a further control action, control must lie in the message window (application window) and not in the main window. Depending on the current controllability, the key actions (or function keys) act on the function key bar of the main window or on the stored key actions of the message window.

This can be achieved, for example, by setting the current focus of control in this section of the window. The focus of control is normally set by clicking with the mouse.

Using the keyboard, the focus can be set in message windows by means of the following configurable routes:
- changing the window by means of a hot key
- setting the focus by means of a control button or
- setting the focus directly to a defined element in the message window on opening the picture.

Changing (switching) to the message window by means of a quick control action (hot key) which can be used in the same way for all window changes, i.e. in trend windows too, is defined in the startup parameters of the Graphics Runtime. The key combination (e.g. CTRL+W) is entered under Computer properties → Graphics/Runtime → Hot keys → Window On Top.

Once the message window has been opened, the buttons in the toolbar can be activated directly by means of this key sequence.

Direct setting of the focus of control in the message window is, however, achieved by means of the internal function Set_Focus. A C action on making a key action or on Open Picture (Picture Object → Events → Miscellaneous → Open Picture) can therefore influence activation of control of the message window.
The functions for the focus of the picture can be found in the Global Script editor under *Internal functions → graphics → set → focus*. For example, the following function is called to set the focus of control:

```
Set_Focus(picture name, object name);
```

The name of the main window (picture name) and the application window (object name) must be entered as the parameters.

A message in the message window is selected by choosing the message line. When the message window is opened, the cursor is positioned in the youngest message (the last message in the message picture). Whether or not it is actually possible to select a message in the window or to scroll through the messages depends on the whether the scroll mechanism is active or not.

The picture scroll mechanism can be turned on/off either by means of a button in the toolbar or directly in the configuration of the message window template. When a picture is opened, the scroll mechanism is actively turned on in the *Alarm Logging → Message Window Templates → Parameters → AutoScrolling editor*.
If scrolling and the focus of control in the message window are active, the movements can be performed as follows:

<table>
<thead>
<tr>
<th>Movement</th>
<th>Standard keys</th>
<th>Key settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>up/down through the message list</td>
<td>Arrow keys</td>
<td>Individual message lines</td>
</tr>
<tr>
<td>Start, end of message list</td>
<td>Home, End keys</td>
<td>Start, end of message picture</td>
</tr>
<tr>
<td>Scrolling</td>
<td>Scrolling keys (Page Up/Page Down)</td>
<td>Several message lines</td>
</tr>
</tbody>
</table>

In addition to being able to activate the buttons on the toolbar (such as acknowledgement of the selected message) by means of standard mouse action, you can also define control actions by means of function keys. A separate key action can be stored under the properties for each button displayed on the toolbar (`Alarm Logging → Message Window Templates → Toolbar → Key Crossed and Selected → Properties`).
For example:

These configuration steps enable you to assign a key combination to each and every one of the buttons used for the message window. You should therefore also define key actions to enable the message window to be controlled by means of the keyboard.

3.3.10.4 Alarm Logging - toolbar buttons designed specifically for a plant

All the toolbar buttons are specified by WinCC and they cannot be changed. If a given button layout is specified for the plant to be configured, you must deactivate the WinCC
toolbar (i.e. no toolbar) and design the relevant buttons yourself. All of these new button objects can be designed to satisfy the wishes of the customer, e.g. given icons.

The functionality assigned to a particular button must, however, still be configured as an associated action. In the *Action* of the associated event (e.g. Press button), the corresponding *standard function* must be selected from the function tree.

The functions available for assigning to buttons can be found in the Global Script editor under *Standard functions → alarm*. For each button in the toolbar, the list contains a function which corresponds to it. For example, the Single Acknowledgement button is called by means of the following function:

```plaintext
OnBtnSinglAckn(window name);
```

The name of the *message window template* must be entered as the parameter. These actions can also be used for buttons you have designed yourself by means of mouse control.

A number of examples of such buttons can be found in the optional packages for the alarm system (e.g. *Basic Process Control* - Horn acknowledgement etc.).

### 3.3.10.5 Tag Logging function keys for the toolbar buttons

In the trend or table windows used for displaying measured values (also known as trend displays), various buttons are assigned to the toolbar, which are normally selected using the mouse.

The most frequent control actions in a trend window are
- scrolling through the measured values (time axis)
- selecting a time frame
- selecting trends
- using the read ruler

After opening the trend window, the current trend curve is displayed depending on the configuration.

**Note:**

When opening the message window, control must lie in the trend window (application window) and not in the main window. Depending on the current controllability, the key actions (or function keys) act on the *function key bar* of the main window or on the stored key actions of the trend or table window.

This can be achieved, for example, by setting the current focus of control in this section of the window. The focus of control is normally set by clicking with the mouse.

Using the keyboard, the focus can be set in trend or table window by means of the following configurable routes:
- changing the window by means of a hot key
- setting the focus by means of a control button or
- setting the focus directly to a defined element in the message window on opening the picture.

Implementation of these different variants can be found in this chapter under the description of Alarm Logging.
In addition to being able to activate the buttons on the toolbar (such as selection of a time frame) by means of standard mouse action, you can also define control actions by means of function keys. By default, the individual buttons are occupied by the function keys F1 through F10.

A separate key action can be stored under the properties for each button displayed in the toolbar (Tag Logging → Trend window templates → Template → Toolbar → Configure...). For example:

![Toolbar Configuration](image)

These configuration steps enable you to assign a key combination to each and every one of the buttons used for the trend or table window. You should therefore also define key actions to enable the trend or table window to be controlled by means of the keyboard.

The following standard keys can be used in the trend window once the respective function key has been activated:

<table>
<thead>
<tr>
<th>Movement</th>
<th>Standard keys</th>
<th>Key settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read ruler</td>
<td>Arrow keys</td>
<td>For moving the read line left or right.</td>
</tr>
<tr>
<td>Zooming</td>
<td>For selecting zoomed window.</td>
<td>For setting and activating substitute input aid for mouse (see system settings). INS and arrow keys enable you to define the zoomed window.</td>
</tr>
<tr>
<td>Dialog boxes, e.g. archive tag selection</td>
<td>Tab key</td>
<td>For moving between the input fields</td>
</tr>
<tr>
<td></td>
<td>Arrow keys</td>
<td>For moving within tag selection or tab selection</td>
</tr>
<tr>
<td></td>
<td>+ key (- key)</td>
<td>For displaying or closing the tree of the archive tags</td>
</tr>
</tbody>
</table>
### Tag Logging - toolbar buttons designed specifically for a plant

All the toolbar buttons are specified by WinCC and their design cannot be changed. If a given button layout is specified for the plant to be configured, you must deactivate the WinCC toolbar (i.e. no toolbar) and design the relevant buttons yourself. All of these new button objects can be designed to satisfy the wishes of the customer, e.g. given icons. The functionality assigned to a particular button must, however, still be configured as an associated action. In the *C action* of the associated event (e.g. Press button), the corresponding *standard function* must be selected from the function tree.

The functions available for assigning to buttons can be found in the Global Script editor under *Standard functions* → *TAGLOG* (or additionally → *TEMPLATE* for the table functions). For each button in the toolbar, the list contains a function which corresponds to it. For example, the read ruler is called by means of the following function:

```c
TlgTrendWindowPressLinealButton(picture_name);
```

The name of the *trend window template* must be entered as the parameter.

These actions can also be used for buttons you have designed yourself by means of mouse control.

### 3.3.10.6 Starting a print job

A print job can be started in a number of different ways. In the *Control Center*, for example, printing is activated directly by selecting from the list of print jobs. You can, however, also create a Print button in the plant window itself, which you can used to start the print job.

This button already exists in the toolbar for the message lists and can, as described on the previous pages, be activated by a function key or a key you have designed yourself.

A printout of the screen contents - a hardcopy - can be activated in every picture by means of a hot key. This hot key is set globally in the project properties. To do this, select *Project properties* → *HotKeys* → *Hard copy* in the *Control Center* and define the hot key by directly entering the key combination (by pressing the respective key(s) on the keyboard).
If you configure your own button for printing a defined print job in the plant picture, the action must be triggered by a *C* *a* *c* *t* *i* *o* *n*. As described at the beginning of the chapter, the button is activated by, for example, a function key (see hot key) or a keyboard action (e.g. the D key). The *C* *a* *c* *t* *i* *o* *n* must correspondingly be configured to the event in question (e.g. *M* *o* *u* *s* *e* *e* *r* *A* *c* *t* *i* *o* *n* or *K* *e* *y* *b* *o* *a* *r* *d* * -* *P* *r* *e* *s* *s*). WinCC makes this functionality available with the functions in *S* *t* *a* *n* *d* *a* *r* *d* * F* *u* *n* *c* *t* *i* *o* *n* *s* → *R* *e* *p* *o* *r* *t* → *R* *e* *p* *o* *r* *t* *J* *o* *b*.

```
ReportJob("Documentation Control Center","PRINTJOB");
```

The function requires two transfer parameters, the first of which is the name of the print job and the second of which defines the print destination (printer or screen).
3.3.10.7 Logging in or out

In addition to the hot keys that can be configured for the login and logout procedures, you can also configure a button which calls the Login dialog box. You can also log out by means of a key action. For this purpose, you have to configure a separate button, which can, for example, be activated both by a mouse action and via the keyboard. You can also set a function key control action by means of the hot key property of the button. The various variants of button and key action are described in detail at the beginning of this chapter.

The function which must be used for login and logout is a WinCC application function. This function must be configured as a C action. Attach the C action, for example, to the event known as mouse click or the event press key.

The following function is used for logout:

```c
#pragma code("useadmin.dll")
#include "PWRT_api.h"
#pragma code()
PWRTLogout();
```

Login is activated by the WinCC C application function PWRTLogin(). Here is an example of how this function could be used:

```c
#pragma code("useadmin.dll")
#include "PWRT_api.h"
#pragma code()
PWRTLogin(c);
```

The dialog box that pops up can be controlled by means of the standard keys:

<table>
<thead>
<tr>
<th>Movement</th>
<th>Standard keys</th>
<th>Key settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual input fields</td>
<td>Tab key (forward) or SHIFT+Tab (backward) Arrow keys</td>
<td>For moving the read line left or right.</td>
</tr>
<tr>
<td>Confirm (OK)</td>
<td>ENTER key</td>
<td>For exiting a dialog box and confirming the input.</td>
</tr>
<tr>
<td>Cancel (Abort)</td>
<td>ESC</td>
<td>For canceling a dialog box or input.</td>
</tr>
</tbody>
</table>
3.3.11 Module technology

Picture module technology is a crucial strategy for enabling quick and simple configuration and the reusability and maintainability of configured picture components.

A configured process box is used, for example, for several process components of the same kind (e.g. valves or controllers).

The original picture window configured can now be reused for the control modules that are to be worked with and visualized in the project. This is done in accordance with the following principles:

- copying a picture window and reconnecting the tag fields
- using a picture window whose tag fields are assigned on being called (indirect link)
- using user objects with prototypes and objects created from them
- creating prototype pictures and integrating them
- creating OCX picture modules and integrating them as WinCC OCX objects

Comparing the different techniques

These techniques differ very greatly with respect to how they are applied, the complexity of configuration and their possibilities. For this reason, we will start by comparing the alternatives.

<table>
<thead>
<tr>
<th>Type</th>
<th>Advantage</th>
<th>Disadvantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy of picture windows</td>
<td>Simple procedure</td>
<td>All object links must be changed. Changes to picture buildup lead to complex post-processing.</td>
</tr>
</tbody>
</table>
| Picture window with indirect link | • Once-only buildup of the picture window with simple C actions  
• Reuse without copying the basic picture window | Changes to picture buildup lead to complex post-processing.                   |
| Smart objects            | Once-only buildup of the object with link by means of existing Dynamic Wizards | • Changes to picture buildup lead to post-processing, i.e. picture regeneration.  
• Cannot be changed centrally. |
| Prototype pictures       | • Once-only buildup of the object  
• Can be changed centrally.       | (Good) knowledge of C necessary.                                             |
| OCX                      | • Simple integration into configuration of WinCC as an object in the picture  
• A later modification of the OCX object doesn’t lead to post-processing in the objects generated, except when changes are made to the object | Must be created by writing a program (C++, VB 5); cannot be created by means of WinCC configuration. |
If only a few simple picture modules are used in the project, one of the first variants is adequate enough to satisfy the person configuring the system. These variants can be implemented without any great training being required.

The user object is particularly suitable for simple objects of low to medium complexity and tag link. If you foresee that the object will require a number of changes, you will find it makes sense to get to grips with the concept of prototype pictures.

If the graphic modules are of a complex nature or if comprehensive processing work is required, preference should be given to OCX technology. The OCX objects available will in the future grow stronger and stronger in this field.

In the following chapters, we will show you the various types of picture module configuration and how they are put to use in the plant pictures. This will enable you to form your own picture of the different variants and their applications in your projects.

### 3.3.11.1 Process box as a picture module

Specific information boxes pop up in the plant pictures to display the current states of a device (controller, valve, motor etc.) or to enable you to specify set values. These process boxes typically contain both current states (actual values) and set values, which can be entered by the privileged operator.

#### Creating the information box

This information box is created as a picture window whose components are connected to the corresponding (process) tags.

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data structures</td>
<td>Define the data structures to be used in the picture module by means of the tag management, e.g. motor with actual value, set value, on-off switch.</td>
</tr>
<tr>
<td>2</td>
<td>Picture module</td>
<td>Using the <em>Graphics Designer</em>, configure a picture which displays the device states, e.g. bars and I/O fields, and control buttons. The size of the picture window (picture object property - X variable and Y variable) must correspond to the target size of the picture window.</td>
</tr>
<tr>
<td>3</td>
<td>Defining the tags</td>
<td>Define the (process) tags in the tag management, e.g. Motor_T01 of the (structure) data type Motor Type, which is used for the process box.</td>
</tr>
<tr>
<td>4</td>
<td>Tag link</td>
<td>Now dynamize the individual picture components, e.g. I/O fields, bars etc., by connecting them to the corresponding (process) tags.</td>
</tr>
<tr>
<td>5</td>
<td>Picture window</td>
<td>In the plant picture, create a picture window object and connect it to the picture window contents created under steps 2 through 4.</td>
</tr>
</tbody>
</table>
This picture window object, the picture window contents and the corresponding call of the picture window (button) can be reused in a similar form for further devices. All you have to do is copy the picture window object, the picture module and the button. The references must be adapted each time. The picture window object and the button can both be copied by being dragged to and dropped in the graphics library (e.g. project library).

**Customizing the picture modules**

The following individual steps must therefore be carried out when using the picture module created:

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Process tags</td>
<td>Define a new process tag, e.g. Motor_T02, for the defined data structure.</td>
</tr>
<tr>
<td>2</td>
<td>Copy of the picture module</td>
<td>Make a copy of the picture window contents (Motort02.PDL) and change all permanently stored references (e.g. instead of Motor_T01.ActValue, now Motor_T02.ActValue).</td>
</tr>
<tr>
<td>3</td>
<td>Copy of the picture window</td>
<td>Make a copy of the picture window object in the destination plant picture (by dragging and dropping from the graphics library). Adapt the reference to the picture window contents under Properties... → Picture name (Motor02.PDL).</td>
</tr>
<tr>
<td>4</td>
<td>Copy of the button</td>
<td>Make a copy of the button in the destination plant picture (by dragging and dropping from the graphics library). Adapt the reference to the new picture window object in the direct link (Object → Picture Window2 → Display).</td>
</tr>
</tbody>
</table>

In this way, the individual picture windows and their contents can be created for each device and reused by being copied. As can already been seen, the work this necessitates is that of adjusting the permanently stored references for the picture window contents. For this reason, there is a more simple method of achieving reusability through indirect addressing. The amount of adaptation work required should be kept to a minimum.

An alternative solution to this is to configure the picture module without a link to the picture window. This means that the picture module itself is configured as a non-displayed object in the plant picture. The great disadvantage of this, however, when changing the picture module is that a change must be made in all the pictures in which this picture module is used.
So far, the individual components of the picture module have been permanently connected to the corresponding (process) tags. If the link is not made by means of a permanent configuration but dynamically during runtime, the picture module created can be used with far greater flexibility. This dynamic linking of (process) tags is implemented by means of indirect addressing of the individual components in the picture module. This means that no direct link is made to the (process) tags; the link made is only to the *container* which will carry the current names of the corresponding (process) tags during runtime.

The adaptational and reusability characteristics of a picture module can in this way be simplified considerably. Configuration is carried out in a similar way to that explained in the steps described above. Here are the actually steps to be carried out:

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Specification of data</td>
<td>Define the data to be used in the picture module by means of the tag management, e.g. Motor001_AcValue, Motor001_SetValue, Motor001_Switch, on the one hand and specify the name container for the individual components that are to be used in the picture module, e.g. ActV_Name, SetV_Name etc., on the other. You initialize these tags with a name, e.g. Motor001_SetValue.</td>
</tr>
<tr>
<td>2</td>
<td>Picture module</td>
<td>Using the <em>Graphics Designer</em>, configure a picture which displays the device states, e.g. bars and I/O fields, and control buttons. The size of the picture window (picture object property - X variable and Y variable) must correspond to the target size of the picture window.</td>
</tr>
<tr>
<td>3</td>
<td>Tag link</td>
<td>Now dynamize the individual picture components, e.g. I/O fields, bars etc., by connecting them to the corresponding container tags which contain the names of the corresponding tags. You must, however, state in the link that the tag is only the name of the actual (process) tags. You do this by ticking the <em>indirekt.Adr.</em> column in each case.</td>
</tr>
<tr>
<td>4</td>
<td>Picture window</td>
<td>In the plant picture, create a picture window object and connect it to the picture window contents created under steps 2 through 3 by means of the Picture window name property.</td>
</tr>
<tr>
<td>5</td>
<td>Properties - Settings</td>
<td>This picture window object should not be shown when the picture is opened. Therefore, the property <em>Display</em> must be set statically to No. The appearance of the picture window, with the Windows buttons and title etc., must also be defined in the properties of the picture window.</td>
</tr>
<tr>
<td>6</td>
<td>Calling the picture window</td>
<td>This picture window must be caused to pop up by, e.g. clicking a button or working on the device itself. Design a button which is connected to popping-up of the picture window object (e.g. by means of a <em>direct link</em>).</td>
</tr>
<tr>
<td>7</td>
<td>Graphics library</td>
<td>The picture window object and the button are copied to the library (by being dragged and dropped), so they can be reused.</td>
</tr>
</tbody>
</table>
### 3.3.11.3 User objects

User objects and the corresponding dynamic wizards can be used to create picture modules which are easy to reuse. The copy made of the picture module can be connected to the corresponding current (process) tags by means of simple configuration using the wizard. A user object is a graphic object designed by the person configuring the system (e.g. a combination of several objects), whose large number of properties and events are reduced to the essential properties and events by means of a configuration dialog. This user object is dynamized by being defined as a prototype by means of the corresponding wizard.

The following steps must be taken:

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data structures</td>
<td>Define the data structures to be used in the picture module by means of the tag management.</td>
</tr>
<tr>
<td>2</td>
<td>Picture module</td>
<td>Using the Graphics Designer, configure a user object with the user-defined properties.</td>
</tr>
</tbody>
</table>

A user object is formed from a group of WinCC objects. Initially, these objects are not configured with dynamics. All the objects that are to be combined to form the user object are selected and the configuration dialog of the user object is called:

In this dialog box, all the properties of the objects are now declared to be the properties of the user object, which are later to be dynamized. The basic properties for an object (e.g. the position and size) have already been stored for the user object.

Each individual property of the combined objects can be selected in the dialog box and added to the new user object (per Drag&Drop) as a user-defined property or event.

Each of these properties can be assigned a new (language-independent) attribute name by the user and also the language-dependent property name (e.g. for configuration in English). Properties which should not be visibly displayed in the properties dialog, but which are used for example in scripts, can be hidden by using the @ character. This means that only a few properties and events (to be dynamized) can be displayed. All the others are hidden.

The user object you have designed must now be dynamized. A specific wizard is provided to enable you to do this:

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Dynamization</td>
<td>Call the dynamic wizard called Add dynamics to the prototype. As a template (i.e. prototype), link each individual property of the object to the corresponding structural component of the data structure defined. The structure member is selected for interconnection by means of the tag browser. The wizard, however, only saves the name of the structural component on the property linked (e.g. Value). Each individual property must be linked separately. This object is now a dynamic object, which, however, has only been linked as a prototype and is not active during runtime. This means that it cannot be updated during runtime.</td>
</tr>
<tr>
<td>4</td>
<td>Copying to the graphics library</td>
<td>Copy this prototype to the graphics library as an object.</td>
</tr>
</tbody>
</table>
The prototype user object is copied to the graphics library so that it can, for example, be reused again and again. One example of a dynamic object are the pointer instruments in the WinCC library (user library, user objects, pointer instruments).

The prototype object is inserted into the destination plant picture as a copy of the prototype. This copy now has to be linked to the real (process) tags from the tag management.

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Tag</td>
<td>Define a (process) tag for the data structure defined in step 1; this tag is to be used for the user object.</td>
</tr>
<tr>
<td>6</td>
<td>Creating an instance</td>
<td>Copy the prototype object from the graphics library to the plant picture by dragging and dropping it. Link this object to the (process) tag by means of the dynamic wizard called Link a prototype to a structure. The wizard automatically links all necessary structural components of the tags to the correct property of the prototype picture module by replacing each prototype tag link on each property with the actual tag link. You now have an object which is updated with the current tag values during runtime.</td>
</tr>
</tbody>
</table>

3.3.11.4 Dynamic instance (linking prototype to a structure)

*Link a prototype to a structure* dynamic wizard, there is also a wizard called *Make a prototype dynamic*. How does it differ from linking to a structure and which steps have to be modified?

In contrast to permanent linking of an object to tags, the picture modules can also be linked dynamically. This means that the instance to the runtime is set first depending on the current contents of a tag. For example, the above picture module is not linked permanently to the tag; the name of the tag is kept dynamic. The current name of the tag must then be determined by means of a text tag. This text tag, which contains the current name of the tag, must be linked to the picture module.

In contrast to permanent instanciation, i.e. linking to a structure, the following steps must be modified when configuring:

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Picture module</td>
<td>Using the <em>Graphics Designer</em>, configure a user object with the user-defined properties as described above. The user object must contain a <em>Static Text</em> component whose <em>Text</em> property is taken over as a user-defined component. This Text property is assigned an attribute name, <em>Tagname</em>. This tag name is used for dynamic linking of the (process) tags.</td>
</tr>
<tr>
<td>5</td>
<td>Tag</td>
<td>Define a (process) tag for the data structure defined in step 1; this tag is to be used for the user object.</td>
</tr>
<tr>
<td>6</td>
<td>Creating an instance</td>
<td>Copy the prototype object from the graphics library to the plant picture by dragging and dropping it. Link this object to the (process) tag by means of the dynamic wizard called Link a prototype to a structure. The wizard automatically links all necessary structural components of the tags to the correct property of the prototype picture module by replacing each prototype tag link on each</td>
</tr>
<tr>
<td>Step</td>
<td>Type</td>
<td>Configuration</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>property with the actual tag link. You now have an object which is updated with the current tag values during runtime.</td>
</tr>
</tbody>
</table>

When the dynamic user objects and prototypes are used, the person configuring the system must make sure that the necessary actions have already been stored on the objects. They must not be deleted, since otherwise the entire functionality of the module is lost.

### 3.3.11.5 Prototype pictures

The technology of the prototype pictures goes one step further. When prototypes are used, the concept can be structured so flexibly that a change made to the prototype is automatically followed by an adjustment to the objects created. This flexibility requires the linking of very flexible C scripts.

The technology of the prototype pictures operates using template pictures which can be repeatedly integrated into one or more parent pictures. A template picture is only a template, which is brought to life only once integrated into a real object. An object based on a template (= prototype picture) is brought into being by what is known as an instanciation*. A number of instances (i.e. real objects) can be created for one template.

**Template picture window**

Display the picture window used with current data from the data manager.

Subsequent changes are made at a central point (in the template) and affect all applications (instances). This makes this a very efficient program which does away with the laborious task of dragging changes to many different places.

In a parent picture, up to 30 instances (i.e. objects) of a particular template type can be displayed. If different prototypes are used, it is possible to use more than 30 objects.

The prototype pictures are picture modules which are copied to the library after being created, so they can be reused. The picture modules used are used in the plant pictures as instances of the template. These copies show the current data, e.g. of controllers or motors,
which is visualized in the module. The corresponding controller or motor components are displayed automatically.

Not only simple picture modules, but complex ones too can be created. A picture module can consist of several components that overlap each other either partially or fully, but that make up a single common unit. For example, all the data that relates to a motor, such as a view of the current status, progress data, maintenance data, etc., can be combined in one object and updated as and when required. If you have a number of motors of the same type, all you have to do is create the picture module once and then make copies of it. Everything else is automatic.

The following steps must be followed to create the picture module:

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data structures</td>
<td>Define the data structures to be used in the picture module by means of the tag management.</td>
</tr>
<tr>
<td>2</td>
<td>Picture window buildup</td>
<td>Using the Graphics Designer, configure the contents of the picture module, e.g. bars, I/O fields etc.</td>
</tr>
<tr>
<td>3</td>
<td>Linking data structure with picture window buildup</td>
<td>Link the picture components with the individual data structure components with special C scripts (from the sample project).</td>
</tr>
<tr>
<td>4</td>
<td>Picture window</td>
<td>Link the picture module to the picture window object.</td>
</tr>
<tr>
<td>5</td>
<td>Graphics library</td>
<td>Copy the picture window to the graphics library.</td>
</tr>
</tbody>
</table>

The picture module can now be used in the plant pictures by being retrieved from the graphics library.

Let's first take a look at how the template picture is created.

<table>
<thead>
<tr>
<th>Step</th>
<th>empty</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Creating a tag structure (data type, structure type) in the data manager; this is where the number of tags that go to make up the structure is defined (member tags), what the tags are called and of which data type each of the tags is (BIT, SHORT, etc.). For example, PID with set value, actual value and temperature as structural components.</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Creating a picture which is to be used as a picture module. This is usually smaller than the size of the monitor screen and can be dimensioned accordingly. Each picture that has been created in its own right can be used to create a template. The picture is created using the graphics editing functions, and graphics tags such as I/O fields, bars etc. are positioned in it but not linked to tags. Internal relationships (direct links) between graphic objects, such as change-controlled transfer of the output value of an I/O field to a bar, are configured in this picture.</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>The graphic fields are now linked to the structural components of the corresponding tag structure. This link configuration links the tags at type level (template only), but not yet with concrete process objects. For this purpose, you will find a pre-prepared sample project on...</td>
</tr>
</tbody>
</table>
In the project library (\Template) of this project is a user object called \TemplateInit, which performs this interconnection. This is located in the graphics library and can be dragged and dropped from here into a picture that is to be standardized. \TemplateInit already has a complete script logic. This logic uses what is known as a ConnectionTable, which during configuration is filled in as a table and contains precisely the underscored entries quoted above. This is method used to define the link between the properties and the structural components.

The buildup of these links can be set within a template or also from outside. To this end, the special project graphics library contains user objects which to the naked eye look like simple buttons, but which in fact contain parameterizable information about the template to be called up.

All of the scripts for implementing this already prepared generation of the prototype must be copied to the destination project. See the final steps described at the end of the chapter under steps 8 - 10. Without these project functions, these prototypes cannot be implemented.

4 This picture is to be used as a process box.

To do this, create a picture window object in a temporary picture (i.e. it is only required for this intermediate step) and link the Picture Name property of this object to the picture that contains the picture module.

5 Copy this picture window object to the graphics library by dragging and dropping it.

This template can now be used repeatedly in the plant pictures. The link to the process tags is made automatically when the name is entered.

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Defining the tags</td>
<td>Define a (process) tag for the corresponding data type (e.g. PID_1 of type PID).</td>
<td></td>
</tr>
</tbody>
</table>
| 7    | Creating an instance| Copy the picture window module from the graphics library. Immediately assign the picture window object name to the name of the (process) tag that is to be used (e.g. PID_1): set Picture window object \rightarrow Picture window \rightarrow Object name \rightarrow Static [D to PID_1]

When the picture module is positioned in the picture, it is given the name of a structured (process) tag whose values contain the status data of a process object. During runtime, then, the picture module retrieves the status data automatically.

A number of C scripts are used for these prototype pictures, which are or have been stored as project functions. To be able to use the C scripts that have already been prepared, you have to adopt the following scripts from the sample project. Proceed as follows:
<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Copying the function files</td>
<td>From the path <code>&lt;Projectpath&gt;\Library</code>, copy all the required functions (.fct), e.g. LinkConnectionTable.fct, from the sample project to your project folder <code>&lt;Projectpath&gt;\Library</code>.</td>
</tr>
<tr>
<td>9</td>
<td>Making known in the project</td>
<td>In WinCC, call the Global Script editor (<code>Global Script → Copy → Open</code>) to make these new functions known in the following: you can now make the new functions known to the function tree of the project functions by clicking the Regenerate Header button. The new functions can now be seen in the list of project functions.</td>
</tr>
</tbody>
</table>
| 10   | Taking over user objects | The user objects are made available by means of the project library. In a new project in which you have so far not stored any of your own symbols in the library, you can simply copy the library from the sample project to your project:

```
copy <Projectpath>\Library\library.pxl → to your path <Projectpath>\Library
```

Otherwise, use the export mechanism to transfer the user objects from one project to the other.

Export the desired symbols in the sample project as .emf files (`File → Export...`) and import these .emf symbols in your own project into a temporary picture by means of `Insert → Import...`. Transfer the symbols to your project library by dragging and dropping them. Use a separate folder also to do this, e.g. Template. |

Picture modules (standardized picture segments or templates) offer a very large savings effect. They are modeled as objects with tag references and are, for example, stored in the graphics library. They are taken from this graphics library, positioned in the plant picture and automatically supplied with data during runtime. There is no longer any need to configure links for individual tags with graphic segments such as I/O fields, bars etc.

When using these prototype pictures, there are different ways in which the picture module components are supplied with the current names. This is done by means of the following variants, which we will briefly name here:

- **The instance name determines itself** when the picture window is opened:
  to this end, a specified project function (EnableTemplateInstance) is stored under the Open Picture event in the picture window itself.

- **input/output tag**, which is automatically read in the picture window by means of a script; this is how the instance name is determined:
  this is done by using the pre-prepared user object, `InstanceCallButton + Template`.

- **A button** transfers the instance name directly to the open picture window:
  this is done by using the pre-prepared user object, `InstanceCallButtons + Template`.

You can find detailed examples of these variants in the sample project on the WinCC CD (`\Samples`).

3.3.11.6 OCX objects

OCX or ActiveX objects are picture modules which are available as loadable components. WinCC offers a number of them, e.g. the WinCC Digital/Analog Clock Control.

These modules can be very easily incorporated into the plant pictures.

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Inserting an OCX object</td>
<td>In the Object Palette of the Graphics Designer under Smart objects, select the type OLE Control (OCX). Drag the object into the plant picture by holding down the [\sqrt{1}] and in the dialog box that then pops up, select the element you want.</td>
</tr>
<tr>
<td>2</td>
<td>Linking properties</td>
<td>The object inserted likewise has properties and events. Which properties and event are available depend on the specific OCX itself. A link to a tag can be created, e.g. using the property Process driver connection.</td>
</tr>
</tbody>
</table>

Creation

The OCX picture modules must be created using a separate development environment. You can use, for example, Microsoft Visual C++ 5 or Microsoft Visual Basic 5. This method is used to modify and improve the picture modules. The OCX modules are very powerful, but they cannot be created with WinCC configuration resources. In this case, you will always have to resort to an external method of creating or modifying. In contrast with change-friendly and powerful OCX programming, the technology of the prototype pictures can get by with pure WinCC resources. This means that you do not need to have any knowledge of OCX programming.

There are already a large number of such modules available today. Among other things, complete modules are available as PCS7 faceplates in connection with the integration of the two worlds of Operation & Observation (Bedienen & Beobachten) and PLC programming (PCS7) in the plant sector.

Registration

The OCX modules created or bought in must be registered on the respective WinCC station. You can see which OCX objects are available on the WinCC station by looking in the selection dialog of the Graphics Designer (see description above). All the OCX elements registered on the computer are listed in the dialog box. An OCX element is stored on the computer in the form of a file with the extension .OCX or .dll. If a module has not yet been registered, you can do so in the WinCC OLE Control dialog box. The dialog box contains a Register... button (obviously for registering the module) and an Unregister button for removing the registration of the components currently selected. The relevant file must be on the WinCC station for registration to be carried out.

The compatibility and mode of functioning of the OCX components must be tested by the person configuring the system. Only those OCX modules marked using WinCC have been used and tested in the WinCC environment.
3.3.12 Online configuration (runtime) - notes and restrictions

A number of points must be noted with respect to online configuration. For various reasons, a small number of changes are not able to be made while online or can only be made under certain conditions, or the changes only become effective at a later point in time.

Control Center

The following changes are not adopted:
- changing the type of a computer in the computer list

During runtime, the following configuration steps are not possible:
- deleting/renaming tags
- changing the data type of a tag

Alarm Logging

The following changes are not adopted:
- changing the archives/reports
- changing the group messages
- every message after a total of 500 single messages during runtime

During runtime, the following configuration steps are not possible:
- no restrictions

Tag Logging

The following changes are not adopted:
- no restrictions

During runtime, the following configuration steps are not possible:
- tables of the user archives can be created but not changed
- deleting data in Tag Logging and user archives

Exceptions for configuration during runtime:
- the runtime API of Tag Logging can be used to edit and delete the tables of the user archives
Global Script

The following changes are not adopted:

- changes made to a wizard script are only adopted after restarting the Graphics Designer.
- modified wizard scripts

During runtime, the following configuration steps are not possible:

- no restrictions

Report Designer

The following changes are not adopted:

- changes to the message sequence report, since once started, it always remains active in runtime and doesn’t reload the layout information

During runtime, the following configuration steps are not possible:

- no restrictions

Redundancy

The following changes are not adopted:

- the computer name of the partner cannot be transferred to a third computer
- the AutoSwitcher cannot be changed, i.e. you must configure at the outset to where the AutoSwitcher is to be switched. It does, however, also switch back if the other one fails.

During runtime, the following configuration steps are not possible:

- no restrictions

SIMATIC S7 Report Suite or S7PMC channel

The following changes are not adopted:

- no diagnostics parameters relating to the S7Chn.ini (not published) are adopted online.
- all changes to communication addresses are indeed adopted online, but are only evaluated when a connection is set up.

During runtime, the following configuration steps are not possible:

- no restrictions
Text Library

The following changes are not adopted:

- no restrictions
- \textit{File} \rightarrow \textit{Send Changes to Active Project.}
- In Alarm Logging, the changes are copied to the text library by means of \textit{File} \rightarrow \textit{Save}.

During runtime, the following configuration steps are not possible:

- no restrictions

User Administrator

The following changes are not adopted:

- changes to user authorization only become effective after logging off and on again.

During runtime, the following configuration steps are not possible:

- no restrictions
4 WinCC - C Course

Experience has shown us that the script language of WinCC poses a problem that newcomers to C initially find extremely difficult to solve. For many applications, it is perfectly adequate if you provide the available functions with the appropriate parameters and use just these functions.

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>It is not absolutely necessary for you to create your own functions or actions when dynamizing objects, since the software already offers a <strong>dynamic dialog</strong>. This dialog creates executable and expandable <strong>C actions</strong>. <strong>Dynamic dialogs</strong> run in a special memory area of the operating system and are therefore considerably quicker than <strong>C actions</strong>. The functionality of the <strong>dynamic dialogs</strong> is limited, however. A <strong>dynamic dialog</strong> can be converted to a <strong>C action</strong> at a later stage, but this does lead to a loss of performance. The quickest method of dynamization is, however, the <strong>direct link</strong>. But this method also suffers from certain restrictions (e.g. only for objects in the picture) compared with <strong>C actions</strong>.</td>
</tr>
</tbody>
</table>

**C actions** in the Graphics Designer and Global Script editors offer users with very demanding tasks an extremely powerful script language. If, in your initial euphoria when developing, your scripts turn out to be somewhat larger and more complex, you can integrate them into WinCC as executable **dll (Dynamic Link Library)** functions and improve performance considerably in this way.

**Target group**

This "C course" is intended to illustrate the most important points of the programming language C to newcomers. It should also provide all those who already program in C with a better insight into the special features of this development environment.

The examples used for this course have been configured in the WinCC project with the name **Cours_00**.
We have configured a picture with a number of examples for each topic covered in this course. You open the individual pictures by clicking the corresponding button in the toolbar with the √.

The Diagnostics button is used to turn the WinCC diagnostics window on/off. In the C actions, all outputs are output to this configured diagnostics window by means of printf. If in the individual examples the relevant button is clicking with the √R, the source code of the example in question is displayed.
4.1 The development environment for scripts in WinCC

C actions in WinCC's Graphics Designer and Global Script editors offer you an extremely powerful script language. The syntax of the script language corresponds to Standard C (per ANSI standard) and is processed interpretatively. This means that the instructions formulated in the script language are only checked for syntax and not immediately executed on being compiled.

Global Script is the generic term for C functions (standard and project functions) and global actions which can, depending on their type, be used for the entire project or even for all projects.
4.1.1 Functions and actions in WinCC

*C actions* (functions and actions) are executed during runtime and serve to both visualize and control the process. Functions and actions can be used to change object properties and they enable you to react to events.

The structure of a function

*Functions* consist of two different areas:

- **Header of the function**
  - **Type of the return value**
  - **Function name**
  - *(Type of Parameter1 Parameter1name1, ....)*

- **Body of the function**
  - `{ Declare tags;
    Commands;
    return;
    } // End of function

The function header

The header describes the environment of the function (interface to the outside world). Here is an example of a *function header*:

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName, UINT nFlags, int x, int y)
{
//Function body
}
```

The header of the *function* describes the name (How is the function called (i.e. invoked)?) and transfer parameters (which data is transferred to the *function* and which *return value* is supplied by the function).

The *function header* is automatically displayed when the *C action* is called and doesn’t have to be written by the person configuring the system. The *function header* shows the person configuring the system which *return value* has to be returned and which data is already available in the function.

Different function headers are displayed depending on the type of dynamization of a property or event.

Function header of an event

```c
#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
//Function body

```

The *return value* with these actions is always of the type *void* (i.e. nothing). The command *return;* can be left out of the *C actions*, since it is executed automatically at the end of every *C action*. 


Function header of a property

```c
#include "apdefap.h"
long _main(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName) {
  //Function body with return value
}
```

In the case of the C actions for object properties, the new setting of the property to be made dynamic is delivered by means of the current return value of the C action. The type of the return value, e.g. a number (in our example, long) or a character string (e.g. char *), is defined in the header of the C action.

The function body

The body describes the content of the function (What does the function do?).

```c
/* Declaration of the tags */
int number1;

/* Value assignments to the tags */
number1=123;

/* Output of the tag values in the diagnostics window */
printf("The first number is %d\n",number1);
```

The individual commands are called in the function body. The function body begins with a left curly bracket and ends with a right curly bracket.

The function body defines additional data which are required during processing of the function (local data). This data is automatically deleted at the end of the function. Each individual command in the function body is concluded by a semicolon.

Return value

The return value of the function (e.g. the new color or new PositionX) is returned at the end of the function in the function body.

Formulation of the C sequences is based on existing functions. These functions can be displayed and used by means of the function tree. These project-wide and cross-project functions are formulated in the GlobalScript editor, with a distinction being made between the following types of function:

Standard functions

WinCC enables you both to create new standard functions and to modify existing ones. Standard functions are known, i.e. available, to all projects and are divided into categories. You edit them in the Control Center using the Global Script editor.

The standard functions are used for dynamizing graphic objects and archives. Standard functions can be called in project functions, in other standard functions and in actions.
Project functions

WinCC enables you both to create new project functions and to modify existing ones. The project functions are only known, i.e. available, in the project in which they have been created. This is the only difference to the standard functions.

You edit them in the Control Center using the Global Script editor.

Actions which are used more than once should be defined as project functions or standard functions.

Project functions can and should be categorized in the same way as the standard and internal functions.

The advantages of project functions are:

- their reusability. Once the C action has been configured and extensively tested, it can be used again and again at any time without requiring any additional configuration and renewed extensive testing.

- Simple modification. If a modification is made to the C action, this modification is only effective at one location – in the project function. You don't have to search for and adapt the configured dynamics in all pictures. This simplifies not only configuration, but also maintenance and troubleshooting work.

- a reduction in the data e of pictures and consequently quicker times for opening pictures. If project- and standard-function calls are used in the picture actions, the overall volume of the data in the pictures is reduced.

- Project functions can be protected against unauthorized modifications by the use of a password (user authorization) (protection of configuration data and configuration know-how).

Internal functions

Internal functions cannot be created or modified and are known, i.e. available, to all projects.

Internal functions to dynamize graphic objects, archives, project functions, standard functions, and actions.

Internal functions are divided into categories.
Actions

Actions (global and on the object) can be created and modified. These actions are only known, i.e. available, to the project in which they have been created.

You use project, standard and internal functions:

- in actions on the object
- in actions which are created in the Dynamic Dialog
- for making alarms, process-value, compressed and user archives.

Note:

Actions are processed interpretatively. You must therefore count on the load on the system being higher whenever you use a large number of or wide-ranging actions. For this reason, it is better if you replace wide-ranging actions with their own DLLs (Dynamic Link Libraries).

You use actions during runtime for the purpose of process control. The execution of actions is triggered by (believe it or not!) a trigger. To this end, you have to activate the project.

You create a global action using the Global Script editor. Start this editor from the Control Center.
4.1.2 The editors for functions and actions

Functions and global actions are edited using the *Global Script* editor.
A distinction is made between project and standard functions. These functions are used in pictures in an object-oriented manner as a *Action* on the object, or in the message system (Alarm Logging).
In contrast, the global actions are not object-oriented and are only edited in certain events (triggering by time or tag).

The differences between these two editors are to be found in the way they are called and in the scope of their functions.

The editor for actions on the object

For dynamizing the objects, the editor is used in the *Graphics Designer*. This editor can only be used for editing the *function body*. The *function header* is generated automatically when the editor is called.
In the picture below, the parameters of the function inserted are assigned in the corresponding dialog box.

Example of editing an action on the object:

![Image of function editor]

The Global Script editor

The editor is called from the *Control Center*. It can be used to edit *functions* and *actions*. *Actions* on the object, however, cannot be edited with this editor. When *actions* are being edited, the *function header* is protected; that is, it cannot be changed. In the case of *functions*, both the *function header* and the *function body* can be edited.
Example of editing a standard function using the Global Script editor.

The control functions listed below apply for both editors.

**Key actions in the editor**

<table>
<thead>
<tr>
<th>Function</th>
<th>Key action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New line</td>
<td>RETURN (ENTER)</td>
</tr>
<tr>
<td>Delete character to right</td>
<td>DEL</td>
</tr>
<tr>
<td>Delete character to left</td>
<td>Backspace</td>
</tr>
<tr>
<td>Move to beginning of line</td>
<td>HOME</td>
</tr>
<tr>
<td>Move to end of line</td>
<td>END</td>
</tr>
<tr>
<td>Move to beginning of text</td>
<td>CTRL+HOME</td>
</tr>
<tr>
<td>Move to end of text</td>
<td>CTRL+END</td>
</tr>
<tr>
<td>Moving the insertion point</td>
<td>with the cursor keys</td>
</tr>
<tr>
<td>Cut selected text</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Copy selected text</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Insert (paste) text from clipboard</td>
<td>CTRL+V</td>
</tr>
</tbody>
</table>
Mouse actions in the editor

<table>
<thead>
<tr>
<th>Function</th>
<th>Mouse action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select text</td>
<td>with left mouse button</td>
</tr>
<tr>
<td>Select one word</td>
<td>double-click with left mouse button</td>
</tr>
<tr>
<td>Reposition insertion point</td>
<td>with left mouse button</td>
</tr>
</tbody>
</table>

Other editing functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert mode</td>
<td>Mode in which text is inserted.</td>
</tr>
<tr>
<td>Selected text</td>
<td>Selected text is replaced by the next character entered using the keyboard.</td>
</tr>
<tr>
<td>Select an area of text</td>
<td>Position the insertion point at the beginning of the area to be selected, hold down the Shift key and position the insertion point to the end of the area to be selected.</td>
</tr>
<tr>
<td>Extend a selection</td>
<td>Hold down the Shift key and position the insertion point to the end of the area to be selected.</td>
</tr>
</tbody>
</table>
4.1.3 Creating functions and actions

Creating a new function

The following steps must be followed to create a standard or project function:

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: creating a standard or project function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Formulate the function.</td>
</tr>
<tr>
<td>2</td>
<td>Add to the function information.</td>
</tr>
<tr>
<td>3</td>
<td>Compile the function.</td>
</tr>
<tr>
<td>4</td>
<td>Save the function and, if necessary, rename it.</td>
</tr>
<tr>
<td>5</td>
<td>If necessary, generate the header files</td>
</tr>
</tbody>
</table>

Through following these 5 steps, you have created your standard or project function.

The header file named `apdefap.h` integrates the header file named `ap_glob.h` which comprises the declaration of the standard functions. `apdefap.h` and `ap_glob.h` are located in the `<WinCC Installation Folder>\APLIB folder. If you create a new standard function and use other standard functions there, you must integrate either the `apdefap.h` or the `ap_glob.h` header file.

New standard functions are added to the existing standard functions in the `<WinCC Installation Folder>\APLIB on the server.

In contrast, the project functions defined in the project are stored on the server under `<ProjectName>\Library (the project path). The function headers (known as the function prototypes) of the new project functions are stored in the declaration file (for C functions), `Ap_pшиб.h`, in the `<ProjectName>\Library folder.

Creating a new action

The following steps must be followed to create a global action:

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: creating an action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Formulate the action.</td>
</tr>
<tr>
<td>2</td>
<td>Add to the action information.</td>
</tr>
<tr>
<td>3</td>
<td>Specify the trigger(s) as the triggering event.</td>
</tr>
<tr>
<td>4</td>
<td>Compile the action.</td>
</tr>
<tr>
<td>5</td>
<td>Assign operator authorization (permission).</td>
</tr>
<tr>
<td>6</td>
<td>Save the action and, if necessary, rename it.</td>
</tr>
</tbody>
</table>

Through following these 6 steps, you have created a global action.
The *Global Script* editor allows you to link the action to operator authorization: *Edit → Operator Permission*.

When you create a new action, the header file named `apdef.h` from the project folder `...\<Projectname>\LIBRARY` is integrated automatically.

If there is no *project function* contained in the action, the header file from the `...\APLIB` folder is integrated. This is how the *standard function* and the *project function* come to exist in the actions.

In multi-user systems, a distinction is made between global and local actions.

Global actions are stored in the project folder in such a way that they are not linked with the particular computer (`...\<Projectname>\PAS`). They are active on all computers.

Local actions are stored in the project folder in such a way that they are linked with the computer (`...\<Projectname>\<Computername>\PAS`). This means that local actions are active only the respective computer.

If the *Global Scripts* runtime module is added to the startup list, all global actions that belong to the project are activated. This activation takes place on startup in runtime mode.
4.1.4 Testing functions and actions

Error messages

You can read up on the syntax messages (errors or warnings) listed in the error window in any book on C or manual on the C compiler (e.g. Microsoft Visual C). These are standard error messages output by every C compiler when the syntax check is run. Errors always lead to the action not being able to be executed, while warnings are merely messages which draw your attention to possibility of errors occurring on execution.

Note:
You should always take note of the warnings displayed in the error window. A correction will have to be made before the action can be executed free of errors. Warnings cover such errors as incorrect number formats in function calls. Apart from that, eliminating warnings is part and parcel of good programming!

Eliminating syntax errors

The error line displayed in the error window of the C action editor describes the syntax error in detail and specifies the code line. If you \texttt{D} the error line, you automatically position the insertion point to the relevant position in the code. This allows you to analyze and correct the error right at the point where it has been made.

Test outputs of the C action

You can test the execution of a \texttt{C action} with the aid of output instructions, which you must write yourself using the output function of C (\texttt{printf}). These output instructions are output in the diagnostics window when the action is executed. The diagnostics window is configured in the picture using the Graphics Designer (\texttt{Smart Objects \rightarrow Application Window \rightarrow Global Script \rightarrow GSC_Diagnose}).
### 4.1.5 Importing/exporting functions and actions

Global actions can be exported and imported.
An imported action replaces the action in the active window totally.

*C actions* that have already been formulated can be used again in a number of different ways.

**Storing the C action in the clipboard**

If you are going to use the formulated *C action* again immediately in the next action screen (of another property or event), you can export and import the current *C action* or segments of this *C action* by means of the clipboard. You can do this using either the Copy and Paste buttons in the toolbar or the shortcut key combinations CTRL C and CTRL V.

**Exporting C actions**

A completely written *C action* can be saved to a file, e.g. *Picturename.act*, at any time - even for copying purposes (copying actions to other properties or events). You do this by selecting the Export Action button in the *Global Script* editor and assigning a file name. In this way, you can at any time store basic actions that are used again and again in the picture path of the project (*<Projectname>*/GraCS).

**Importing C actions**

An existing *C action* which is made available in the picture path of the project, e.g. (*<Projectname>*/GraCS), can be inserted into the action screen and modified at any time. Select the property you want to dynamize and call the editor for *C actions*. Click the Import Action button and select the file name under which the desired action is stored, e.g. *Picturename.act*. In this way, you are able to make use of basiC actions at any time and subsequently adapt them to the dynamics.

**Storing a configured and linked object as a library object**

Objects that have already been preconfigured with (more complex) *C actions* can be stored in the *project library* as a complete graphic object with dynamics, so that it can be used again.
All you have to do is copy the object to the selected *project library* by means of *drag&drop* (selection and copying using the mouse). What’s more, the configured actions for the properties or events are also taken over. An example of objects with *C actions* that have already been stored can be found in the Use Objects folder.
4.2 Tags in C

In our project, you can find the examples that relate to the topic of tags by clicking the Tags button. By clicking the R, you can display the source code of the example in question.

Screen for tags

![Screen for tags](image)

After you have clicked the Tag button with the R, you will see the screen depicted above. The buttons in this screen execute the examples described. By clicking the R, you can display the source code of the example in question.

Before we begin with the examples, let's take a quick theoretical look at the topic of tags.

Tag consist of a tag name, a tag type, and the contents. Tags can be likened to a container. The tag name we give to the container must be unique, since we want to be able to relocate and reuse the container and its contents at some later point in time.

Don't confuse these C tags with WinCC tags. The tags described here are only available within the C scripts.
Tag types in C

C recognizes the following basic types of tag, which correspond to the following value ranges:

<table>
<thead>
<tr>
<th>Type</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>int</td>
<td>Integers (numbers with no places after the decimal point), e.g. 2 / -3 / 5 / etc.</td>
</tr>
<tr>
<td>char</td>
<td>A character, e.g. a / k / z , but also the RETURN key</td>
</tr>
<tr>
<td>float</td>
<td>Floating-point numbers (numbers with places after the decimal point), e.g. 3.23 / 4.32 / 3.01</td>
</tr>
<tr>
<td>double</td>
<td>Floating-point numbers with a range of values twice as large as the float type</td>
</tr>
</tbody>
</table>

The tag type double only differs from the tag type float with respect to its range of values. In type double, the numbers can be displayed with greater accuracy (higher resolution).

The tag type int can be preceded by one of the keywords signed or unsigned. If signed is positioned before int, the program is able to distinguish between signs; if the prefix is unsigned, only positive values (+) may be used. The int type can also be preceded by the prefix long or short.

If nothing else is explicitly specified, all int tags are of the type signed int.

Here are the value ranges of the tag types:

<table>
<thead>
<tr>
<th>Type</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>int</td>
<td>- 2 147 483 648 through 2 147 483 647</td>
</tr>
<tr>
<td>unsigned int in WinCC also (DWORD)</td>
<td>0 through 4 294 967 295</td>
</tr>
<tr>
<td>short int in WinCC also (SHORT)</td>
<td>-32768 through 32767</td>
</tr>
<tr>
<td>long int</td>
<td>-2 147 483 648 through 2 147 483 647</td>
</tr>
<tr>
<td>unsigned short int</td>
<td>0 through 65 535</td>
</tr>
<tr>
<td>unsigned long int</td>
<td>0 through 4 294 967 295</td>
</tr>
<tr>
<td>char</td>
<td>All ASCII characters</td>
</tr>
<tr>
<td>unsigned char</td>
<td>All ASCII characters</td>
</tr>
<tr>
<td>float</td>
<td>-10^38 through 10^38</td>
</tr>
<tr>
<td>double</td>
<td>-10^308 through 10^308</td>
</tr>
</tbody>
</table>

In the olden days, there were two types of ASCII characters (displayable characters) to code. The first range of values from -128 through 127, the second range of values from 0 through 255.

To completely avoid this problem of having different types of ASCII value, the unsigned char type was introduced. This type only recognized values from 0 through 255. Generally speaking, only unsigned char values are used today.
Parameters for printf

In our example, we output the results in the diagnostics window of the Global Script editor by means of printf. Here is some information about printf.
Structure and example of printf:

```
printf("Content of tag: \%d\r\n",tag);
```

The % is a special character, just as the \ is. The % tells the program that the value of a tag is supposed to stand at that point. %d displays an integer tag.
Lists of tags are separated by commas.

Here are just some of the parameters for printf:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>%d</td>
<td>int, short int or char (as a decimal number)</td>
</tr>
<tr>
<td>%ld</td>
<td>Display long int as a number</td>
</tr>
<tr>
<td>%c</td>
<td>Like %d, with char as a character</td>
</tr>
<tr>
<td>%x</td>
<td>Like %d, with char as a hexadecimal character with small a...f</td>
</tr>
<tr>
<td>%X</td>
<td>Like %x, only with large hexadecimal characters A...F</td>
</tr>
<tr>
<td>%o</td>
<td>Like %d, with char as an octal character</td>
</tr>
<tr>
<td>%u</td>
<td>Like %d, not only unsigned values</td>
</tr>
<tr>
<td>%f</td>
<td>Floating numbers written as floating-point numbers, e.g. 3.43234</td>
</tr>
<tr>
<td>%e</td>
<td>Floating numbers written as exponential numbers, e.g. 23e+432</td>
</tr>
<tr>
<td>%E</td>
<td>Like %e, but with a large E, e.g. 23E+432</td>
</tr>
<tr>
<td>%g</td>
<td>Floating numbers written as exponential or floating-point numbers</td>
</tr>
<tr>
<td>%s</td>
<td>char* or char[]</td>
</tr>
<tr>
<td>%le</td>
<td>Display double number</td>
</tr>
<tr>
<td>%%</td>
<td>Is not an instruction, but outputs a %</td>
</tr>
<tr>
<td>\n</td>
<td>Is not an instruction, but outputs a carriage return</td>
</tr>
<tr>
<td>\r</td>
<td>Is not an instruction, but outputs a line feed</td>
</tr>
<tr>
<td>\t</td>
<td>Is not an instruction, but outputs a Tab</td>
</tr>
</tbody>
</table>
4.2.1 Example 1 - Using tag types

In our first example, we will show you how to use the different tag types in a C action. The action is configured to the button example_01 → Events → Mouse → Press left. Click the button called Example 1 with the and the next script will be edited.

C action

```c
#include "apdefap.h"

void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
                       char* lpszPropertyName, UINT nFlags, int x, int y)
{
    int number1;
    float number2 = 23.415; // set value in declaration
    char character;

    // set tag values
    number1 = 123;
    character = 'e';

    // output in diagnostics window
    printf("example 1\n");
    printf("number1 : %d\n", number1);
    printf("number2 : %.3f\n", number2);
    printf("character : %c\n", character);

    // set internal tag
    SetTagDWord("S32i_course_tag_03", number1);
}
```

Output in the diagnostics window

![Example 1 output](image)
Explanation of the individual program components

- The first section is the function header. It cannot be changed.
- In the Declaration section, the tags (number1, number2, and character) are created. This is done by means of the notational form tag type tag name, and each line is concluded by ;.
- In tag number2, the value is assigned together with the declaration. This is done by means of the notational form tag type tag name – value that is to be assigned.
- The remaining tags have the values assigned to them. We now have the tags with a specific variable (int, float, and char).
- The tags now have the values (123, 23.415, and e). The numbers to the left and right of the decimal point are separated by a point.
- The values are then output in the diagnostics window by means of the printf function.
4.2.2 Example 2 - C tags in connection with WinCC tags

In our second example, we will show you how to use C tags in connection with WinCC tags, in this case, *internal tags*. The *external tags* (process tags from the tag management) are read and modified in the same way.

This example shows how a tag (internal or external) is set to a defined value (*SetTag*) and how the current value (*GetTag*) of a tag is read.

The action is configured to the button `example_02 → Events → Mouse → Press left`. Click the button called *Example 2* with the `✓` and the next script will be edited.

**C action**

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
                   char* lpszPropertyName, UINT nFlags, int x, int y)
{
    //tag declaration
    int number1;
    int   number2;
    float number3;

    //set internal tags
    SetTagDWord("S32i_course_tag_00",123);
    SetTagFloat("F32i_course_tag_01",23.415);

    //read internal tag values
    number1=GetTagDWord("S32i_course_tag_00");
    number2=GetTagDWord("S32i_course_tag_04");
    number3=GetTagFloat("F32i_course_tag_01");

    //output in diagnostics window
    printf("\r\n\nextample 2\r\n");
    printf("S32i_course_tag_00 : %d\r\n",number1);
    printf("S32i_course_tag_04 : %d\r\n",number2);
    printf("F32i_course_tag_01 : %.3f\r\n",number3);
}
```

Output in the diagnostics window
Explanation of the individual program components

- The first section is the function header. It cannot be changed.
- Declaration of the C tags.
- In the Set internal tags section, the internal WinCC tags (S32_i_course_tag_00 and F32_i_course_tag_01) are supplied with values (123 and 23,415) by means of the WinCC functions, SetTagDWORD and GetTagFloat, provided for this purpose.

In the next section, we use the appropriate WinCC function (GetTagDWORD, GetTagFloat) to read the value from the internal WinCC tags (S32_i_course_tag_00, S32_i_course_tag_01) and assign these tags to the C tags (number1, number2).

The value of the tag (S32_i_course_tag_04) is read from Input field1 and assigned to the C tag (number2). This value can be changed. Click Input field1 with the $\sqrt{3}$, enter the value and complete your input by pressing Return.

The values are then output in the diagnostics window by means of the printf function.
4.2.3 Example 3 - Using tags

In our third example, we will show you another way to use a tag. We will change the content of a tag by clicking in it with the mouse. This tag is linked with the X position of an object. When the tag is changed, the object is moved.

The action is configured to the button example_03 → Events → Mouse → Press left. Click the button called Example 3 with the mouse and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
                   char* lpszPropertyName, UINT nFlags, int x, int y)
{
    int number;

    number=GetTagDWord("S32i_course_tag_02");

    //set tags
    if (number==448) (number=585);
    else (number=448);

    SetTagDWord("S32i_course_tag_02",number);

    //output in diagnostics window
    printf("\r\nexample 5\r\n";
    printf("actual x-position : %d\r\n",number);
}
```

Output in the diagnostics window

![Diagnostics Window](image)
Explanation of the individual program components

- The first section is the function header. It cannot be changed.
- The declaration of the tag.
- In the set tags section, the value of the tag is changed in the if condition.
- The new value is assigned to the internal WinCC tag (S32i_course_tag_02) using the WinCC function, SetTagDWord, provided for this purpose.
- In the object rectangle_01, this tag is linked to PositionX. The position is updated when this tag, S32i_course_tag_02, is changed.
- The value is then output in the diagnostics window by means of the printf function.
4.3 Operators and mathematical functions in C

In our project, you can find the examples that relate to the topic of operators by clicking the Operators button. By clicking the R, you can display the source code of the example in question.

**Screen for operators**

![Screen for operators](image)

After you have clicked the Operators button with the R, you will see the screen depicted above. The buttons in this screen execute the examples described. By clicking the R, you can display the source code of the example in question.

**Before we begin with the examples, let's take a quick theoretical look at the topic of operators.**

The operators control what is to happen to the tags and constants. You use operators to link tags and constants to one another, and to derive new contents for tags from this.

Operators are divided up into different types. Those described below are the ones that are of most importance to us:

**Arithmetics**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>addition</td>
</tr>
<tr>
<td>-</td>
<td>subtraction</td>
</tr>
<tr>
<td>*</td>
<td>multiplication</td>
</tr>
<tr>
<td>/</td>
<td>division</td>
</tr>
<tr>
<td>++</td>
<td>incrementation</td>
</tr>
<tr>
<td>--</td>
<td>decrementation</td>
</tr>
</tbody>
</table>

The arithmetic operators are, e.g. in the Dynamic Dialog, required to set up a dependency between several tags (e.g. Motor Status1 and Motor Status2). The arithmetic operators are also used to formulate formulae within C actions.
Logic, comparison

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>greater than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>greater than or equal to</td>
</tr>
<tr>
<td>==</td>
<td>equal to</td>
</tr>
<tr>
<td>!=</td>
<td>not equal to</td>
</tr>
<tr>
<td>&lt;=</td>
<td>less than or equal to</td>
</tr>
<tr>
<td>&lt;</td>
<td>less than</td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td>logic AND operation</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>logic reversal</td>
</tr>
</tbody>
</table>

The arithmetic and logic operators are, e.g. in the Dynamic Dialog, required to set up a dependency between several tags (e.g. Motor Status and !Error). You will find the logic operators again in the Abfragen of C actions.

Bit manipulation

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;</td>
<td>AND operation of bits</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>^</td>
<td>Exclusive OR (EXOR) operation of bits</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>Shifting of bit to the left</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>Shifting of bit to the right</td>
</tr>
</tbody>
</table>

The bit-by-bit operators are, e.g. in C actions, used to query bits or to set individual bits in a data word (e.g. set Motor Status bit to work in Position 1, Motor Status | 0x0002).
4.3.1 Boolean algebra

Logic functions

In mathematics, systems of logic tags that are linked by logic functions are known as **Boolean algebra**. When *C actions* are being created, logic tags are in many applications linked to new tags by means of logic functions.

A logic function can be viewed in a **function table**. A function table can also be termed a **Truth table**. If you want to view logic elements, make use of the special symbols, that are standardized. These symbols are also known as **gates**.

4.3.1.1 Basic logic functions

Described below are the most important of the basic logic functions. Logic elements are in many places referred to by their English names.

**NOT gate**

The **NOT gate** (or NOT element) negates the input signal. This negation is depicted by means of the circle at the exit of the box.

<table>
<thead>
<tr>
<th>a</th>
<th>Not</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

**logic AND operation**

The **AND operation** is only 1 if both tags have the value 1.

<table>
<thead>
<tr>
<th>a</th>
<th>b</th>
<th>And</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

**OR operation**

The **OR function** is 1 if the value of at least one tag is 1.

<table>
<thead>
<tr>
<th>a</th>
<th>b</th>
<th>Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>
NAND operation

An AND operation followed by a negation is known as a **NAND operation**. This function has the value 0 if both tags have the value 1.

<table>
<thead>
<tr>
<th>a</th>
<th>b</th>
<th>Nand</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

NOR operation

An OR operation followed by a negation is known as a **NOR operation**. This function only has the value 1 if both tags have the value 0.

<table>
<thead>
<tr>
<th>a</th>
<th>b</th>
<th>Nor</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Exclusive OR (EXOR) operation

This function results in the value 1 if one of the two tags (either of them) has the value 1. This function is known as the **EXOR function**.

<table>
<thead>
<tr>
<th>a</th>
<th>b</th>
<th>EXOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>
4.3.2 Example 1 - Using operators of the basic arithmetic operations

In Example 1, we will show you how to use the different operators of the Basic arithmetic operations in a C action.
The action is configured to the button example_01 → Events → Mouse → Press left. Click the button called Example 1 with the ⬇️ and the next script will be edited.

C action

```c
#include "apdefap.h"

void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName, UINT nFlags, int x, int y)
{
    float a,b;
    float result1,result2,result3,result4;

    a=123.6;
    b=23.4;

    result1=a+b;  // add
    result2=a-b;  // subtract
    result3=a/b;  // divide
    result4=a*b;  // multiply

    //output in diagnostics window
    printf("%r\nexample \n\n");
    printf("%.1f + %.1f = %.1f\n",a,b,result1);
    printf("%.1f - %.1f = %.1f\n",a,b,result2);
    printf("%.1f / %.1f = %.1f\n",a,b,result3);
    printf("%.1f * %.1f = %.1f\n",a,b,result4);
}
```

Output in the diagnostics window

![Global Script - Diagnostics](image)
Explanation of the individual program components

- The first section is the *function header*. It cannot be changed.
- Declaration of the C tags.
- The tags have the values assigned to them.
- Execution of the mathematical operations.
- The values are then output in the diagnostics window by means of the *printf* function.
4.3.3 Example 2 - Mathematical functions

In Example 2, we will show you how to use mathematical functions in a \textit{C action}. The action is configured to the button example_02 $\rightarrow$ Events $\rightarrow$ Mouse $\rightarrow$ Press left. Click the button called Example 2 with the $\sqrt{}$ and the next script will be edited.

\textbf{C action}

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName, UINT nFlags, int x, int y)
{
float a;
int b,c,d;
div_t result5;
double result1,result2;
int result3,result4;
a=123.6;
b=-24;
c=68;
d=12;
result1=pow(a,2);
result2=sqrt(a);
result3=abs(b);
result4=rand();
result5=div(c,d);

//output in diagnostics window
printf("%sexample 2 \n");
printf("%.1f raised to the power of 2\t= %.1f\n",a,result1);
printf("square root of %.1f\t= %.1f\n",a,result2);
printf("%d divided by %d\t\t= %d , %d remainder\n",c,d,result5.quot,result5.rem);
printf("absolute value of %d\t= %d\n",b,result3);
printf("a pseudorandom number\t= %d\n",result4);
}
```

Output in the diagnostics window

![Diagnostics window output](image-url)

123.6 raised to the power of 2 = 15277.0
square root of 123.6 = 11.1
68 divided by 12 = 5, 8 remainder
absolute value of -24 = 24
a pseudorandom number = 41
Explanation of the individual program components

- The first section is the *function header*. It cannot be changed.
- Declaration of the C tags.
- The tag has the relevant values assigned to it.
- Execution of the mathematical functions. You can find these functions under → *Internal functions → c_bib → math*
- The values are then output in the diagnostics window by means of the *printf* function.

Mathematical functions can be used whenever they are available for selection. For example, in the *Dynamic Dialog* when formulating the inquiry or in the *C actions*. 

![Edit action](image)
4.3.4 Example 3 - Operators for bit operations

In Example 3, we will show you how to use operators for bit operations in a C action. The action is configured to the button example_03 → Events → Mouse → Press left. Click the button called Example 3 with the \(^{\sqrt{}}\) and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
                   char* lpszPropertyName, UINT nFlags, int x, int y)
{
    int a,b,c;
    int result1,result2,result3,result4,result5;
    a=3; // binary 011
    b=5; // binary 101
    result1=a&b; // AND
    result2=a|b; // inclusive OR
    result3=a^b; // exclusive OR
    result4=a>>1; // shift right
    result5=a<<1; // shift left
    // write result of OR in output_01
    SetTagDWord("S32i_course_op_03", result2);
    // output in diagnostic window
    printf("example 3:\r\n");
    printf("%d & %d = %d\r\n",a,b,result1);
    printf("%d | %d = %d\r\n",a,b,result2);
    printf("%d ^ %d = %d\r\n",a,b,result3);
    printf("%d >> 1 = %d\r\n",a,result4);
    printf("%d << 1 = %d\r\n",a,result5);
}
```

Output in the diagnostics window

[Image of a window showing examples of operators with their results]

<table>
<thead>
<tr>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;</td>
<td>5 = 1</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>^</td>
<td>5 = 6</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>1 = 1</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>1 = 6</td>
</tr>
</tbody>
</table>
Explanation of the individual program components

- The first section is the *function header*. It cannot be changed.
- Declaration of the C tags and assignment of the values.
- Execution of the bit operations.
- Output of the results of the *inclusive OR* operation in *Output Field 1*.
- The values are then output in the diagnostics window by means of the *printf* function.
4.4 Pointers in C

In our project, you can find the examples that relate to the topic of pointers by clicking the *Pointers* button. By clicking the √ R, you can display the source code of the example in question.

**Screen for pointers**

![Screen for pointers](image)

After you have clicked the *Pointers* button with the √, you will see the screen depicted above. The buttons in this screen execute the examples described. By clicking the √ R, you can display the source code of the example in question.

**Before we begin with the examples, let’s take a quick theoretical look at the topic of pointers.**

The pointers are an essential component of the programming languages C and C++. Even in German the pointer is frequently referred to as a *Pointer*.

**The definition and notation of pointers**

A pointer does not contain the value of a tag; it merely points to the address under which the value of the tag is stored.

The *pointer must have the same data type as the tag to which it points!* In principle, a tag is declared by a *prefixed asterisk* acting as a pointer. The tag value to which a pointer points is accessed by means of the * operator. This is also known as the contents operator.

This, however, must not be confused with the multiplier. These are two separate operators! Depending on the context, the compiler decides on whether it is dealing with a pointer operator or a multiplication.
Part of a program to explain pointers

```c
int number1;
int *pointer1;

number1 = 123;
pointer1 = &number1;
```

This example is the best way of explaining what a pointer is:
- We create the tag `number1` and the pointer called `pointer1`.
- Tag `number1` is assigned the value 123.
- The pointer called `pointer1` is assigned the address of tag `number1`.
- This is performed by the `address` operator `&`!
- `pointer1` now contains the address of tag `number1`.

The advantage of this is that the pointers contain only an address and no tags. This makes them extremely flexible and quick.

String as a pointer

If a string (character string) is generated by a pointer, it is saved randomly at any free point in the memory. The pointer points to the first element of the string. This does indeed work, but it is a **poor and dangerous way of going about programming**!

A string of characters is identified in C by the start of the string (start address of the string) and by the end of the string (null character, `\0`):

```text
WINCC
```

During WinCC configuration, you will find pointers, for example, in connection with the function parameters:
- `lpszPictureName` is, for example, a pointer which points to the beginning of the name of the picture (e.g. Start):
  ```text
  START
  ```
- `lpszObjectName` is a pointer which points to the beginning of the object name (e.g. Circle1):
  ```text
  CIRCLE
  ```

The true benefit of pointers only really becomes clear when they are used in fields. These fields are often referred to as arrays.
Groups or strings of tags of one type can be referred to as fields.
4.4.1 Example 1 - Pointers

In Example 1, we will show you how to use pointers in C.
The action is configured to the button example_01 → Events → Mouse → Press left. Click the button called Example 1 with the "√" and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
                    char* lpszPropertyName, UINT nFlags, int x, int y)
{
    // declaration of tags
    int number1;
    float number2;
    char character;

    // declaration of pointers
    int *pointer1;
    float *pointer2;
    char *pointerc;

    // set tag values
    number1=123;
    number2=23.415;
    character='e';

    // set addresses
    pointer1=&number1;
    pointer2=&number2;
    pointerc=&character;

    // set internal tag
    SetTagDWord("S32i_course_point_00",*pointer1);

    // output in diagnostics window
    printf("\nExample 1\n");
    printf("number1 = %d\r\n",GetTagDWord("S32i_course_point_00"));
    printf("number2 = %.3f\r\n",*pointer2);
    printf("character = %c\r\n",*pointerc);
}
```
Output in the diagnostics window

![Global Script - Diagnostics](image)

Example:
- `example 1`
- `number1 : 123`
- `number2 : 23.415`
- `character : e`

Explanations of the individual program components:
- The first section is the *function header*. It cannot be changed.
- Declaration of the C tags.
- Declaration of the pointers.
- Assign values to the tags.
- In this section, the *pointers* are assigned the *addresses* of the corresponding tags.
- The values are then output in the diagnostics window by means of the *printf* function.
4.4.2 Example 2 - Pointers in connection with WinCC tags

In Example 2, we will show you how to use pointers in connection with internal tags.
The action is configured to the button example_02 → Events → Mouse → Press left. Click the button called Example 2 with the \( \sqrt{ } \) and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
                    char* lpszPropertyName, UINT nFlags, int x, int y)
{
    //declaration of array
    int array[4];

    int index;
    int *pointer;

    //set tag values
    array[0]=2;
    array[1]=4;
    array[2]=6;
    array[3]=8;

    //pointer to first tag of array
    pointer=&array[0];

    //read index from input_01
    index=GetTagDWord("S32i_course_point_04");
    index--;

    //set internal tag
    SetTagDWord("S32i_course_point_03",*(pointer+index));

    //output in diagnostics window
    printf("\nexample 2\n");
    printf("%d. tag in array is %d\n",(index+1),*(pointer+index));
}
```
Output in the diagnostics window

Explanation of the individual program components

- The first section is the function header. It cannot be changed.
- Declaration of a field (four integers).
- Declaration of a tag.
- Declaration of a pointer.
- Assign values to the fields.
- In this section, the pointer is assigned the address of the first element of the field.
- Read the desired index out of Input Field 1 and adjust to C format (the first element in a field has the index 0).
- The current index is added to the pointer which points to the first position in the field. The pointer that has been calculated in this way is then used to read out the desired element.
- The values are then output in the diagnostics window by means of the printf function.
4.4.3 Example 3 - Pointers in connection with string processing

In Example 3, we will show you how to use pointers in C. We will alter the way a text is presented by turning it into a toolbar.
The action is configured on the static text with the name static text_01 → Properties → Font → Text. By clicking the Example 3 button with the \(\sqrt{\) , the tag BINi_varia_point_05 is set to 1 by means of a direct link. The following script is processed every 250 ms. The if condition is, however, only executed when the Example 3 button is clicked.

C action

```c
#include "apdefap.h"
long _main(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
    //declaration of static tag
    static int i = 10;

    char *str = " WinCC";

    if (GetTagBit("BINi_varia_point_05")) {
        if (i>19) (i=0); //check limit
        i++; //inc
    }

    //return string
    return(str+i);
}
```

The effects are immediately visible in the picture:

WinCC

Explanation of the individual program components

- The first section is the function header. It cannot be changed.
- Declaration of the tag of type static in. Tags with static prefixed to them retain their value for length of time it takes to open the picture. Initialization only takes place the first time the action is called.
- Declaration of the pointer and value assignment.
- Check whether the Example 3 button is clicked.
- Check whether the position exceeds the maximum length of characters. If this is the case, the procedure starts from the beginning again.
- Increment the position.
- The position of the pointer which points to the string is incremented and the result is returned on return.
4.5 Loops and conditional statements in C

In our project, you can find the examples that relate to the topic of loops by clicking the Loops button. By clicking the \( \text{R} \), you can display the source code of the example in question.

**Screen for loops**

After you have clicked the Loops button with the \( \text{R} \), you will see the screen depicted above. The buttons in this screen execute the examples described. By clicking the \( \text{R} \), you can display the source code of the example in question. Ü and ß are further examples of loops.

**Loops**

**Before we begin with the examples, let's take a quick theoretical look at the topic of loops.**

In principle, there are two types of loop: the pre-checking and the post-checking loop. The pre-checking loops check whether or not a condition is true before the body of the loop and the post-checking loops check after the body of the loop. That is, post-checking loops are run through at least once.

If the body of the loop consists of an instruction, the curly brackets can be left out.

**while**

```c
while ([condition])
{ body of loop }
```

The body of the loop is repeated for as long as the condition is satisfied.

**do - while**

```c
do
{ body of loop }
while [condition];
```

The body of the loop is run through at least once and then repeated until the condition is no longer satisfied.
The while condition statement in post-checking loops is always followed by a semicolon; in contrast, there must be no semicolon in pre-checking loops.

for

```c
for ([ Init ] ; [ condition ] ; [ statement ] )
{ body of loop }
```

This all looks very cryptic. So, we rewrite the whole thing a bit differently and end up with the following equivalent expression:

```c
Init;
while [condition]
{ body of loop }
{ [statement];
}
```

Conditional statements

In loops, the body of the loop is processed for as long as the condition is true. In conditional statements, the statement is processed precisely once if the condition is true. When making comparisons, always pay attention to the tag types!

if

```c
if ( [condition1] )
{ body1 }
else
{ body2 }
```

If the condition is true (not 0), Instruction Body1 is processed. If the condition is not true (the value is 0), the alternative in Instruction Body2 is processed. else can also be left out, in which case no alternative is executed.

Since if simply checks the numeric value of an expression, certain abbreviations are possible. The two statements below are therefore identical.

```c
if (condition)
if (condition != 0)
```
You can also combine a number of inquiries:

```java
if ( [condition1] )
  { body1 }
else if ( [condition2] ) // second if inquiry (nested)
  { body2 }
else
  { body3 }
```

In this case, the first condition is checked first. If it is not true, the second condition is checked. If this condition is true, Instruction Body2 is executed. If neither of the conditions is true, Instruction Body3 is executed.

**Note:**

If a condition is executed, the other cases are no longer processed.

If you have more than two inquiries, it is better to use switch case.

**switch & case**

```java
switch ( [tag] ) {
  case [Term1] :
    Action1;
    break;
  case [Term2] :
    Action2;
    break;
  default:
    Action3;
    break;
}
```

In this case, a tag is checked to see whether it matches up. The `switch` statement is used to specify the tag to be checked. First of all, the tag is checked to see whether it corresponds to the `Term1`; if it does, `Action1` is executed. This action can contain as many instructions as you want. The actions are concluded by a `break`!

The keyword `default` is not followed by a comparison. These actions are only executed if none of the `case` conditions are satisfied. That is, a default statement is executed as long as no other case arises.

The `break` statement can be left out with `default` (is always the last statement), but this is not considered good programming.
4.5.1 Example 1 - while loop

In Example 1, we will show you how to use the while loop in a C action. The action is configured to the button example_01 → Events → Mouse → Press left. Click the button called Example 1 with the ⬈️ and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, 
                    char* lpszPropertyName, UINT nFlags, int x, int y)
{
//while loop
int i,j;
printf("\r\n example 1 : while loop\r\n");

j=0; // execution count
i=8; // tag used for loop action
while (i>0) {
    j++;
    i--;
    printf("%d. run : i=%d\r\n",j,i);
} //while
}
```

Output in the diagnostics window

```
example 1 : while loop
1. run : i=7
2. run : i=6
3. run : i=5
4. run : i=4
5. run : i=3
6. run : i=2
7. run : i=1
8. run : i=0
```
Explanation of the individual program components

- The first section is the \textit{function header}. It cannot be changed.
- Declaration of the C tags, \textit{i} is required for the loop function, \textit{j} only for outputting the passes.
- Output in the diagnostics window what comes next.
- Initialize the tags for loop processing.
- The \textit{while} loop is processed for as long as \textit{i} > 0.
- Tag \textit{j} is ented; \textit{i} is decremented.
- The current value of the tag is then output in the diagnostics window by means of the \textit{printf} function.
4.5.2 Example 2 - do - while loop

In Example 2, we will show you how to use the `do - while` loop in a C action. The action is configured to the button `example_02 → Events → Mouse → Press left`. Click the button called `Example 2` with the `☑` and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
       char* lpszPropertyName, UINT nFlags, int x, int y)
{
    //do loop
    int i, j;
    printf("\r\nexample 2 : do loop\r\n");
    j=0; // execution count
    i=8; //tag used in loop action
    do  {
        j++;
        i--;
        printf("%d. run : i=%d\r\n", j, i);
    } //do
    while (i>0);
}
```

Output in the diagnostics window

![Global Script - Diagnostics](image)
Explanation of the individual program components

- The first section is the function header. It cannot be changed.
- Declaration of the C tags. $i$ is required for the loop function, $j$ only for outputting the passes.
- Output in the diagnostics window what comes next.
- Initialize the tags for loop processing.
- The do-while loop is processed for as long as $i \geq 0$ (at least 1 pass).
- Tag $j$ is ented; $i$ is decremented.
- The current value of the tag is then output in the diagnostics window by means of the \textit{printf} function.
4.5.3 Example 3 - for loop

In Example 3, we will show you how to use the for loop in a C action. The action is configured to the button example_03 → Events → Mouse → Press left. Click the button called Example 3 with the \( \sqrt{ } \) and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName, UINT nFlags, int x, int y)
{
    //for loop
    int i,j;
    printf("\n\nexample 3 : for loop\n\n");
    j=0; // execution count
    for(i=7;i>=0;i--) { 
        j++;
        printf("%d. run : i=%d\r\n",j,i);
    } //for
}
```

Output in the diagnostics window

```
example 3 : for loop
1. run : i=7
2. run : i=6
3. run : i=5
4. run : i=4
5. run : i=3
6. run : i=2
7. run : i=1
8. run : i=0
```

![Diagnostics window output](image)
Explaination of the individual program components

- The first section is the function header. It cannot be changed.
- Declaration of the C tags. $i$ is required for the loop function, $j$ only for outputting the passes.
- Output in the diagnostics window what comes next.
- The tag for the loop counter is initialized.
- The for loop is processed for as long as $i \geq 0$. The start value of $i$ is 7.
- Tag $j$ is incremented during the pass; $i$ is decremented after the pass.
- The current value of the tag is then output in the diagnostics window by means of the `printf` function.
4.5.4 Example 4 - Conditional statement with if

In Example 4, we will show you how to use the conditional if statement in a C action.
The action is configured to the button example_04 → Events → Mouse → Press left. Click
the button called Example 4 with the [ ] and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
  char* lpszPropertyName, UINT nFlags, int x, int y)
{
  //if statement
  static int number=12;
  printf("\r\nExample 4 : if statement\n");
  if (number==12) {
    printf("number = 12\n");
    printf("if clause executed\n");
    number=11;
  } //if
  else {
    printf("number != 12\n",number);
    printf("else clause executed\n");
    number=12;
  } //else
}
```

Output in the diagnostics window

![Diagnostics Window](image)
Explanation of the individual program components

- The first section is the *function header*. It cannot be changed.
- Declaration of the C tag as *static*. The value of this tag is retained until the next change of picture.
- Output in the diagnostics window what comes next.
- Processing of the *inquiry*.
- If the condition *(number == 12)* is satisfied, the *if* branch is processed. If the condition is not satisfied, the *else* branch is processed.
- The current result of the inquiry is output in the diagnostics window by means of the *printf* function.
4.5.5 Example 5 - Conditional statement with switch and case

In Example 5, we will show you how to use the switch case statement in a C action. The action is configured to the button example_05 → Events → Mouse → Press left. Click the button called Example 5 with the \( \text{\textsuperscript{\textcircled{L}}} \) and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, 
char* lpszPropertyName, UINT nFlags, int x, int y)
{
    //case statement
    static int number=1;
    if (number==1) printf("\r\nexample 5 : case statement\r\n");
    switch (number) {
        case 1: {
            printf("number = %d\r\n",number);
            printf("case 1 clause executed\r\n");
            number++;
            break;
        } //case1
        case 2: {
            printf("number = %d\r\n",number);
            printf("case 2 clause executed\r\n");
            number++;
            break;
        } //case2
        case 3: {
            printf("number = %d\r\n",number);
            printf("case 3 clause executed\r\n");
            number++;
            break;
        } //case3
        default : {
            printf("number = %d\r\n",number);
            printf("default clause executed\r\n");
            number=1;
            break;
        } //default
    } //switch
```
Output in the diagnostics window:

```
example 5: case statement
number = 1
case 1 clause executed
number = 2
case 2 clause executed
number = 3
case 3 clause executed
number = 4
default clause executed
```

Explanation of the individual program components

- The first section is the *function header*. It cannot be changed.
- Declaration of the C tags as *static*. The value of this tag is retained until the next change of picture.
- During the first pass, what comes next is output in the diagnostics window.
- The *switch* statement defines which tag is to be examined (*number*).
- The *case* statements check whether or not the condition is satisfied. The tag is checked to see whether it matches up. If the condition is not satisfied, the next *case* condition is processed. If this branch is likewise not satisfied, the next *case* condition is checked, etc.
- Each time you click the button with the , a *case* statement or the *default* statement is processed.
- Output in the diagnostics window is initiated by means of the *printf* function.
- The value of tag *number* is changed.
### 4.5.6 Example 6 - Using static tags with conditional statement and return value

In Example 6, we will show you how to use C tags of the type `static` in connection with a conditional statement. The font size is changed by means of the return value in a C action. The action is configured on the property `static_text_01` → `Properties` → `Font` → `Font size`. The following script is processed every 250 ms when the picture is open.

#### C action

```c
#include "apdefap.h"
long _main(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
    Static int i=0;
    static BOOL a=0;
    if (((i<1)||(i>60)) a=!a;
    //inc or dec i according to a
    if (a) i=i+6;
    else i-=6; //short form for i=i-6
    //return
    return(i+20);
}
```

#### Explanation of the individual program components

- The first section is the function header. It cannot be changed.
- Declaration of the C tags as `static`. The value of these tags is retained until the next change of picture. Both are initialized with 0.
- The value of tag `a` is determined. Whenever `i` leaves the permissible range, the value of tag `a` is inverted.
- Tag `i` is incremented or decremented depending on tag `a`. If the condition is satisfied, the tag is incremented. A different notation is `if (a=!0)`.
- To calculate the font size, a minimum size of 20 points is added to tag `i` and transferred to the `Font size` property of the object with `return` as the return value.
4.5.7 Example 7 - Using static tags with conditional statement and return value

In Example 7, we will show you how to use C tags of the type static in connection with a conditional statement. The font color is changed by means of the return value in a C action. The action is configured on the property static_text_02 → Properties → Colors → Font color. The following script is processed every 250 ms when the picture is open.

C action

```c
#include "apdefap.h"
long _main(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
    static long int i=0;
    static BOOL a=0;
    if ((i<400)||(i>1000000)) a=!a;
    //inc or dec i according to a
    if (a==1) i+=500;  //short form for i=i+500
    else i=i-500;
    //return color
    return(i+100000);
}
```

Explanation of the individual program components

- The first section is the function header. It cannot be changed.
- Declaration of the C tags as static. The value of these tags is retained until the next change of picture.
- Whenever i leaves the permissible range, the value of tag a is inverted.
- Tag i is incremented or decremented depending on tag a.
- For returning the color value, the value 100000 is added to tag i and transferred to the property of the object. You will find notes on color coding in the appendix, in Section 5.1.6 Color table.
4.6 File operations in C

In our project, you can find the examples that relate to the topic of files by clicking the Files button. By clicking the $\text{Files}$ button, you can display the source code of the example in question.

Screen for files

After you have clicked the Files button, you will see the screen depicted above. The buttons in this screen execute the examples described. By clicking the $\text{Files}$ button, you can display the source code of the example in question.

Before we begin with the examples, let's take a quick theoretical look at the topic of file operations.
In C, a file is a collection of characters, irrespective of the content.
Before you can edit (read, write) a file in C, you have to open it first.

fopen

A file is opened by means of the fopen function. The name of the file to be edited and the editing mode are transferred as the argument.

```c
FILE *file;
file = fopen (filename, workmode);
```

The file name can also be transferred with its path details.
If an error arises, no connection to a file description is returned, i.e. in C a NULL pointer.
The tag of type FILE contains the information which file commands required for editing the file.

In editing mode, define which functions are allowed.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>r</td>
<td>Opening the file for reading (r = read). The return value is NULL if the file does not exist or there is no read authorization.</td>
</tr>
<tr>
<td>W</td>
<td>Opening the file for writing (w = write). The return value is NULL if the file is READ-ONLY or it does not exist.</td>
</tr>
<tr>
<td>a</td>
<td>Opening the file for appending at the end (a = append). If the file exists, what has been written is appended at the end.</td>
</tr>
<tr>
<td>Mode</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>If the file does not exist, it is created. The return value is NULL if a new file is not allowed to be created or the existing file is not allowed to be written to.</td>
</tr>
<tr>
<td>r+</td>
<td>The file is opened for being read and written to alternately. The return value is NULL if the file does not exist or there is no read and write authorization for the file.</td>
</tr>
<tr>
<td>w+</td>
<td>Creating a new file for being read and written to alternately. If the file already exists, it is deleted! The return value is NULL if the author does not have authorization for these actions.</td>
</tr>
<tr>
<td>a+</td>
<td>Opening a file for being read or written to (appended to) at the end. If the file is created if it does not already exist. The return value is NULL if a file is not allowed to be read or written to, or if the file authorization is inadequate.</td>
</tr>
</tbody>
</table>

**fclose**

fclose is used to closed files that we have opened beforehand by means of fopen.

fclose (file);

**fscanf**

The instruction behaves in exactly the same way as scanf, the difference being that fscanf specifies the file from which the information comes.

fscanf (file, "%c", character);

**fprintf**

The instruction behaves in exactly the same way as printf, the difference being that fprintf specifies the file to which the information is sent.
4.6.1 Example 1 - Opening, writing to and closing a file

In Example 1, we will show you the basic file operations in C. The action is configured to the button `example_01` → `Events` → `Mouse` → `Press left`. Click the button called `Example 1` with the ⌘ and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName, UINT nFlags, int x, int y)
{
    FILE *file;
    long l;
    float fp;
    char s[20];
    char c;

    //open file to write
    datei = fopen( "cours_00.dat", "w+" );

    //file open error ??
    if( file != NULL ){
        l=6500;
        strcpy(s,"sentence");
        fp=3.1434567;
        c=’d’;

        //write data
        fprintf( file,"%s\n%ld\n%f\n%c\n", s, l, fp, c );

        //output in diagnostics window
        printf("\nexample 1\n");
        printf("written data\n");
        printf("string: \t	%s\n", s);
        printf("int value: \t	%ld\n", l);
        printf("float value: \t%f\n", fp);
        printf("character: \t%c\n", c);

        //close file
        fclose( file );
    } //if
    else printf( "file open error\n" );
}
```
Output in the diagnostics window:

![Global Script - Diagnostics](image)

example 1
written data
string: sentence
int value: 6500
float value: 3.143457
character: d

Explanation of the individual program components

- The first section is the function header. It cannot be changed.
- Declaration of the tag and of the pointer.
- Opening the file to overwrite it. If the file does not yet exist, it is created.
- In this section, opening of the file is checked in a conditional inquiry. If this works, the values are assigned to the tag and written to the file by means of `fprintf`. If the file has not been opened or created successfully, the else branch is processed.
- The values are then output in the diagnostics window by means of the `printf` function.
- In the final step, the file is closed.
4.6.2 Example 2 - Opening, appending to and closing a file

In Example 2, we will show you the basic file operations in C.
The action is configured to the button \textit{example 02} \rightarrow \textit{Events} \rightarrow \textit{Mouse} \rightarrow \textit{Press left}. Click the button called \textit{Example 2} with the \textbf{Ctrl} and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
    char* lpszPropertyName, UINT nFlags, int x, int y)
{
    static int i = 0;
    FILE *file;
    char s[200];
    switch (i) {
        case 0 : strcpy(s,"This\r\n"); break;
        case 1 : strcpy(s,"sentence\r\n"); break;
        case 2 : strcpy(s,"is\r\n"); break;
        case 3 : strcpy(s,"a\r\n"); break;
        case 4 : strcpy(s,"long\r\n"); break;
        case 5 : strcpy(s,"one\r\n"); break;
    }

    //open file to write and append data
    datei = fopen("cours_00.dat","a");

    //file open error ??
    if( file != NULL ){
        //write data
        fprintf(file,"%s",s);

        //output in diagnostics window
        if (i==0) {
            printf("\r\nexample 2");
            printf("\r\nwritten data\r\n");
        }
        printf("string:\t%s",s);
        fclose( datei );//close file
    } //if
    else printf("\r\nfile open error\r\n");
    i++;
    if (i>5) (i=0);
}
```
Output in the diagnostics window:

![Global Script - Diagnostics](image)

**example 2**

**written data**

<table>
<thead>
<tr>
<th>string</th>
<th>content</th>
</tr>
</thead>
<tbody>
<tr>
<td>string:</td>
<td>This</td>
</tr>
<tr>
<td>string:</td>
<td>sentence</td>
</tr>
<tr>
<td>string:</td>
<td>is</td>
</tr>
<tr>
<td>string:</td>
<td>a</td>
</tr>
<tr>
<td>string:</td>
<td>long</td>
</tr>
<tr>
<td>string:</td>
<td>one</td>
</tr>
</tbody>
</table>

25.02.98  13:59:32

Explanation of the individual program components

- The first section is the *function header*. It cannot be changed.
- Declaration of the tag and of the pointer.
- Generating a text depending on the static tag *i*.
- Opening the file to append the data to the end of the file.
- In this section, opening of the file is checked in a conditional inquiry. If opening works, the current text is written to the file by means of *printf*. The data (contents of tag *s*) is appended to the end of the file.
- The text written is then output in the diagnostics window by means of the *printf* function.
- In the final step, the file is closed.
4.6.3 Example 3 - Opening, reading and closing a file

In Example 3, we will show you the basic file operations in C. The action is configured to the button example_03 → Events → Mouse → Press left. Click the button called Example 3 with the \( \sqrt{\) and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
                    char* lpszPropertyName, UINT nFlags, int x, int y)
{
    FILE *file;
    int i;
    char t[20];
    char* z;
    //open file to read
datei = fopen("cours_00.dat","r");

    //file open error ??
    if( file != NULL ){
        printf("\nexample 3\n
data read in file\n");
        printf("\n\r\ndata read in file\r\n");

        //read data in file
        i=1;
        while ( i ) {
            i++;
            z=fgets(t,20,file);
            if (z==NULL) break; //end of file
            //output in diagnostics window
            printf("line%02d\t\t%s",(i-1),t);
        //while

        //close file
        fclose( file );
    } //if
else {
    printf("\r\nfile open error\r\n");
} //else
```

Output in the diagnostics window:

![Diagnostic Window](image)

Explanation of the individual program components

- The first section is the *function header*. It cannot be changed.
- Declaration of the tag and of the pointer.
- Opening the file.
- In this section, opening of the file is checked in a conditional inquiry. If this works, the data is read out of the file line-by-line by means of fgets and output in the diagnostics window by means of the printf function. When the end of the file is reached (return value is 0), the while loop is exited by means of break.
- In the final step, the file is closed.
4.6.4 Example 4 - Deleting a file

In Example 4, we will show you how to delete the file created beforehand. The action is configured to the button example_05 → Events → Mouse → Press left. Click the button called Example 5 with the `√` and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
   char* lpszPropertyName, UINT nFlags, int x, int y)
{
   //delete file
   remove("cours_00.dat");
   printf("\r\n\nexmaple 4\r\n");
   printf("file cours_00.dat was deleted\r\n");
}
```

Output in the diagnostics window

```
example 4
file cours_00.dat was deleted
```

Explanation of the individual program components

- The first section is the function header. It cannot be changed.
- The file is deleted.
- The diagnostics window then displays what has happened.
4.7 Structures in C

In our project, you can find the examples that relate to the topic of structures by clicking the Structures button. By clicking the button, you can display the source code of the example in question.

**Screen for structures**

![Image of a screen with structures and examples]

After you have clicked the Structures button with the button, you will see the screen depicted above. The buttons in this screen execute the examples described. By clicking the button, you can display the source code of the example in question.

In the right-hand field, the values of the input fields in Example 2 are evaluated.

Before we begin with the examples, let's take a quick theoretical look at the topic of structures.

**Definition of the structure**

In principle, a structure declaration in C looks as follows:

```c
struct structurename{
    [ components ]
};
```

In C, components are a collection of defined tags, which are themselves structural elements and a permanent part of the structure created. In principle, we can handle the structure in the same way as a tag type, since it is in fact a collection of data types.

With

```c
struct whole {
    int number;
    char character[50];
};
```

```c
struct whole structure[2];
```

The above instruction is used in the declarative section to define the structure layout. Imagine that a data type, `struct whole`, is created and that the tag, `structure`, is of the type `struct whole`. 
The following simplification can be used for the declaration

The declaration of the structure layout and the definition of a tag can be combined into one statement:

```c
struct whole {
    int number;
    char character [50];
} structure [2];
```

Accessing the tags in the structure

`structurename.tagname` can be used to access specific pieces of data. It is essential that there is a decimal point (or dot) between the two elements. It separates the individual elements in the hierarchy.

The tag name is always the name that is used when creating the structure!

With

```c
structure[0].number = 2;
strcpy(structure[0].character,"our first structure");
```

The above statement is used to assign the values to the elements. In the case of character strings, it is possible to use a simple assignment (With `strcpy`, a character or a character string is assigned to a character string).

As before, you can also access fields within structures:

```c
printf (%c",structure[0].character[5] );
```

For example, outputs the 6th letter of the character string from the 1st field of `structure [0]`. **Indices start at 0**!

Pointers as structural elements

Any types of tag can be incorporated into a structure. This also includes pointers. The following structure is, therefore, perfectly conceivable:

```c
struct structure{
    int number;
    char *character string;
}
```

**Note:**

If a pointer that points to a character string (e.g. `*character string`) is used, the memory must also be available or be allocated beforehand (e.g. by means of the internal function `sysMalloc (8)`).

As an example of this, we will use the structure of the previous example and generate the following pointer:

```c
struct struktur *pointer;
```

If we now want to access an element, we have to write the following:

```c
(*pointer).number;  // or more simply  pointer->number;
```

**Note:**

Since the dot takes priority over the `*` operator, must first expression must be set in parentheses.
4.7.1 Example 1 - Structures in C

In Example 1, we will show you how to use structures in C.
The action is configured to the button example_01 \rightarrow Events \rightarrow Mouse \rightarrow Press left. Click the button called Example 1 with the √ and the next script will be edited.

C action

```
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName, UINT nFlags, int x, int y) {

    //declare structure
    struct data {
        char name[40];
        int age;
        int weight;
        float height; } family[3];

    int i;

    //set values to structure elements
    strcpy(family[0].name,"Rudi");
    strcpy(family[1].name,"Simone");
    strcpy(family[2].name,"Bernhard");

    family[0].age=8;
    family[1].age=13;
    family[2].age=18;

    family[0].weight=38;
    family[1].weight=47;
    family[2].weight=53;

    family[0].weight=1.34;
    family[1].weight=1.56;
    family[2].weight=1.78;

    //output in diagnostics window
    printf("\n\nexample 1\n\nthis is a family\n");
    for (i=0;i<3;i++) {
        printf("%s is %d years old, has %d kg and is %.2f m height.\n",family[i].name,family[i].age,family[i].weight,family[i].height);
    }
}
```
Output in the diagnostics window:

![Global Script - Diagnostics](image)

**Example 1**

this is a family
Rudi is 8 years old, has 38 kg and is 1.34 m height.
Simone is 13 years old, has 47 kg and is 1.56 m height.
Bernhard is 10 years old, has 53 kg and is 1.70 m height.

25.02.98 14:10:48

Explanation of the individual program components

- The first section is the *function header*. It cannot be changed.
- Declaration of the structure and of the tag.
- The values are assigned to the structural elements.
- The values (pieces of information) are then output in the diagnostics window by means of the *printf* function.
4.7.2 Example 2 - C structures in connection with WinCC

In Example 2, we will show you how to use structure tags in WinCC. Before we can use these structure tags in our action, they have to be created in the tag management of the Control Center. You will find a detailed explanation in the Configuration Manual, Volume 2, in the example 2.8 Using Structure Tags.

The action is configured to the button example_02 → Events → Mouse → Press left. Click the button called Example 2 with the $\sqrt{\text{F}}$ and the next script will be edited.

C action

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, 
    char* lpszPropertyName, UINT nFlags, int x, int y)
{
    int input1,input2;
    int output1,output2;
    //read selected position in input_01 and input_02
    input1=GetTagDWord("S32i_course_str_01");
    input2=GetTagDWord("S32i_course_str_02");
    input1=input1-1;
    input2=input2-1;
    //calculate new rectangle position
    output1=500+(input1*40);
    output2=470+(input2*40);
    //set internal tags which contain rectangle position
    SetTagDWord("STUi_course_str_00.xpos",output2);
    SetTagDWord("STUi_course_str_00.ypos",output1);
}
```

Display on the screen:
Explanation of the individual program components

• The first section is the *function header*. It cannot be changed.
• Declaration of the tags.
• Reading the values out of the I/O fields. The limits of the input are defined directly in the *I/O fields*.
• Recalculate the positional specifications entered to give positions on the screen.
• Assign the values calculated to the WinCC structure tags. The values are linked to the X and Y positions of the rectangle.
• The structure used must be declared under *Control Center → Data Types → Structure Types*, and has the following layout:

Creating the structure tags in the tag management
4.8 Global Scripts

In our project, you can find the examples that relate to the topic of Global Scripts by clicking the GSC button. By clicking the \( \sqrt{R} \), you can display the source code of the example in question.

**Screen for Global Script**

After you have clicked the GSC button with the \( \sqrt{R} \), you will see the screen depicted above. The buttons in this screen execute the examples described. By clicking the \( \sqrt{R} \), you can display the source code of the example in question.

The project functions have been created in the Global Script editor and used in the object-oriented actions in the Graphics Designer. The functions are selected via the function tree in the editor of the C action.
4.8.1 Example 1 - Using a project function

In Example 1, we will show you how to use project functions in a C action. The action is configured to the button example_01 → Events → Mouse → Press left. Click the button called Example 1 with the \(\sqrt{\text{C}}\) and the next script will be edited.

Program of the project function

```c
void calculate(float a, float b, float *pRes1, float *pRes2)
{
    // calculate and store value in addresses
    *pRes1 = a / b; // divide
    *pRes2 = a * b; // multiply
}
```

Program of the action on the object

```c
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName, UINT nFlags, int x, int y)
{
    float number1, number2;
    float result1, result2;
    number1 = 267.3;
    number2 = 23.7;
    // execute function and set parameters
    calculate(number1, number2, &result1, &result2);
    // output in diagnostics window
    printf("example 1\r\n");
    printf("values calculated in function\r\n");
    printf("%f  /  %f = %f\r\n", number1, number2, result1);
    printf("%f  *  %f = %f\r\n", number1, number2, result2);
}
```
Output in the diagnostics window

![Global Script - Diagnostics](image)

Example 1

Values calculated in function

\[
\begin{align*}
267.299988 \times 23.700001 &= 6335.009766 \\
267.299988 / 23.700001 &= 11.278481
\end{align*}
\]

Explanation of the individual program components

- In the program of the action, the tags \(\text{number1, number2}\) are declared and the project function \(\text{calculate}\) is transferred.
- In the program of the project function called, the values transferred are calculated. The values calculated are returned by means of the two pointers \(\ast\text{pRes1, pRes2}\).
- The values in the \textit{C action} are then output in the diagnostics window by means of the \textit{printf} function.
### 4.8.2 Example 2 - Using project functions, further examples

In Example 2, we will show you how to use project functions in a C action. The action is configured to the button example_02 → Events → Mouse → Press left. Click the button called Example 2 with the \( \sqrt{ \) and the next script will be edited.

#### Program of the project function

```c
void colourchange()
{
    long int color1,color2,color3,color4;
    long int store;

    //get rectangle colors
    color1=GetBackColor(lpszPictureName,"rectangle_01");
    color2=GetBackColor(lpszPictureName,"rectangle_02");
    color3=GetBackColor(lpszPictureName,"rectangle_03");
    color4=GetBackColor(lpszPictureName,"rectangle_04");

    //cyclic color change
    store=color1;
    color1=color2;
    color2=color3;
    color3=color4;
    color4=store;

    //set rectangle colors
    SetBackColor(lpszPictureName,"rectangle_01",color1);
    SetBackColor(lpszPictureName,"rectangle_02",color2);
    SetBackColor(lpszPictureName,"rectangle_03",color3);
    SetBackColor(lpszPictureName,"rectangle_04",color4);
}
```

#### Program of the action on the object

```c
#include "apdefap.h"

void OnLButtonDown(char* lpszPictureName, char* lpszObjectName,
                        char* lpszPropertyName, UINT nFlags, int x, int y)
{
    //execute function
    colourchange(lpszPictureName);
}
```
Change of colors on mouse click

Explanation of the individual program components

- In the program of the project function, the current colors are read out, shifted one position further and reassigned to the objects.
- The picture name is transferred when the project function is called.
4.9 Project as an example

This project is another example of how to use the pointers, loops, statements, file operations, structures, and global scripts described in the previous chapters. The individual program components are not described in any detail here.

Screen for project

When you open the screen containing the project, you see the above picture. This represents a color mixing system. By clicking the Red, Green and Blue buttons with the ‘√’ symbol, you add the corresponding color. You have to click the button again to stop adding the color. You reset the system to its initial state by clicking Restart. The output fields indicate the amount of each color already added (max. 50).
4.10 Displaying the source code by clicking the right mouse button

In the project with the name *Cours_00*, the sources of the *C action* can be displayed in all examples while runtime is in progress. You display them, in all examples, by clicking the respective button with the right mouse button.

```c
#include "apdefap.h"
void OnRButtonDown(char* lpszPictureName, char* lpszObjectName,
                    char* lpszPropertyName, UINT nFlags, int x, int y)
{
  char name[30],namex[30];
  int visx,comp;
  int number;
  int  ch = '_';
  char *pdest;

  visx=GetVisible("course_0_startpicture_00.PDL","code picture");
  strcpy(namex,GetTagChar("T16x_org_picname_02"));
  pdest = strrchr( lpszObjectName, ch );
  if ( pdest == NULL ) {printf("ObjectNameError");}
  else {
    number = atoi(strrchr(lpszObjectName,'_')+1);
    sprintf(name,"course_4_tag_%02d.PDL",number);
    SetTagChar("T16x_org_picname_02",name);
  }
  comp=strcmp(name,namex);
  if ( (comp==0) && (visx==1) ){
    SetVisible("course_0_startpicture_00.PDL","code picture",0);
    SetVisible("course_0_startpicture_00.PDL","code picture",1);
  }
  else SetVisible("course_0_startpicture_00.PDL","code picture",1);
}
```

Explanation of the individual program components

- The first section is the *function header*. It cannot be changed.
- Declaration of the tags.
- Check whether the picture window has already been opened.
- Read out the picture name.
- Define the button number.
- Put together the name of the source code picture.
- Compare to see whether or not the picture name has been changed.
- If the name is the same, close the picture and rebuild it so that it is displayed in the foreground.
- A new picture is the picture that is displayed.
5 Appendix

In this Appendix, you will a collection of topics that have not been directly incorporated into the Configuration Manual.
5.1 Tips and tricks

More examples of configuring with WinCC.
5.1.1 Standard input/output at I/O field

Configure the following actions so that an I/O field is displayed in a standard manner and/or the entered value to be transferred to the PLC in a standard manner:

Action on property "Output Value" of an I/O field (important: "float", if you require digits behind the decimal point)

```c
float a;
a=GetTagFloat("DB21_DW1");
return(a/100);
```

Action on event "input value" of an I/O field (tag "Var1" is an unsigned 16-bit value)

```c
float a;
a=GetInputValueDouble(lpszPictureName,lpszObjectName);
SetTagFloat("Var1",a*100);
```
5.1.2 Object-specific actions upon Open Picture

There are cases in which you have to perform actions on the property of one or more objects in a picture only once upon Open Picture. One possibility is to formulate a picture-specific action on the picture object under Events → Miscellaneous → Open Picture. This, however, has the disadvantages that the action has to have an effect on objects in the picture and thus the object names have to be firmly specified in the picture. The objects can no longer be handled freely. This solution is not object-oriented.

There is a way in which you can avoid this problem:

- Define an internal tag - for example, dummy - which is never updated or deliberately set. Set the trigger for the action on the object to modify that tag. On opening the picture in runtime, the action is activated for the first time and would then only react again thereafter if tag dummy were to be modified, which does not happen since this tag is never modified.
5.1.3 WinCC Scope

General

*WinCC Scope* is a tool that supports you in diagnosing WinCC projects. It makes a great deal of information available about the activated project and also about the computer system concerned. You require a web browser such as Internet Explorer to be able to work with *Scope*. In addition, the TCP/IP network protocol must be installed.

Starting and running

If you have installed WinCC, *Scope* is also installed by default. Before you can use Scope, you have to start the *WinCCDiagAgent.exe* program. You will find it in the folder called *Siemens\WinCC\WinCCScope\bin*. The program is a simple HTTP server. You can then launch *Scope* from the Start menu. From the start page, you are directed to *How to use the new Diagnostics Interface*, a page containing a general description of how to run *WinCC Scope*. Click *http://localhost* to start *Scope*. You can select and view various kinds of information from a list contained in the left window. The segment called *System Info* contains general information on the different computer systems concerned, whereas you can find information on the WinCC project that has just been activated in the segment called *WinCC Info*.
5.1.4 Accessing the database

5.1.4.1 Accessing the database from Excel/MSQuery

The following description of accessing the WinCC database refers to the use of Microsoft® Excel 97 with SR-1.

Accessing from Excel/MSQuery

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: Access from Excel/MSQuery</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open Excel. Choose Data → External Data → Create New Query... from the menu to open the Select Data Source in MSQuery.</td>
</tr>
<tr>
<td></td>
<td>On the Databases tab, select the entry &lt;New Data Source&gt;. Choose OK to create a new data source.</td>
</tr>
</tbody>
</table>
2 Specify the name of the new data source in the Create New Data Source dialog box. It does not have to be the name of the WinCC database. Select Sybase SQL Anywhere 5.0 as the driver.

Choose the Connect... button to open the Connect to SQL Anywhere dialog box and enter the information required by the driver. Enter the User ID as dba and the Password as sql. Choose the Browse button to select the database you want to edit.

Choose OK to terminate your input.

3 If a data source has yet to be configured for the database you selected, the message Name of data source not found and no standard driver specified appears.

Confirm this message and click the Connect... button once again. Select the Machine Data Source tab in the Select Data Source dialog box. The CS and runtime databases of the current WinCC project already appear in the list of data sources.
### Procedure: Access from Excel/MSQuery

Sources. The names of these data sources begin with the character string `CC_`, which is followed by the project name. The name of the data source representing the runtime database ends with an `R` character.

If you want to work on a WinCC database, you must first create a data source for it. You do this by choosing the New button. In the Create New Data Source wizard that appears, select the item called User Data Source on the first page and close the page by clicking Next. On the next page, select the driver Sybase SQL Anywhere 5.0 and close the page by clicking Next. Close the last page by clicking Finish.

The SQL Anywhere ODBC Configuration dialog box opens, in which you have to enter information required by the driver. The User ID you have to enter is again dba and the Password is sql. Choose the Browse button to select the database you want to edit.

Choose OK to close the dialog box.

#### SQL Anywhere ODBC Configuration

<table>
<thead>
<tr>
<th>Data Source Name: Example_01t</th>
<th>OK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description:</td>
<td></td>
</tr>
<tr>
<td><strong>Connection Information</strong></td>
<td></td>
</tr>
<tr>
<td>User ID:</td>
<td>dba</td>
</tr>
<tr>
<td>Password:</td>
<td>***</td>
</tr>
<tr>
<td>Server Name:</td>
<td>&lt;default&gt;</td>
</tr>
<tr>
<td>Database Name:</td>
<td>Example_01t</td>
</tr>
</tbody>
</table>

#### Database Startup

- **Database File:** D:\Handbuch\Example_01\EXAM1
- **Local**
- **Network**
- **Custom**
  - **Browse...**

#### Additional Connection Options

- **Translator Name:** <No Translator>
- **Select**
- **Microsoft Applications (Keys in SQL Statistics)**
- **Prevent Driver not Capable errors**
- **Delay AutoCommit until statement close**

Select the newly created data source in the Select Data Source dialog box and click OK to close the dialog box.

Confirm the Connect to SQL Anywhere dialog box which then appears.

You can configure the data source beforehand by means of the Control Panel. Open the ODBC Data Source Administrator on the Control Panel. Choose the Add button to open the Create New Data Source wizard.
### Accessing the database from Access

The following description of accessing the WinCC database refers to the use of Microsoft® Access 97 with SR-1.

**Accessing with Access**

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: accessing with Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open an Access database, or create a new one. Choose File → Get External Data → Import... from the menu to open the Import dialog box. For the file type, select the ODBC Databases() list entry. The Select Data Source dialog box will be opened automatically. Select a data source on the Machine Data Source tab. The CS and runtime databases of the current WinCC project already appear in the list of data sources. The names of these data sources begin with the character string CC_, which is followed by the project name. The name of the data source representing the runtime database ends with an R character.</td>
</tr>
<tr>
<td>2</td>
<td>If the WinCC database does not appear in the list, create it first as a data source by choosing the New button. In the Create New Data Source wizard that appears, select the item called User Data Source on the first page and close the page by clicking Next. On the next page, select the driver Sybase SQL Anywhere 5.0 and close the page by clicking Next. Close the last page by clicking Finish. The SQL Anywhere ODBC Configuration dialog box opens, in which you have to enter information required by the driver. Enter the User ID as dba and the Password as sql. Choose the Browse button to select the database you want to edit. Choose OK to close the dialog box.</td>
</tr>
</tbody>
</table>
### 5.1.4.3 Accessing the database from ISQL

Direct access to the WinCC database is possible using ISQL. This, however, is entirely your personal responsibility since the configuration data may become inconsistent as a result of editing or deleting tables.

**Accessing with ISQL**

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: accessing with ISQL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start ISQL.EXE in the folder called Siemens\Common\sqlany. The <strong>Interactive SQL Logon</strong> dialog box appears. Enter the <strong>User ID</strong> as <em>dba</em> and the *<em>Password as sql</em>. If you acknowledge by choosing OK, the program is automatically connected to the current WinCC database - in other words, to the CS database. If, however, you wish to access another database - for example, the...</td>
</tr>
</tbody>
</table>
### 5.1.4.4 Accessing the database from WinCC Scope

#### Accessing with WinCC Scope

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure: accessing with WinCC Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Before starting WinCC Scope from the Start menu, start the application called WinCCDiagAgent.exe in the Siemens\WinCC\WinCCScope\bin folder. Click Scope to start Scope.</td>
</tr>
<tr>
<td>2</td>
<td>You can obtain a general description of how to run WinCC Scope from the first page by selecting How to use the new Diagnostics Interface. Click <a href="http://localhost">http://localhost</a> to start Scope.</td>
</tr>
</tbody>
</table>
| 3    | You can select different functions from a list in the left segment.  
  - Select Database to obtain general information about the WinCC database.  
  - You can view different tables in a database by selecting Database Query. The default data source is the CS database of the current WinCC project. The names of these data sources begin with the character string CC_, which is followed by the project name. The name of the data source representing the runtime database ends with an R character. However, other data sources can also be displayed.  
  - SQL statements can be applied to a data source you select by means of SQL query. However, it is advisable to edit the WinCC database only if your system knowledge of SQL statements is very good. Examples of SQL statements are listed in the preceding section called Accessing the database from ISQL. |

---

**Step**

runtime database - choose Command → Connect from the menu. In the dialog box that appears, enter the same details for the User ID and Password. For Database File, enter the database you require with its full path.

2 You can now enter SQL statements in the Command window and execute them by choosing the Execute button. Here are some examples of SQL statements:

- select* from systable: displays all table names
- select * from <table_name> : shows the contents of the table called <table_name>
- unload table <table_name> to <filename> : exports the table called <table_name> to the file called <filename>
- drop table <table_name> : deletes the table called <table_name>
5.1.4.5 Exporting from a database using C actions

Data export can also be activated from a WinCC runtime picture. To do this, it is possible to start an interactive SQL with a command line by means of ProgramExecute. The action which has to be executed is stored in a command file (archiv.sql in our example).

C action - on button, for example

```c
#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
    lpszPropertyName)
{
    char* path =   "C:\\SIEMENS\\Common\\SQLANY\\SQL -q -b -c";
    char* parameters =
        "UID=DBA;PWD=SQL;DBN=CC_Project_97-10-21_09:53:27R";
    char* action = "read D:\\WinCC\\Project\\archiv.sql";
    char ExportArchive[200];
    sprintf(ExportArchive,"%s %s %s",path,parameters,action);
    ProgramExecute(ExportArchive);
}
```

- The **path** tag contains the path to the ISQL.exe program with its call parameters.
- The **parameters** tag contains the input that has to be performed in the **Interactive SQL Logon** dialog box for connecting to the database. The input consists of:
  - **UID** (User ID) : DBA
  - **PWD** (Password) : SQL
  - **DBN** (Data Base Name) : Name of the ODBC data source. The names of these data sources begin with the character string **CC_** which is followed by the project name together with the date and time of creation of the project. The name of the data source representing the runtime database ends with an **R** character. You can set this name, when the project has been activated, by choosing **Control Panel → ODBC → User DSN** tag.
- The **action** tag specifies that the SQL statements listed in the **archiv.sql** file have to be executed.
- The statements are combined in **ExportArchive** and executed with the **ProgramExecute()** function.

**Note:**

If you want to export from a database other than one of the two project databases, specify the **DBF** parameter, the database file with specification of the path to the database, instead of the **DBN** parameter. This method does not work for the currently activated project database, however.
Contents of the file: archiv.sql

```
select * from PDE#HD#ProcessValueArchive#Analog;
output to D:\WinCC\Projekt\archiv.txt format ascii
```

- In the open database, the measured value archive `pde#hd#ProcessValueArchive#Analog` is selected and then exported by means of the output instruction to the ASCII file called `archiv.txt`.

### 5.1.4.6 Database selections

The `select` instruction in the command file that was described earlier selects tables. Subsets of these tables can be selected with additional parameters and are then exported with the `output` instruction. A few examples of this subject are shown below.

**Selecting a time range**

```
select * from PDE#HD#ProcessValueArchive#Analog where T between '1996-5-1 10:10:0.00' and '1996-6-1 10:10:0.00'
```

**Selection from a time stamp**

```
select * from PDE#HD#ProcessValueArchive#Analog where T > '1996-5-1 10:10:0.00'
```

**Selecting a process value with and without sorting**

```
select * from PDE#HD#ProcessValueArchive#Analog where V > 100
select * from PDE#HD#ProcessValueArchive#Analog where V > 100
order by T
```

**Selecting with selection of columns t (time) and v (value) to process value**

```
select T,V from PDE#HD#ProcessValueArchive#Analog where V > 100
order by T
```
5.1.5 Serial connection

To establish a serial connection, perform the following settings:

**CP525 settings:**

- **Message:** Parameter CP525 Name: P3964R
- **Procedure:** COMPONENT: RK    Version : 01
- **Baud rate:** 9600
- **Number of stop bits:** 1
- **Parity:** EVEN

On the PLC, you require SYNCHRONOUS in the startup circuit for the CP525 and SEND/RECEIVE ALL in the cyclic program.

**WinCC settings:**

![Connection properties](image)

For optimization purposes, one of the peers - preferably WinCC - should have the priority high.
5.1.6 Color table

The color values are composed from a large palette.
The sixteen basic colors are:

<table>
<thead>
<tr>
<th>Color</th>
<th>Color Value (hex)</th>
<th>Symbolic Constant</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>0x000000FF</td>
<td>CO_RED</td>
</tr>
<tr>
<td>Dark red</td>
<td>0x00000080</td>
<td>CO_DKRED</td>
</tr>
<tr>
<td>Green</td>
<td>0x0000FF00</td>
<td>CO_GREEN</td>
</tr>
<tr>
<td>Dark green</td>
<td>0x00080000</td>
<td>CO_DKGREEN</td>
</tr>
<tr>
<td>Blue</td>
<td>0x00FF0000</td>
<td>CO_BLUE</td>
</tr>
<tr>
<td>Dark blue</td>
<td>0x00800000</td>
<td>CO_DKBLUE</td>
</tr>
<tr>
<td>Cyan</td>
<td>0x00FFFF00</td>
<td>CO_CYAN</td>
</tr>
<tr>
<td>Dark cyan</td>
<td>0x00808000</td>
<td>CO_DKCYAN</td>
</tr>
<tr>
<td>Yellow</td>
<td>0x0000FFFF</td>
<td>CO_YELLOW</td>
</tr>
<tr>
<td>Dark yellow</td>
<td>0x00080808</td>
<td>CO_DKYELLOW</td>
</tr>
<tr>
<td>Magenta</td>
<td>0x00FF00FF</td>
<td>CO_MAGENTA</td>
</tr>
<tr>
<td>Dark magenta</td>
<td>0x00800080</td>
<td>CO_DKMAGENTA</td>
</tr>
<tr>
<td>Light gray</td>
<td>0x00C0C0C0</td>
<td>CO_LTGRAY</td>
</tr>
<tr>
<td>Gray</td>
<td>0x00808080</td>
<td>CO_DKGRAY</td>
</tr>
<tr>
<td>Black</td>
<td>0x00000000</td>
<td>CO_BLACK</td>
</tr>
<tr>
<td>White</td>
<td>0x00FFFFFF</td>
<td>CO_WHITE</td>
</tr>
</tbody>
</table>

symbolic constant predefined externally by #define.
Mixed colors are produced by means of intermediate values on the palette.

If color changes are created with the help of the Dynamic dialog box and the configured
data are subsequently processed with the C actions, the color values can similarly be read out, though they are in decimal format.
5.2 Documentation of S5 Alarm Logging

Task and function of S5 alarm logging

The present document describes the functions and properties of the SIMATIC S5 software:

S5 alarm logging
The software is used to ensure binary messages are acquired in the correct chronological order, to process them and to store them temporarily. The program package provides the requisite software functionality within the SIMATIC S5 to implement chronologically correct message acquisition of the WinCC system.

The basic method of operation of the software can be described as follows. The software monitors the binary signal condition of the messages which the user makes available to the S5 alarm system at a message interface. If a signal condition changes, the message is identified by means of its message number and date/time stamped. To these data are added a 32-bit process variable and an alphanumeric job/batch identifier - if configured by the user. The message block configured in this manner is stored temporarily, if required, in a FIFO buffer. Temporary storage of message data is necessary whenever more message are issued per unit of time than can be transferred over an existing BUS connection to the WinCC system. This functionality makes it possible to achieve decoupling with respect to time between chronological message acquisition in the SIMATIC S5 and higher-level WinCC alarm logging and enables message processing with real-time compatibility.

The message blocks generated by S5 alarm logging are made available to the S5 user program at a data block interface. By using S5 communication software, which has to be implemented by the user, these data are transferred over a BUS connection - for example, SINEC H1 - to higher-level WinCC alarm logging. A wide range of processing functions is available for the messages at that level - for example, visualization, archiving, reporting, etc.

The configuration of S5 alarm logging is performed by the user by means of a data block interface (system DB 80). At this point the user determines the system envelope within which alarm logging works. Definitions of the memory areas used by S5 alarm logging, the type and scope of the messages that have to be processed and allocation of the assigned address areas are specified at this point.

The present section describes the use and handling of S5 alarm logging in a SIMATIC S5 environment. The user is provided with an overview of the function and data blocks used by the software, and the storage space required. This is followed by an in-depth interface description of all the existing data interfaces between S5 alarm logging and the S5 user program. To help you, an example project is presented to make S5 alarm logging easier for the user when starting.
5.2.1 List of software blocks

The SIMATIC S5 software can be found on the CD together with the examples relating to this manual is stored under the file name 'WINCCIST.S5D'.

The file contains the following function and data blocks for S5 alarm logging:

<table>
<thead>
<tr>
<th>FB</th>
<th>Name</th>
<th>Size</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB 80</td>
<td>SYSTEMFB</td>
<td>1114</td>
<td>Sequenced Reporting</td>
</tr>
<tr>
<td>FB 81</td>
<td>ANLAUFFB</td>
<td>135</td>
<td>Startup and initialization of Sequenced Reporting</td>
</tr>
<tr>
<td>FB82</td>
<td>PCHECK</td>
<td>574</td>
<td>Called by FB 81</td>
</tr>
<tr>
<td>FB 83</td>
<td>MBLOCK</td>
<td>699</td>
<td>Called by FB 80</td>
</tr>
<tr>
<td>FB 84</td>
<td>SCHREIB</td>
<td>94</td>
<td>Called by FB 80</td>
</tr>
<tr>
<td>FB 87</td>
<td>VOLL</td>
<td>87</td>
<td>Called by FB 80</td>
</tr>
<tr>
<td>DB 80</td>
<td>System DB</td>
<td>512</td>
<td>Assign Parameters to Alarm Logging</td>
</tr>
<tr>
<td>All</td>
<td></td>
<td>2703</td>
<td></td>
</tr>
</tbody>
</table>

Table 1

The minimum storage requirement depends on the configuration of S5 alarm logging. The following data blocks are also required.

*FIFO buffer (min.)* 
2 DB = 1024 bytes

*Transfer mailbox for WinCC*
1 DB = 512 bytes

512 bytes have to be allowed additionally for every offset and parameter data block.

Calculation of the exact size of the offset data blocks will follow in Section 5.2.4.1 Structure of offset data block, and that of the size of the parameter data block concerned in Section 5.2.4.10 Structure of the parameter data block.
5.2.2 Hardware requirements

The function blocks specified in Table 1 for S5 alarm logging require the following hardware for them to be executed correctly:

<table>
<thead>
<tr>
<th>PLC</th>
<th>CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>AG 115U</td>
<td>CPU 944 *, CPU 945</td>
</tr>
<tr>
<td>AG 135U</td>
<td>CPU 928B</td>
</tr>
<tr>
<td>AG 155U</td>
<td>CPU 946/ 947, CPU 948</td>
</tr>
</tbody>
</table>

Table 2
* Only the CPU 944 featuring two PU interfaces has a system clock.

These CPUs have an internal clock and are this in a position to provide the current date and time for construction of the message blocks. For every WinCC channel created, an up-to-date date/time message frame is read periodically to the SIMATIC S5 CPU. The internal clock of the SIMATIC S5 is synchronized with the WinCC system clock by means of function block FB 86 : MELD:UHR.
5.2.3 Embedding S5 alarm logging in the SIMATIC-S5 user program

To embed the SIMATIC S5 software for alarm logging in the SIMATIC S5 user program, perform the following steps:

Transfer all the blocks specified in the Table 1 from the file called WinCCST. SSD to the corresponding PLC.
If not already implemented by default or not yet available on the PLC, transfer the data handling blocks for the PLC concerned.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action: Embed alarm logging</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Transfer all the blocks specified in the Table 1 from the file called WinCCST. SSD to the corresponding PLC.</td>
</tr>
<tr>
<td>2</td>
<td>If not already implemented by default or not yet available on the PLC, transfer the data handling blocks for the PLC concerned.</td>
</tr>
<tr>
<td>3</td>
<td>Assign parameters to data block DB 80 as described in Section 5.2.6</td>
</tr>
<tr>
<td>4</td>
<td>Create data blocks for the send mailbox, the FIFO buffer, the message offset and, if necessary, the message parameters (refer to Section 5.2.4).</td>
</tr>
<tr>
<td>5</td>
<td>Initialize offset data blocks for the different message categories (refer to Section 5.2.4.1- idle condition, basic message number, etc.).</td>
</tr>
<tr>
<td>6</td>
<td>Specify process variables, job and batch identifier for the different messages in the user program (refer to Section 5.2.4.10).</td>
</tr>
<tr>
<td>7</td>
<td>Call the following blocks in the startup OBs (OB 20, OB 21, OB 22):</td>
</tr>
<tr>
<td></td>
<td>• SPA HTB : SYNCHRON (the data handling block of the CPU concerned)</td>
</tr>
<tr>
<td></td>
<td>SPA FB 81 : ANLAUFFB</td>
</tr>
<tr>
<td>8</td>
<td>Call the following blocks in OB 1:</td>
</tr>
<tr>
<td></td>
<td>• for periodic processing of messages SPA FB 80 : SYSTEMFB</td>
</tr>
<tr>
<td></td>
<td>• a user-created function block for transferring message blocks to the higher-level WinCC system (refer to Section 5.2.5.4)</td>
</tr>
<tr>
<td>9</td>
<td>Insert additional functions as described in the following sections:</td>
</tr>
<tr>
<td></td>
<td>• Synchronization of date and time by means of FB 86 : MELD:UHR (refer to Section 5.2.8).</td>
</tr>
</tbody>
</table>

Table 3
Figure 1
5.2.4 General description of S5 alarm loggings

A description is presented for the following components of S5 alarm logging:
- offset data block
- parameter data block
- message block
- FIFO buffer
- send mailbox
- system data block

Relationship between the different components:

Must be supplied with current data by the user application (process tags, batch number, job number)

Before the message acquisition system can monitor and acquire messages, they have to be configured in the corresponding data blocks. We distinguish between four categories of message:

<table>
<thead>
<tr>
<th>Category</th>
<th>Definition: Message Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Message without parameters</td>
</tr>
<tr>
<td>2</td>
<td>Message with process variables (2 DW)</td>
</tr>
<tr>
<td>3</td>
<td>Message with process variables (2 DWs) and job/batch identifier (3 DWs)</td>
</tr>
<tr>
<td>4</td>
<td>Message with process variables (2 DWs) and job/batch identifier (3 DWs) and reserve (3 DWs)</td>
</tr>
</tbody>
</table>

Table 4

For alarm logging, you can globally specify a date/time stamp for the construction of message blocks. If the date/time stamp is missing, the corresponding information is added by the WinCC system to the message blocks (refer to Section 5.2.4.11).
5.2.4.1 Structure of offset data block

The offset data block has an identical structure in all message categories. The corresponding data block address is specified for every message category required (refer to 5.2.4.1) in system data block DB 80.

Offset data block for corresponding message category:

<table>
<thead>
<tr>
<th>DW</th>
<th>Contents</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>DW 0</td>
<td>Not assigned</td>
<td>Head</td>
</tr>
<tr>
<td>DW 1</td>
<td>Basic message number</td>
<td></td>
</tr>
<tr>
<td>DW 2</td>
<td>Address of last signal condition block</td>
<td></td>
</tr>
<tr>
<td>DW 3</td>
<td>Not assigned</td>
<td></td>
</tr>
<tr>
<td>DW 4</td>
<td>Signal conditions of messages - bit No.</td>
<td>Signal condition block 1</td>
</tr>
<tr>
<td></td>
<td>15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0</td>
<td></td>
</tr>
<tr>
<td>DW 5</td>
<td>Idle condition bits</td>
<td></td>
</tr>
<tr>
<td>DW 6</td>
<td>Acknowledgement bits</td>
<td></td>
</tr>
<tr>
<td>DW 7</td>
<td>Edge trigger flags</td>
<td></td>
</tr>
<tr>
<td>DW 8</td>
<td>Signal conditions of messages - bit No.</td>
<td>Signal condition block 2</td>
</tr>
<tr>
<td></td>
<td>15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0</td>
<td></td>
</tr>
<tr>
<td>DW 9</td>
<td>Idle condition bits</td>
<td></td>
</tr>
<tr>
<td>DW 10</td>
<td>Acknowledgement bits</td>
<td></td>
</tr>
<tr>
<td>DW 11</td>
<td>Edge trigger flags</td>
<td></td>
</tr>
<tr>
<td>DW 12</td>
<td>Signal conditions of messages - bit No.</td>
<td>Signal condition block 3</td>
</tr>
<tr>
<td></td>
<td>15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0</td>
<td></td>
</tr>
<tr>
<td>DW 13</td>
<td>Idle condition bits</td>
<td></td>
</tr>
</tbody>
</table>

Table 5

The following items are described below:
- Basic message number
- Offset message number
- Signal condition block
- Address of last signal condition block
- Signal conditions
- Idle condition bits
- Acknowledgement bits
- Edge trigger flags
5.2.4.2 Basic message number

Every message is assigned a certain message number by means of which you can
distinguish between the messages that are issued. The message number consists of the basic
message number and an offset message number.
A different basic message number has to be specified for every message category you use.
Messages of same basic message number are numbered serially by means of the offset
message number.
The basic message number for the corresponding message category is specified in DW 1 of
the offset data block concerned (refer to 5.2.4.10).

Special case

When message category 1 is being used, two offset data blocks are possible. To achieve
serial message numbering for this message category, you have to enter the basic message
number of the second offset data block on the basic message number of the first offset data
block plus its message capacity (1008 messages).

Calculating the message number:
Message number = basic message number + offset message number

Example:

<table>
<thead>
<tr>
<th>Calculation</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Given:</td>
<td>Message category 1, serial message numbering starting at: message number 10000</td>
</tr>
<tr>
<td>Required:</td>
<td>Basic message number of the two offset data blocks</td>
</tr>
<tr>
<td>10000</td>
<td>Basic message number of the first offset data block</td>
</tr>
<tr>
<td>10000 + 1008</td>
<td>Basic message number of the second offset data block</td>
</tr>
</tbody>
</table>

5.2.4.3 Offset message number/signal conditions of messages

The signal conditions of messages are contained in the offset data blocks of the
corresponding message category at the bit position concerned of the offset message
number.
The offset message number of the corresponding message results starting at the 16 bits (bits
0-15) of DW 4. Serial numbering is performed in increments of four (DW8, DW12, etc.).

<table>
<thead>
<tr>
<th>Signal condition block</th>
<th>Signal Condition Block Starts at Data Word</th>
<th>Bit Number 0 - 15 Corresponds to Offset Message Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
<td>0 - 15</td>
</tr>
<tr>
<td>2</td>
<td>8</td>
<td>16 - 31</td>
</tr>
<tr>
<td>3</td>
<td>12</td>
<td>32 - 47</td>
</tr>
<tr>
<td>4</td>
<td>16</td>
<td>48 - 63</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>62</td>
<td>248</td>
<td>976 - 991</td>
</tr>
<tr>
<td>63</td>
<td>252</td>
<td>992 - 1007</td>
</tr>
</tbody>
</table>
Table 6

**Calculating the offset message number:**

- Offset message number = message number - basic message number
- Offset message number = (data word / 4 - 1) * 16 + bit No. (0-15)
- Offset message number = (signal condition block - 1) * 16 + bit No. (0-15)

**Calculating DB, DW, bit No. from the offset message number:**

- Data block = offset data block
- Data word = (offset message number / 16 + 1) * 4
- Bit No. = offset message number % 16

**In the case of message category 1, the length of a data word may be greater than 252, in which case the following applies:**

- Data block = offset data block + 1
- Data word = data word - 252
- Bit No. = Bit No.

**Example 1:**

Given: DW 248, bit 7, basic message number = 10000

Required: Message number

signal condition block = 248 / 4
= 62

offset message number = (signal condition block - 1) * 16 + bit number
= (62 - 1) * 16 + 7 - 983

Message number = basic message number + offset message number
= 10000 + 983 - 10983

The required message number is 10983.

**Example 2:**

Given: Message category 1 with two offset data blocks,
message number = 12000, basic message number = 10000

Required: DB, DW, bit No.

offset message number = message number - basic message number
= 12000 - 10000 - 2000

Bit No. = offset message number % 16 - 0

Data word = (offset message number / 16 + 1) * 4
= (2000 / 16 + 1) * 4 - 504

Data block = offset data block + 1

Data word = 504 - 252 - 252

Bit No. = 0

Message number 12000 will be found in the second offset data block of message category 1, data word 252, bit No. 0.
5.2.4.4 Signal condition block

The first signal condition block starts at data word address 4, the next signal condition blocks follow at intervals of 4 data words (DW 8, DW 12, etc.). Refer also to Table 5 and Table 6.

63 signal condition blocks are possible for every offset data block (signal condition blocks 1 to 63).

A signal condition block contains 16 signal conditions. There are thus 63 * 16 = 1008 messages possible in an offset data block.

Structure of signal condition block:

<table>
<thead>
<tr>
<th>DW</th>
<th>Bit number</th>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>signal conditions</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>Idle conditions</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>Acknowledgement bits</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>Edge trigger flags</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Table 7

Additional information on these four bit states is provided in this chapter.

Calculating the signal condition block concerned:

\[
\text{Signal Condition Block} = (\text{offset message number} / 16) + 1
\]

\[
\text{signal condition block} = \text{data word} / 4
\]

Calculating the data word which starts at the signal condition block concerned:

\[
\text{First data word of the signal condition block} = \text{signal condition block} \times 4
\]

5.2.4.5 Address of the last signal condition block

Specifying the DW address, the last signal condition block to be assigned messages specifies the number of possible messages of the corresponding message category.

Calculating the last signal condition block:

\[
\text{Last signal condition block} = \text{required messages in this message category} / 16
\]

```c
// Incompletely filled (16 messages) signal condition block
if ((required messages of this message category % 16) != 0) {
    ++ last signal message block;
}
```

With message category 1, a message volume of more than 1008 messages may occur, in which case the following applies:
1st offset DB:

Last signal condition block  =  63
Address of last signal condition block  =  63 * 4 – 252

2nd offset DB:

Last signal condition block  =  (required messages in this message category - 1008) / 16

// Incompletely filled (16 messages) signal condition block
if ( ((required messages in this message category - 1008) % 16) != 0 ) {
    ++ last signal message block;
}

Calculating the DW address of the last signal condition block:

DW address of last signal condition block  =  last signal condition block * 4

Example:

Given: 1030 messages of message category 1

1st offset DB:

Address of the last signal condition block  =  63 * 4 – 252

2nd offset DB:

Required messages - 1008  =  1030 - 1008 - 22
(Required messages - 1008) / 16  =  22 / 16 – 1
(Required messages - 1008) % 16  =  22 % 16 – 6
Last signal condition block  =  2
Address of last signal condition block  =  2 * 4 – 8

5.2.4.6 Signal conditions

Position: 1st data word of the signal condition block (refer to Table 5).

The user must make sure that the signal conditions of the corresponding messages are entered in the data words provided for them in the offset data blocks of the corresponding message category. This can be performed by the PLC by means of continual signal updating during the process.
5.2.4.7 Idle conditions

Position: 2nd data word of the signal condition block (refer to Table 5).

By the idle condition of a signal we mean the signal level in the passive operating state. This defines whether a signal (message) is active 'low' or 'high'. This information is required to find out whether a message is 'arriving' or 'departing'. If a change of event has the negated state with regard to the idle condition, it is a message which is 'arriving'. In the case of a 'departing' message, the state of the change of event is identical to that of the associated idle condition.

The idle conditions of messages has to be specified by the user at the corresponding positions.

5.2.4.8 Acknowledgement bits

Position: 3rd data word of the signal condition block (refer to Table 5).

Acknowledgement bits are not configured but evaluated within the current program. In this instance, the messages are acknowledged directly by the higher-level PC in accordance with the acknowledgement philosophy concerned. These message-related acknowledgements are sent by the PC to the PLC concerned with the associated configured messages of the integrated message acquisition system.

The corresponding acknowledgement bit is set one PLC cycle long by S5 alarm logging. The application program has to evaluate this information accordingly.

5.2.4.9 Edge-triggered flags

Position: 4th data word of the signal condition block (refer to Table 5).

The edge-triggered flags are used to determine any change of events which may have occurred (change of message). They are not configured but evaluated within S5 alarm logging.

5.2.4.10 Structure of the parameter data block

For message categories 2 to 4, it is necessary to configure parameter data blocks for additional data of the message concerned, in addition to an offset data block. The signal condition of a message is stored in the offset data block. The addresses of the parameter data blocks are stored in consecutive data blocks and are directly contiguous with the corresponding offset data blocks.
Relationship between the offset and parameter data block x

![Diagram showing the relationship between offset and parameter data block x](image)

Figure 3

<table>
<thead>
<tr>
<th>Category</th>
<th>Max. Number</th>
<th>Size of Parameter Block</th>
<th>No. of Blocks per Parameter DB</th>
<th>Max. No. of Parameter DBs</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1008 / 2016</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>1008</td>
<td>2 DW</td>
<td>128</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>1008</td>
<td>5 DW</td>
<td>51</td>
<td>20</td>
</tr>
<tr>
<td>4</td>
<td>1008</td>
<td>7 DW</td>
<td>36</td>
<td>28</td>
</tr>
</tbody>
</table>

Table 8

Calculating the number of parameter data blocks:

\[
\text{Number of Parameters Data Block} = \frac{\text{used Messages}}{\text{Number of parameter blocks per parameter data block}}
\]

When configuring, care must be taken to ensure that addresses do not overlap with data blocks of another message category and that the number of parameter data blocks can cope with any future upgrade.

A parameter data block contains parameter blocks which are assigned to the different messages. The parameter blocks are stored consecutively, starting with the parameter block for the first message of that message category, in the parameter data block. The parameter blocks are incremented consecutively beyond the borders of the parameter DB. On reaching the end of the parameter DB, the parameter block with the next number is continued from DW 0 onwards of the next parameter DB. Only whole parameter blocks are stored in the parameter data block.
Calculating the start address of a parameter block:

- **Offset message number** = message number - basic message number
- **Parameter DB** = offset DB + 1 + (offset message number / parameter blocks per parameter DB)
- **Start address of parameter DB** = (offset message number % parameter blocks per parameter DB) * size of parameter block

The user must ensure that the corresponding data (process variables, job number, batch identifier) are available at the appropriate address.

### 5.2.4.11 Message block structure

A message block that is sent to the higher-level WinCC system consists of several, consecutive data words. The data words contain message-specific information. The sum of the data words result in one message block. The size of the message blocks differs from message category to message category (refer to Table 10).

Irrespective of its message category, a message block always consists of at least two data words. These are the message number and the message status. Depending on whether the messages are date/time stamped (three data words) and have been provided with the appropriate parameters, a message block may be as many as 12 data words long.

<table>
<thead>
<tr>
<th>DW</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st DW</td>
<td>Message number</td>
</tr>
<tr>
<td>2nd DW</td>
<td>Message status</td>
</tr>
<tr>
<td>3rd DW</td>
<td>Time</td>
</tr>
<tr>
<td>4th DW</td>
<td>Time</td>
</tr>
<tr>
<td>5th DW</td>
<td>Date</td>
</tr>
<tr>
<td>6th DW</td>
<td>Process tag</td>
</tr>
<tr>
<td>7th DW</td>
<td>Process tag</td>
</tr>
<tr>
<td>8th DW</td>
<td>Job number</td>
</tr>
<tr>
<td>9th DW</td>
<td>Job number</td>
</tr>
<tr>
<td>10th DW</td>
<td>Batch identifier</td>
</tr>
<tr>
<td>11th DW</td>
<td>Reserve</td>
</tr>
<tr>
<td>12th DW</td>
<td>Reserve</td>
</tr>
</tbody>
</table>

Table 9

If messages are not date/time stamped, the three data words required for them at the end of the envisaged third to fifth positions of the block are not needed. The parameter data words are then attached without a gap to the status data word. The size of message blocks (number of DWs) varies from message category to message category and the desired date/time stamp and can be taken from Table 10.
Determining the message block length as a function of message category:

<table>
<thead>
<tr>
<th>Category</th>
<th>Message Block Length in DWs without Date and Time</th>
<th>Message Block Length in DWs with Date and Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td>10</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
<td>12</td>
</tr>
</tbody>
</table>

Table 10

5.2.4.12 Message number

Every message is assigned a certain message number by which it can be clearly identified.

5.2.4.13 Message status

The message status is structured as follows:

Table 11

5.2.4.14 Date/time stamp

The date and time are made available by function block FB 86 : MELD:UHR in binary code. Refer to Section 5.2.10 Purpose and function of S5-time synchronization.

5.2.4.15 Process variable

Two data words by means of which process variables can be detained upon the arrival of a message and passed to the process system.
5.2.4.16 Job number/batch identifier

Depending on the configuration, the first two data words have to be interpreted as a signed 32-bit binary number or as a total of four ASCII characters. The third data word has to be interpreted as two ASCII characters.
The current job number and the batch identifier can be passed to the WinCC system by means of these three data words upon the arrival of a message.

5.2.4.17 Reserve

The two reserve data words of message category 4 are intended for future add-ins but not yet implemented in the WinCC system.

5.2.4.18 Construction of a message block

After a message block has been detected, the corresponding message number is determined by the currently checked bit position and stored as the first data word of the message block in the FIFO buffer. Depending on the arriving or departing message, category and requirement for a date/time stamp, the corresponding status mask is selected and stored as the second data word of the message block in the FIFO buffer. If the corresponding bit in the system data block has been assigned parameters for a date/time stamp, the three words now follow which are available in system data block 80 from address DW 190 and thereafter in the required PC format. Depending on the message category, the associated parameter block is read, if necessary, from the corresponding data archive (parameter data block) and added to the last input to finish creating the message block in the FIFO buffer. The next status bit of the message that follows is then examined. This is performed until all parameterized messages have been processed.

5.2.4.19 The internal FIFO buffer

A FIFO buffer is a memory at the end of which its beginning follows once again - in other words, the memory area is literally connected like a ring. This results in the memory being limited in size, on the one hand, and not being finite owing to its restarting at the beginning, on the other.
This results in the message acquisition system, upon reaching the virtual end without extraction of the previous data (buffer is full), in the oldest data being overwritten by the most recent data, thus being lost as information.

The FIFO buffer in RAM acts, as its name suggests, as a buffer for the acquired messages before they are forwarded to the PC. In RAM, the FIFO buffer consists of a memory area of at least two data blocks and can, depending on parameter assignment, be made any size required as is allowed by the maximum permissible data blocks of a programmable controller and the remaining available DBs of the user program. The user passes to alarm logging the number of data blocks available to it for archiving.
With more than one data block, data blocks having consecutive DB numbers are imperative. Thus the user specifies the initial DB number and the number of the final DB of the buffer as parameters in the system DB. All data blocks whose values lie between the initial data block and the final data block (including the two data blocks) belong to the buffer as storage space.
5.2.4.20 The send mailbox - data transfer to the higher-level WinCC system

As a matter of principle, all message entries of a current cycle are written initially to the internal FIFO buffer of S5 alarm logging. The message entries - up to a maximum of the contents of one data block - are transferred to the message interface (send mailbox) upon completion of acquisition, providing the send mailbox is ready. The message interface, in the form of a data block, acts as a data source for the transfer function blocks (STEP 5 - data handling blocks). The data handling blocks form an interface to the corresponding communication processor for the process bus being used - for example, for the SINEC-H1 bus).

Send mailbox structure:

<table>
<thead>
<tr>
<th>DW</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>DW 0</td>
<td>Length of data block</td>
</tr>
<tr>
<td>DW 1</td>
<td>KY = [ PLC No. ], [ CPU No. ]</td>
</tr>
<tr>
<td>DW 2</td>
<td>KY = [ 0 ], [ number of messages ]</td>
</tr>
<tr>
<td>DW 3</td>
<td>Useful data start (message blocks)</td>
</tr>
</tbody>
</table>

Table 12

<table>
<thead>
<tr>
<th>DW 0 Length of the Data Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0</td>
</tr>
</tbody>
</table>

Triggering Edge Length of the Data Block

Table 13

From DW 0 of the send mailbox, it is first necessary to extract the triggering flank of a desired job by means of bit number 14 and, secondly, to determine the source data length from bits Nos. 0-8.

Since the data block which is required to be transferred must not be longer than 256 data words but only one number up to 255 can be represented with one byte, separate polling of the bytes using the commands DL and DR is not possible. We therefore recommend that DW 0 be transferred in an auxiliary flag. This also has the advantage that the enable bit can be evaluated separately and directly. This operation cannot be utilized when data words are being used.

If the condition is fulfilled, the bit which is used as an edge for one-shot triggering of a send job is reset. The remaining set bits then correspond to the transferred source data length and can be written to the data area of indirect parameter assignment as QLAЕ. Following a successfully completed WRITE request (SINEC-H1) to the WinCC system ('free of faults' (FOF)), DW 0 of the send mailbox has to be overwritten with the value '0'. This re-enables the send mailbox and further message blocks, to the extent present, can be transferred from the internal FIFO buffer to the send mailbox.

The WRITE request (SINEC-H1) has to be implemented by means of the SEND direct function and details will be found in the manual for the PLC concerned.
5.2.5 Interface description

Descriptions are provided for the following interfaces and blocks:

- system data block DB 80:
  For assigning parameters to S5 alarm logging.
- offset data block for the corresponding message category:
  Binary interface of the message signals to S5 alarm logging with specification of
  message characteristics.
- parameter data block for corresponding message category:
  For specifying additional message data of categories 2 through 4.
- Send mailbox:
  transfer interface to the WinCC system.

5.2.5.1 System data block 80

By using the system data block DB 80, it is possible to configure independent data areas for
four message categories, a FIFO memory and a send mailbox. Data words 0 through 20 in
DB 80 are earmarked for configuration.
A detailed description of data words 0 through 20 is presented in Section 5.2.6.

5.2.5.2 Offset data block

S5 alarm logging evaluates the signal conditions of the corresponding messages and
constructs the corresponding message blocks, if necessary.

The user has to make sure that

- the idle conditions of the individual messages are specified during configuration.
- the message states during the runtime of the S5 user program are written to the
  corresponding signal condition bits.
- the corresponding acknowledgement bits are read out and evaluated, as and when
  required.

5.2.5.3 Parameter data block

With message categories 2 through 4, additional information about the current state of the
system can be transferred by means of the message block.

The user has to make sure that

- upon the arrival of a message, the valid process variables (process value, job and batch
  numbers) are located in the corresponding parameter blocks.
5.2.5.4 Send mailbox/transfer mailbox

As soon as it contains message blocks, the send mailbox is transferred with a WRITE request (SINEC-H1) directly to the WinCC system (refer to Section 5.2.4.20).

The user has to make sure that

- the corresponding data handling blocks of the CPU concerned are available.
- during configuration of the WinCC system, appropriate communication channels are specified for process bus connection.
- a WRITE request, as described in Section 5.2.4.20, is initiated.
5.2.6 Assigning parameters to S5 alarm logging/system DB 80

Description of configurable data words of system data block DB 80:

<table>
<thead>
<tr>
<th>DW</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>DB address: internal FIFO start</td>
</tr>
<tr>
<td>1</td>
<td>DB address: internal FIFO end</td>
</tr>
<tr>
<td>2</td>
<td>0: without date and time 1: with date and time</td>
</tr>
<tr>
<td>3</td>
<td>DB offset for category 1 messages</td>
</tr>
<tr>
<td>4</td>
<td>1: a DB offset of category 1 2: two DB offsets of category 1</td>
</tr>
<tr>
<td>5</td>
<td>DB offset for category 2 messages</td>
</tr>
<tr>
<td>6</td>
<td>DB offset for category 3 messages</td>
</tr>
<tr>
<td>7</td>
<td>DB offset for category 4 messages</td>
</tr>
<tr>
<td>8</td>
<td>Reserve</td>
</tr>
<tr>
<td>9</td>
<td>Reserve</td>
</tr>
<tr>
<td>10</td>
<td>DB address: send mailbox CPU -&gt; PC</td>
</tr>
<tr>
<td>11</td>
<td>1: Acquisition optimized (ACOP)</td>
</tr>
<tr>
<td>12</td>
<td>ACOP from n messages onwards</td>
</tr>
<tr>
<td>13</td>
<td>PLC type (115 / 135 / 155)</td>
</tr>
<tr>
<td>14</td>
<td>Reserve (must be 1)</td>
</tr>
<tr>
<td>15</td>
<td>PLC No: 1 to 255; CPU No: 1 to 4</td>
</tr>
<tr>
<td>16</td>
<td>Reserve</td>
</tr>
<tr>
<td>17</td>
<td>Reserve</td>
</tr>
<tr>
<td>18</td>
<td>Reserve</td>
</tr>
<tr>
<td>19</td>
<td>Reserve</td>
</tr>
<tr>
<td>20</td>
<td>Parity error of the plausibility check</td>
</tr>
</tbody>
</table>

Table 14

**DW 0, DW 1: DB memory area of the internal FIFO buffer**

The internal FIFO buffer area for messages is defined by means of the two data words. The storage space must have a size of at least two data blocks and care must be taken to parameterize the FIFO end larger than the FIFO start. The memory area of the buffer memory results from the data block area limited by the FIFO start and FIFO end, including the two specified data blocks.

**Selecting FIFO buffer size:**

When the storage capacity of the FIFO buffer is reached, the oldest messages are overwritten. The number of DBs must be selected large enough so that, in the event of a torrent of messages occurring, no messages are overwritten before they could be paged out. To make sure that this does not occur, the following rule of thumb applies.
Determining the number of DBs in the FIFO buffer:
Messages per DB = (255 DW / DB) / message block length
Refer to Table 10

<table>
<thead>
<tr>
<th>Number of DBs</th>
<th>Number of Messages if a Message Overload occurs</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Messages per DB</td>
</tr>
</tbody>
</table>

For 'ACOP mode' of the message acquisition system, it is advisable to allow one or two data blocks more.

**DW 2: date and time identifier**
The option of date/time stamping messages refers to all messages assigned parameters. Either all the messages which have to be acquired are date/time stamped (DW2 = 1) or none (DW2 = 0). If DW2 = 0 is set, the WinCC system adds a date/time stamp to arriving message blocks.

**DW 3, DW 4: offset DB of message category 1**
If category 1 messages (messages without parameters and batch identifier) have to be configured, the address of the offset data block has to be specified in data word 3. The signal conditions of these messages have to be written consecutively by the PLC program in the data blocks specified at this point.

If more than 1008 1 messages (not more than 2016 messages) are planned, a further data block is enabled for category 1 messages by entering the figure '2' in data word 4. Referred to the address in DW 3, the second data block automatically has the next higher address. With a maximum of 1008 category 1 messages, a '1' is entered in DW 4.

**DW 5, DW 6, DW 7: offset DB of message categories 2, 3, 4**
Similar to DW 3, data words 5-7 contain the data block addresses concerned at which the signals of messages are stored.

DW 5 contains the address of the data block for message category 2, whereas DWs 6 and 7 contain the addresses for message categories 3 and 4, respectively.

If a message category is not used, a '0' has to be included in the DW concerned.

The addresses specified in DWs 5-7 are 'offset DBs'. Depending on the message category and the number of messages per category, they are assigned a corresponding number of 'secondary DBs'. The secondary DBs contain the parameters of the messages. For this reason, it is necessary to make sure, when assigning the offset DB addresses, that there is sufficient space (data blocks) for the parameter DBs between the previous offset DBs and the one to be specified.

Up to 1008 messages can be configured for message categories 2 through 4. When fully used, there is consequently a different number of 'secondary DBs' (parameter DBs) from offset DBs for the different categories (refer to Table 8).

**DW 10: message interface to higher-level WinCC system**
Parameters must always be assigned to data word 10, though the mode in which the message acquisition system has to operate is of no consequence. The DB address of the transfer mailbox is assigned in DW 10. The transfer mailbox acts as an interface between the SIMATIC S5 and the higher-level WinCC system.
**DW 11, DW 12: mode selection for optimum acquisition and corresponding number of messages**

Two operating modes are provided:

- '0' in DW 11 -> 'Normal Mode' of the message acquisition system
- '1' in DW 11 -> 'Optimum Acquisition Mode' of the message acquisition system

**Normal Mode:**

As many acquired messages are paged out to be sent in the course of a cycle from the internal buffer as the message interface can handle, provided that it is prepared to accept data.

Very large numbers of messages within any cycle or successive cycles will result in this process having a relatively high cycle time. The larger the message categories involved, the longer the cycle time. In this instance, acquisition of message blocks involves more effort and takes longer.

**Optimized acquisition:**

With the messages that are issued, chronological acquisition has priority over sending to the PC. Attention is focused on the relative time between the messages issued by the system. The fact that messages might arrive at the PC a few milliseconds later is of secondary importance. The inertia of the human eye and the receptivity of an observer in the control room are decisive for that.

In order to reduce the cycle time of the message acquisition system in such time-critical instances, the option of running this system at 'optimized acquisition operation' has been introduced. The minimum number of messages issued within an OB1 cycle has to be specified in DW 12. If the number of messages exceeds this minimum number during the current OB1 cycle, the messages are only acquired and buffered. They are not paged out or subsequently sent to a communication peer in this OB1 cycle.

**DW 15: PLC/CPU number**

This data word is required for constructing the message frame head and needs specification of the project-related PLC and CPU numbers of that programmable controller. The CPU number is particularly important when several CPUs are operating in a single PLC. Only in conjunction with the data word containing the ID for the messages can the higher-level WinCC system interpret sent data as a message which assign message-specific message texts and evaluate them accordingly.

The only data word to have S5 data format 'KY’ during configuration is DW 15. This means that two bytes can be presented separately (separated by a comma). The left byte contains the PLC number, which may be between 1 and 255. The CPU number, which may be between 1 and 4, is specified in the right byte.
Example:

\[ \begin{align*}
    KY & = 10,2 \\
    PLC \ number & = 10 \\
    CPU \ number & = 2
\end{align*} \]

**DW 20 : parameter assignment errors**

A plausibility check is performed on all the data words assigned parameters in the system DB upon start-up of S5 alarm logging. During the check, differentiation is made between exceeding possible ranges of values, overlappings and multiple assignment of data blocks to which parameters have been assigned and missing details.

An output parameter in data word format, this function block has a PAFE word (Parameter Error word); it is similar to the system-specific data handling blocks. The status of the PAFE word can be taken from system DB 80 (DW 20). The PAFE word can be examine for errors which may have occurred following the program return from FB 81. Following that, suitable action can be taken.

It is practical to have the programmable controller 'jump' to Stop status in the event of a PAFE word other than zero. If the PAFE word is ignored, the program cannot be guaranteed to run without errors.

**Evaluating the PAFE word**

If the program or PLC is brought to its Stop status, in accordance with the recommendation, following the occurrence of an error (PAFE word \( \neq 0 \)), the error can be specifically analyzed and rectified by means of the error number. The table below provides information on the type of error caused during parameter assignment.

**Format of PAFE word:**

\[ KY = error \ number, \ group \ error \ ID \]

**Example:**

\[ KY = 9,1 \]

The parameter assignment error having the number 9 corresponds to:

Offset DB addr. of category 1 is larger than the maximum permissible DB address.

<table>
<thead>
<tr>
<th>Error No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start DB of internal buffer not defined</td>
</tr>
<tr>
<td>2</td>
<td>Start DB of internal buffer has the same address as the system DB ('80')</td>
</tr>
<tr>
<td>3</td>
<td>Start DB address of internal buffer larger than maximum permissible DB address</td>
</tr>
<tr>
<td>4</td>
<td>End DB of internal buffer has the same address as the system DB ('80')</td>
</tr>
<tr>
<td>5</td>
<td>End DB address is smaller than start DB address of internal buffer</td>
</tr>
<tr>
<td>6</td>
<td>End DB address of internal buffer larger than maximum permissible DB address</td>
</tr>
<tr>
<td>7</td>
<td>Offset DB of category 1 has the same address as the system DB ('80')</td>
</tr>
<tr>
<td>Error No.</td>
<td>Meaning</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>8</td>
<td>Offset DB addr. of category 1 is within the internal buffer area</td>
</tr>
<tr>
<td>9</td>
<td>Offset DB addr. of category 1 is larger than the maximum permissible DB address.</td>
</tr>
<tr>
<td>10</td>
<td>Offset DB of category 2 has the same address as the system DB ('80')</td>
</tr>
<tr>
<td>11</td>
<td>Offset DB of category 2 has the same address as that of category 1</td>
</tr>
<tr>
<td>12</td>
<td>Offset DB of category 2 has the same address as the 2nd offset DB of category 1</td>
</tr>
<tr>
<td>13</td>
<td>Offset DB addr. of category 2 is within the internal buffer area</td>
</tr>
<tr>
<td>14</td>
<td>Offset DB addr. of category 2 is larger than the maximum permissible DB address.</td>
</tr>
<tr>
<td>15</td>
<td>Offset DB of category 3 has the same address as the system DB ('80')</td>
</tr>
<tr>
<td>16</td>
<td>Offset DB of category 3 has the same address as that of category 1</td>
</tr>
<tr>
<td>17</td>
<td>Offset DB of category 3 has the same address as the 2nd offset DB of category 1</td>
</tr>
<tr>
<td>18</td>
<td>Offset DB of category 3 has the same address as that of category 2</td>
</tr>
<tr>
<td>19</td>
<td>Offset DB addr. of category 3 is within the internal buffer area</td>
</tr>
<tr>
<td>20</td>
<td>Offset DB addr. of category 3 is larger than the maximum permissible DB address.</td>
</tr>
<tr>
<td>21</td>
<td>Offset DB of category 4 has the same address as the system DB ('80')</td>
</tr>
<tr>
<td>22</td>
<td>Offset DB of category 4 has the same address as that of category 1</td>
</tr>
<tr>
<td>23</td>
<td>Offset DB of category 4 has the same address as the 2nd offset DB of category 1</td>
</tr>
<tr>
<td>24</td>
<td>Offset DB addr. of category 4 is within the internal buffer area</td>
</tr>
<tr>
<td>25</td>
<td>Offset DB addr. of category 4 is larger than the maximum permissible DB address.</td>
</tr>
<tr>
<td>26</td>
<td>Offset DB of category 4 has the same address as that of category 2</td>
</tr>
<tr>
<td>27</td>
<td>Offset DB of category 4 has the same address as that of category 3</td>
</tr>
<tr>
<td>28</td>
<td>The PC send mailbox has the same address as the system DB ('80')</td>
</tr>
<tr>
<td>29</td>
<td>The PC send mailbox is not defined ('0')</td>
</tr>
<tr>
<td>30</td>
<td>PC send mailbox addr. within internal buffer area</td>
</tr>
<tr>
<td>31</td>
<td>PC send mailbox addr. larger than maximum permissible DB address</td>
</tr>
<tr>
<td>32</td>
<td>The PC send mailbox has the same address as the offset DB of category 1</td>
</tr>
<tr>
<td>33</td>
<td>The PC send mailbox has the same address as the offset DB of category 2</td>
</tr>
<tr>
<td>34</td>
<td>The PC send mailbox has the same address as the offset DB of category 3</td>
</tr>
<tr>
<td>35</td>
<td>The PC send mailbox has the same address as the offset DB of category 4</td>
</tr>
<tr>
<td>36</td>
<td>The PC send mailbox has the same address as the 2nd offset DB of category 1</td>
</tr>
<tr>
<td>37</td>
<td>Reserve DW 9 and/or reserve DW 10 not equal to 0</td>
</tr>
<tr>
<td>38</td>
<td>Reserve DW 9 and/or reserve DW 10 not equal to 0</td>
</tr>
<tr>
<td>39</td>
<td>Reserve DW 9 and/or reserve DW 10 not equal to 0</td>
</tr>
<tr>
<td>40</td>
<td>Reserve DW 9 and/or reserve DW 10 not equal to 0</td>
</tr>
<tr>
<td>41</td>
<td>Reserve DW 9 and/or reserve DW 10 not equal to 0</td>
</tr>
<tr>
<td>Error No.</td>
<td>Meaning</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>42</td>
<td>Reserve DW 9 and/or reserve DW 10 not equal to 0</td>
</tr>
<tr>
<td>43</td>
<td>Reserve DW 9 and/or reserve DW 10 not equal to 0</td>
</tr>
<tr>
<td>44</td>
<td>Reserve DW 9 and/or reserve DW 10 not equal to 0</td>
</tr>
<tr>
<td>45</td>
<td>Reserve DW 9 and/or reserve DW 10 not equal to 0</td>
</tr>
<tr>
<td>46</td>
<td>Reserve DW 9 and/or reserve DW 10 not equal to 0</td>
</tr>
<tr>
<td>47</td>
<td>Number of messages for the minimum limit of the selected operating mode with optimum acquisition is missing</td>
</tr>
<tr>
<td>48</td>
<td>PLC type is not defined</td>
</tr>
<tr>
<td>49</td>
<td>Reserve DW 14 not equal to 1</td>
</tr>
<tr>
<td>50</td>
<td>PLC No. for message frame head is not defined</td>
</tr>
<tr>
<td>51</td>
<td>CPU No. for message frame head is not defined</td>
</tr>
<tr>
<td>52</td>
<td>CPU No. is larger than allowed (1 to 4)</td>
</tr>
</tbody>
</table>

Table 15
5.2.7 S5 alarm logging configuration example

Description

S5 alarm logging is required to be configured for the following message categories:

<table>
<thead>
<tr>
<th>Category</th>
<th>Definition: Message Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1200 messages (from message number 10000 through 11199)</td>
</tr>
<tr>
<td></td>
<td>Messages 11000 through 11199 are 'low active'</td>
</tr>
<tr>
<td>2</td>
<td>No messages planned</td>
</tr>
<tr>
<td>3</td>
<td>11 messages (from message number 30000 through 30010)</td>
</tr>
<tr>
<td>4</td>
<td>No messages planned</td>
</tr>
</tbody>
</table>

All messages are to be date/time stamped.
A 135U, PLC No. 1, CPU No. 1 are in use.

5.2.7.1 Parameter assignment DB 80

<table>
<thead>
<tr>
<th>Category</th>
<th>Max. Number</th>
<th>Size of Parameter Block</th>
<th>No. of Blocks per Parameter DB</th>
<th>Max. No. of Parameter DBs</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1008 / 2016</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>1008</td>
<td>2 DW</td>
<td>128</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>1008</td>
<td>5 DW</td>
<td>51</td>
<td>20</td>
</tr>
<tr>
<td>4</td>
<td>1008</td>
<td>7 DW</td>
<td>36</td>
<td>28</td>
</tr>
</tbody>
</table>

DB 81 is used as the PC send mailbox.

With a uniform occurrence of the existing messages, the average message block length (with date and time) is:

\[
\frac{1200 \times 5 + 11 \times 10}{1200 + 11} = 5.04
\]

Assumption:
S5 alarm logging is required to accommodate a messages overload of 100 messages in one PLC cycle and to operate at 30 messages or more in 'Optimum Acquisition mode'.

5 DW/mess. * 100 mess. = 500 DWs
\[
\frac{500 \text{ DW}}{256 \text{ DW/DB}} = 1.95 \text{ DBs}
\]

There therefore results four data blocks for the FIFO buffer, since one or two additional data blocks have to be allowed for 'Optimum Acquisition mode'.
The FIFO buffer starts at data block address 82 and thus the end address of the FIFO buffer is DB 85.

To provide a reserve for any future upgrade of the FIFO buffer, the offset data block of category 1 is in DB 88 and DB 89 (more than 1008 category 1 messages).

DB 90 becomes the offset data block of message category 3. A parameter DB of message category 3 can accommodate 51 parameter blocks; if the 11 blocks used are subtracted, this
results in an upgradability 40 category 3 messages with only one parameter data block (DB 91).

<table>
<thead>
<tr>
<th>DW</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>DB address: internal FIFO start</td>
<td>82</td>
</tr>
<tr>
<td>1</td>
<td>DB address: internal FIFO end</td>
<td>85</td>
</tr>
<tr>
<td>2</td>
<td>0: without date and time</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1: with date and time</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>DB offset for category 1 messages</td>
<td>88</td>
</tr>
<tr>
<td>4</td>
<td>1: one DB offset of category 1</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>2: two DB offsets of category 1</td>
<td>2</td>
</tr>
<tr>
<td>5</td>
<td>DB offset for category 2 messages</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>DB offset for category 3 messages</td>
<td>90</td>
</tr>
<tr>
<td>7</td>
<td>DB offset for category 4 messages</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>Reserve</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>Reserve</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>DB address: send mailbox CPU -&gt; PC</td>
<td>81</td>
</tr>
<tr>
<td>11</td>
<td>1: Acquisition optimized (ACOP)</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>ACOP from n messages onwards</td>
<td>30</td>
</tr>
<tr>
<td>13</td>
<td>PLC type (115 / 135 / 155)</td>
<td>135</td>
</tr>
<tr>
<td>14</td>
<td>Reserve</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>PLC No: 1 to 255; CPU No: 1 to 4</td>
<td>1, 1</td>
</tr>
<tr>
<td>16</td>
<td>Reserve</td>
<td>0</td>
</tr>
<tr>
<td>17</td>
<td>Reserve</td>
<td>0</td>
</tr>
<tr>
<td>18</td>
<td>Reserve</td>
<td>0</td>
</tr>
<tr>
<td>19</td>
<td>Reserve</td>
<td>0</td>
</tr>
<tr>
<td>20</td>
<td>Parity error of the plausibility check</td>
<td>0</td>
</tr>
</tbody>
</table>

Data block 100 is used by DW 10 through DW 20 to synchronize the time.
Data block 101 is used by DW 0 through DW 255 for receiving commands.

5.2.7.2 Creating data blocks

Create data blocks DB 81 - DB 85, DB 88 - DB 91 and DB 101 of DW 0 - DW 255.
Create data block DB 100 of DW 0 - DW 20.
5.2.7.3 Initializing offset data blocks

**Message category 1**
DB 88 and DB 89 are provided for message category 1. DB 88 contains the messages numbered 10000 through 11007, and DB 89 the messages numbered 11008 through 11199. A total of 1200 category 1 messages have to be configured.

See Chapter 5.2 Address of the last signal condition block.
Offset message number = message number - basic message number = 0 through 1199

1st offset DB:
address of last signal condition block: DW 252

2nd offset DB:
address of last signal condition block: DW 252

\[
\begin{align*}
1200 & - 1008 = 192 \\
192 / 16 & = 12 \\
192 \% 16 & = 0
\end{align*}
\]

*Address of the last signal condition block in offset data block 2* = \(12 \times 4 - 48\)

**DB 88:**

<table>
<thead>
<tr>
<th>DW</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DW 0</td>
<td>Not assigned</td>
<td></td>
</tr>
<tr>
<td>DW 1</td>
<td>Basic message number</td>
<td>10000</td>
</tr>
<tr>
<td>DW 2</td>
<td>Address of last DW</td>
<td>252</td>
</tr>
<tr>
<td>DW 3</td>
<td>Not assigned</td>
<td></td>
</tr>
</tbody>
</table>

**DB 89:**

<table>
<thead>
<tr>
<th>DW</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DW 0</td>
<td>Not assigned</td>
<td></td>
</tr>
<tr>
<td>DW 1</td>
<td>Basic message number</td>
<td>11018</td>
</tr>
<tr>
<td>DW 2</td>
<td>Address of last DW</td>
<td>48</td>
</tr>
<tr>
<td>DW 3</td>
<td>Not assigned</td>
<td></td>
</tr>
</tbody>
</table>

See Chapter 5.2.4.3 Offset message number/signal conditions of messages.

Messages 11000 through 11199 are 'low active'.
Position of the idle condition bit of message number 11000:
Offset message number: 11000 - 10000 - 1000
Start of signal condition block: (offset message number / 16 + 1) * 4 -
Data word of the idle condition bit: DW 253
Data bit: offset message number % 16 - 8
Data block: offset data block - DB 88

Position of the idle condition bit of message number 11000:
Offset message number: 11199 - 10000 - 1199
Start of signal condition block: (offset message number / 16 + 1) * 4 -
300 - 252 = 48
Data word of the idle condition bit: DW 49
Data bit: offset message number % 16 - 15
Data block: offset data block + 1 - DB 89

The following idle condition bits have to be modified:

DB 88:
DW 253: set data bits 8 through 15 to '1'

DB 89:
DW 5, DW 9, DW 13, through DW 49: set data bits 0 through 15 to '1'

Message category 3
For message category 3, DB 90 is provided as the offset data block with messages 30000 through 30010, and DB 91 as the parameter data block.
A total of 11 category 3 messages have to be configured.
See Chapter 5.2.4.10 Structure of the parameter data block.

Offset Message No. = Message No. - Basic Message No. = 0 through 10

Offset DB:

Address of the last signal condition block
Address of last signal condition block
11 / 16 - 0
11 % 16 = 11
(0+1) * 4 = 4
DB 89:

<table>
<thead>
<tr>
<th>DW</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DW 0</td>
<td>Not assigned</td>
<td></td>
</tr>
<tr>
<td>DW 1</td>
<td>Basic message number</td>
<td>30000</td>
</tr>
<tr>
<td>DW 2</td>
<td>Address of last DW</td>
<td>4</td>
</tr>
<tr>
<td>DW 3</td>
<td>Not assigned</td>
<td></td>
</tr>
</tbody>
</table>

All idle condition bits are '0'.
See Chapter 5.2.4.10 Structure of the parameter data block

Parameter DB = offset DB + 1 + (offset message number / parameter blocks per parameter DB)

**Message number 30000:**
Parameter DB = 90 + 1 + 0 / 51 = 91

**Message number 30010:**
Parameter DB = 90 + 1 + 10 / 51 = 91

Start address of the parameter block concerned = (offset message number % parameter blocks per parameter DB) * size of parameter block

**Message number 30000:**
Start address of the parameter block concerned = (0 % 51) * 5 = DW

**Message number 30010:**
Start address of the parameter block concerned = (10 % 51) * 5 = DW 50

**DB 91: parameter data block 91 for offset data block 90**

<table>
<thead>
<tr>
<th>Message number</th>
<th>Process Values</th>
<th>Job number</th>
<th>Batch identifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>30000</td>
<td>DW 0, 1</td>
<td>DW 2, 3</td>
<td>DW 4</td>
</tr>
<tr>
<td>30001</td>
<td>DW 5, 6</td>
<td>DW 7, 8</td>
<td>DW 9</td>
</tr>
<tr>
<td>30002</td>
<td>DW 10, 11</td>
<td>DW 12, 13</td>
<td>DW 14</td>
</tr>
<tr>
<td>30003</td>
<td>DW 15, 16</td>
<td>DW 17, 18</td>
<td>DW 19</td>
</tr>
<tr>
<td>30004</td>
<td>DW 20, 21</td>
<td>DW 22, 23</td>
<td>DW 24</td>
</tr>
<tr>
<td>30005</td>
<td>DW 25, 26</td>
<td>DW 27, 28</td>
<td>DW 29</td>
</tr>
<tr>
<td>30006</td>
<td>DW 30, 31</td>
<td>DW 32, 33</td>
<td>DW 34</td>
</tr>
<tr>
<td>30007</td>
<td>DW 35, 36</td>
<td>DW 37, 38</td>
<td>DW 39</td>
</tr>
<tr>
<td>30008</td>
<td>DW 40, 41</td>
<td>DW 42, 43</td>
<td>DW 44</td>
</tr>
<tr>
<td>30009</td>
<td>DW 45, 46</td>
<td>DW 47, 48</td>
<td>DW 49</td>
</tr>
<tr>
<td>30010</td>
<td>DW 50, 51</td>
<td>DW 52, 53</td>
<td>DW 54</td>
</tr>
</tbody>
</table>
5.2.8 Documentation of the SIMATIC S5 command blocks

Purpose and function of S5 command blocks

The software is used to process bits, bytes, words and double words in the SIMATIC S5 over a process bus - for example, SINEC H1. Only byte and word values in the SIMATIC S5 can be addressed over the process bus.

By default, the following operations can be executed:

• Data blocks (DB and DX), timers and counters have to be changed only as words.
• Bit memories, inputs, outputs, I/O (P and Q) have to be changed only as bytes.

The program package provides the requisite software functionality within the SIMATIC S5 to implement the following operations on the WinCC system over the given process bus.

• Set an initializing pulse for one OB1 cycle
• Set, reset, invert the bit in DB/DX
• Set, reset, invert the bit in bit memory
• Write left/right bytes to DB/DX
• Write word/double word to DB/DX
• Write byte/word to bit memory
• Write byte/word to I/O
• Write byte/word to upgraded I/O

The required changes in the SIMATIC S5 are made available as a raw data tag by the WinCC Control Center across a data interface. The instructions have to be sent to the S5 by means of a raw data tag. These instructions are evaluated directly in the S5 by instruction interpreter FB 87: EXECUTE and executed.

The present manual describes the use and handling of S5 command blocks in a SIMATIC S5 environment. The user is provided with an overview of the function and data blocks used by the software, and the storage space required. There follows a detailed interface description of the existing data interface. An example configuration is presented to help you.

5.2.8.1 List of software blocks

The 'S5 command blocks' SIMATIC S5 software will be found on the WinCC CD in the file called WINCC1ST.S5D.

The file contains the following function blocks for the S5 command blocks:

<table>
<thead>
<tr>
<th>FB</th>
<th>Name</th>
<th>Size in Bytes</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB 87</td>
<td>Execute</td>
<td>152</td>
<td>Enables bit, byte, word and double word manipulation over the process bus</td>
</tr>
<tr>
<td>FB 88</td>
<td>OPCODE</td>
<td>399</td>
<td>Called by FB 87</td>
</tr>
<tr>
<td>All</td>
<td></td>
<td>551</td>
<td></td>
</tr>
</tbody>
</table>

Table 16

In addition, a 512-byte command data block is also required.
5.2.8.2 Hardware requirements

The function blocks specified in Table 16 require the following hardware for them to be executed correctly:

<table>
<thead>
<tr>
<th>PLC</th>
<th>CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>AG 115U</td>
<td>CPU 943, CPU 944, CPU 945</td>
</tr>
<tr>
<td>AG 135U</td>
<td>CPU 928A, CPU 928B</td>
</tr>
<tr>
<td>AG 155U</td>
<td>CPU 946/ 947, CPU 948</td>
</tr>
</tbody>
</table>

5.2.8.3 Call parameters of FB 87: EXECUTE

A description of the call parameters of function block **FB 87 : EXECUTE** is presented in the following.

<table>
<thead>
<tr>
<th>Name</th>
<th>Execute</th>
<th>Parameters</th>
</tr>
</thead>
</table>

**DBNR:** Data block number of the command transfer interface

**DBDX:** Type of data source for the command transfer interface

DB.......Data source for a data block (DB).

DX.......Data source for an extended data block (DX).

**RIMP:** Bit position for the initializing pulse

RIMP.......Bit memory number, bit number
5.2.9 Interface description

Descriptions are provided for the following interfaces and blocks:
- command function block FB 87
- command data block: instruction transfer interface to the SIMATIC S5.

In the SIMATIC S5, the instruction interpreter (FB 87: EXECUTE) is called periodically in OB 1. The type and address of the command DBs are transferred as parameters. When a command is queued, the Op code and four parameters are forwarded to FB 88: OPCODE and executed directly. After an instruction has been executed, the command counter (DW 1) is decremented by one. The process of instruction transfer and decrementing of the command counter is repeated until all queued instructions have been processed.

Details of the type and address of the data block have to agree in both the WinCC Control Center and S5 program, and the data block has to be present in the S5. A DB data block and a DX data block and their addresses - for instance, DX 234 - are available to choose from. The data block has to be opened by the user up to data word 255, since data words 0 - 255 can be addressed in the data block specified.

The following syntax has been defined for the commands stored in the command data block:

<table>
<thead>
<tr>
<th>DW</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>Number of commands to be executed</td>
</tr>
<tr>
<td>2</td>
<td>Op code of the first command</td>
</tr>
<tr>
<td>3</td>
<td>Parameter 1 (Op code 1)</td>
</tr>
<tr>
<td>4</td>
<td>Parameter 2 (Op code 1)</td>
</tr>
<tr>
<td>5</td>
<td>Parameter 3 (Op code 1)</td>
</tr>
<tr>
<td>6</td>
<td>Parameter 4 (Op code 1)</td>
</tr>
<tr>
<td>7</td>
<td>Op code of the second command</td>
</tr>
<tr>
<td>8</td>
<td>Parameter 1 (Op code 2)</td>
</tr>
<tr>
<td>9</td>
<td>Parameter 1 (Op code 2)</td>
</tr>
<tr>
<td>10</td>
<td>Parameter 2 (Op code 2)</td>
</tr>
<tr>
<td>11</td>
<td>Parameter 3 (Op code 2)</td>
</tr>
<tr>
<td>12</td>
<td>Parameter 4 (Op code 2)</td>
</tr>
<tr>
<td>13</td>
<td>Op code of the third command</td>
</tr>
<tr>
<td>14</td>
<td>Parameter 1 (Op code 3)</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
</tr>
</tbody>
</table>

The syntax of the implemented commands are described in the following:
Transfer of Op code and parameters to the command DB

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Op code</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Parameter 3</th>
<th>Parameter 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set bit in DB</td>
<td>10</td>
<td>DB</td>
<td>DW</td>
<td>Bit</td>
<td>-</td>
</tr>
<tr>
<td>Reset bit in DB</td>
<td>11</td>
<td>DB</td>
<td>DW</td>
<td>Bit</td>
<td>-</td>
</tr>
<tr>
<td>Invert bit in DB</td>
<td>12</td>
<td>DB</td>
<td>DW</td>
<td>Bit</td>
<td>-</td>
</tr>
<tr>
<td>Set right byte in DB</td>
<td>15</td>
<td>DB</td>
<td>DW</td>
<td>Value</td>
<td>-</td>
</tr>
<tr>
<td>Set left byte in DB</td>
<td>16</td>
<td>DB</td>
<td>DW</td>
<td>Value</td>
<td>-</td>
</tr>
<tr>
<td>Write data word to DB</td>
<td>17</td>
<td>DB</td>
<td>DW</td>
<td>Value</td>
<td>-</td>
</tr>
<tr>
<td>Write double word to DB</td>
<td>18</td>
<td>DB</td>
<td>DW</td>
<td>Value</td>
<td>Value</td>
</tr>
<tr>
<td>Set bit in DX</td>
<td>20</td>
<td>DX</td>
<td>DW</td>
<td>Bit</td>
<td>-</td>
</tr>
<tr>
<td>Reset bit in DX</td>
<td>21</td>
<td>DX</td>
<td>DW</td>
<td>Bit</td>
<td>-</td>
</tr>
<tr>
<td>Invert bit in DX</td>
<td>22</td>
<td>DX</td>
<td>DW</td>
<td>Bit</td>
<td>-</td>
</tr>
<tr>
<td>Set right byte in DX</td>
<td>25</td>
<td>DX</td>
<td>DW</td>
<td>Value</td>
<td>-</td>
</tr>
<tr>
<td>Set left byte in DX</td>
<td>26</td>
<td>DX</td>
<td>DW</td>
<td>Value</td>
<td>-</td>
</tr>
<tr>
<td>Write data word to DX</td>
<td>27</td>
<td>DX</td>
<td>DW</td>
<td>Value</td>
<td>-</td>
</tr>
<tr>
<td>Write double word to DX</td>
<td>28</td>
<td>DX</td>
<td>DW</td>
<td>Value</td>
<td>Value</td>
</tr>
<tr>
<td>Set memory bit</td>
<td>30</td>
<td>MB</td>
<td>Bit</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Reset memory bit</td>
<td>31</td>
<td>MB</td>
<td>Bit</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Invert memory bit</td>
<td>32</td>
<td>MB</td>
<td>Bit</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Write memory byte</td>
<td>35</td>
<td>MB</td>
<td>Value</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Write memory word</td>
<td>36</td>
<td>MW</td>
<td>Value</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Write I/O byte</td>
<td>45</td>
<td>PB</td>
<td>Value</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Write I/O word</td>
<td>46</td>
<td>PW</td>
<td>Value</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Write extended I/O byte</td>
<td>55</td>
<td>QB</td>
<td>Value</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Write extended I/O word</td>
<td>56</td>
<td>QW</td>
<td>Value</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Set initializing pulse</td>
<td>60</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
5.2.10 Purpose and function of S5-time synchronization

The present document describes the functions and properties of the SIMATIC S5 software:

S5 time synchronization

The software is used to synchronize the SIMATIC S5 system clock. Further, it supplies a suitable date/time data format for creating the message blocks to ‘chronological message acquisition’ of S5 alarm logging.

Function block **FB 86: MELD:UHR** also makes available the current time of day in a format required by ‘chronological message acquisition’. The data are made available in system data block 80 from DW 190 onwards.

If a change to a message signal condition occurs, the message is identified by means of its message number by function block **FB 80: SYSTEMFB** and stamped with the current date and time from system data block 80.

The present manual describes the use and handling of S5 time synchronization in a SIMATIC S5 environment. The user is provided with an overview of the function and data blocks used by the software, and the storage space required. An example configuration is presented to help you.

5.2.10.1 List of software blocks

The SIMATIC S5 software (S5 time synchronization) will be found on the WinCC CD in the file called WINCC1ST.S5D.

The file contains the following function and data blocks:

<table>
<thead>
<tr>
<th>FB</th>
<th>Name</th>
<th>Size in Bytes</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB 86</td>
<td>MELD:UHR</td>
<td>1135</td>
<td>Synchronization of time</td>
</tr>
<tr>
<td>All</td>
<td></td>
<td>1135</td>
<td></td>
</tr>
</tbody>
</table>

Table 17

- Clock data area 115U: 27 DWs = 54 bytes
- Clock data area 135U/155U: 12 DWs = 24 bytes
- Data area for S5 alarm logging: 3 DWs = 6 bytes

5.2.10.2 Hardware requirements

The function blocks specified for S5 alarm logging require the following hardware for them to be executed correctly:

<table>
<thead>
<tr>
<th>PLC</th>
<th>CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>AG 115U</td>
<td>CPU 944 *, CPU 945</td>
</tr>
<tr>
<td>AG 135U</td>
<td>CPU 928B</td>
</tr>
<tr>
<td>AG 155U</td>
<td>CPU 946/ 947, CPU 948</td>
</tr>
</tbody>
</table>

* Only the CPU 944 featuring two PU interfaces has a system clock
5.2.11 Call parameters of FB 86 : MELD:UHR

A description of the call parameters of function block FB 86 : MELD:UHR is presented in the following.

A description of the call parameters of function block FB 87 : EXECUTE is presented in the following.

<table>
<thead>
<tr>
<th>Name</th>
<th>MELD:UHR</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID: DCF7</td>
<td>E/A/D/B/T/Z: D KM/KH/KY/KC/KF/KT/KZ/KG: KF</td>
<td></td>
</tr>
</tbody>
</table>

CPUT:

<table>
<thead>
<tr>
<th>No. of CPU</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CPU 943 / CPU 944</td>
</tr>
<tr>
<td>2</td>
<td>CPU 945</td>
</tr>
<tr>
<td>3</td>
<td>CPU 928B</td>
</tr>
<tr>
<td>4</td>
<td>CPU 946 / 947</td>
</tr>
<tr>
<td>5</td>
<td>CPU 948</td>
</tr>
</tbody>
</table>

DCF7:

Operating mode
0 = operation with S5 system clock
1 = operation with DCF77 radio clock

QTYP:

Type of data source for the time synchronization message frame.
0 = data source is a data block (DB)
1 = data source is an extended data block (DX)
QSYN:

**Data source of time data**
- DCF7 = 0: QSYN = DB number, DW number of the received time synchronization message frame
- DCF7 = 1: QSYN = DB number, DW number of the DCF77 - Time

UDAT:

**Address of clock data area**
- UDAT = DB number, DW number

ZINT:

Time interval in minutes for sending the synchronization message frame (DCF7 = 1)

ZUHR:

**Destination data area for time data in alarm logging format.**
- ZUHR = DB number, DW number

ZSYN:

Destination data area for time synchronization message frame (DCF7 = 1)

If chronological message acquisition functionality is to be used with S5 alarm logging, a special time data format will be expected in DB 80 from DW 190 onwards. This time data format will be derived from the S5 system time and written to the corresponding data area ZUHR (DB 80, DWs 190 - 192).

**Relationship between 'chronological reporting' and FB 86: MESS:TIME:**

![Diagram of 'chronological reporting' relationship](Figure 4)
5.2.12 Data formats for date and time

Time synchronization message frame from a system (WinCC does not currently support the time message frame)

The first data word of the time synchronization message frame contains a source ID, which is sent by the system together with data and time data. Function block **FB 86 : MELD:UHR** extracts the queued message frame only as soon as the source ID 'FFFF' is positioned here. Receipt of the message frame is acknowledged with a '0' in this data word. Not until a new message frame arrives (DW 1 = 'FFFF') is it read out again and evaluated.

<table>
<thead>
<tr>
<th>Meaning</th>
<th>Data word</th>
<th>Contents</th>
<th>Validity</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source ID/time message frame</td>
<td>1</td>
<td>FFFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message frame ID</td>
<td>2</td>
<td>FFFF</td>
<td></td>
<td>Not used</td>
</tr>
<tr>
<td>Seconds</td>
<td>3</td>
<td>00xx</td>
<td>xx: 0 to 59</td>
<td></td>
</tr>
<tr>
<td>Minutes</td>
<td>4</td>
<td>00xx</td>
<td>xx: 0 to 59</td>
<td></td>
</tr>
<tr>
<td>Hours</td>
<td>5</td>
<td>00xx</td>
<td>xx: 0 to 23</td>
<td></td>
</tr>
<tr>
<td>Day</td>
<td>6</td>
<td>00xx</td>
<td>xx: 1 to 31</td>
<td></td>
</tr>
<tr>
<td>Month</td>
<td>7</td>
<td>00xx</td>
<td>xx: 1 to 12</td>
<td></td>
</tr>
<tr>
<td>Year</td>
<td>8</td>
<td>00xx</td>
<td>xx: 0 to 127 (1990-2117)</td>
<td>Year + 1990</td>
</tr>
<tr>
<td>Day of week</td>
<td>9</td>
<td>00xx</td>
<td>xx: 0 to 6</td>
<td>Sunday = 0</td>
</tr>
<tr>
<td>Day of year</td>
<td>10</td>
<td>00xx</td>
<td>xx: 1 to 365</td>
<td></td>
</tr>
</tbody>
</table>
| Summer time, winter time  | 11        | yyyy     | xx: winter time = 00  
                                      summer time = 01  
                                      yy: leap year  
                                      current year = 00  
                                      last year = 01  
                                      two year ago = 02  
                                      three years ago = 03 |                  |

Table 18

5.2.12.1 Time data area CPU 944, CPU 945

The data word numbers are relative details. The actual position of the area is determined by the call parameters: UDAT = DB No., DW No. of **FB 86 : MELD:UHR**.
<table>
<thead>
<tr>
<th>DW</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>internal tags</td>
</tr>
<tr>
<td>1</td>
<td>current time</td>
</tr>
<tr>
<td>2</td>
<td>time operating range</td>
</tr>
<tr>
<td>3</td>
<td>reserve - alarm time</td>
</tr>
<tr>
<td>4</td>
<td>reserve - operating hours</td>
</tr>
<tr>
<td>5</td>
<td>time / date</td>
</tr>
<tr>
<td>6</td>
<td>after RUN / STOP</td>
</tr>
</tbody>
</table>

Table 19

**Current time in time data area:**

<table>
<thead>
<tr>
<th>DW</th>
<th>Word/Left</th>
<th>Word/Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>---</td>
<td>Day of week</td>
</tr>
<tr>
<td>6</td>
<td>Day</td>
<td>Month</td>
</tr>
<tr>
<td>7</td>
<td>Year</td>
<td>AM/PM (bit, No. 7), hour</td>
</tr>
<tr>
<td>8</td>
<td>Minute</td>
<td>Second</td>
</tr>
</tbody>
</table>

Figure 5

**Setting area in time data area:**

<table>
<thead>
<tr>
<th>DW</th>
<th>Word/Left</th>
<th>Word/Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Leap year</td>
<td>Day of week</td>
</tr>
<tr>
<td>10</td>
<td>Day</td>
<td>Month</td>
</tr>
<tr>
<td>11</td>
<td>Year</td>
<td>AM/PM (bit, No. 7), hour</td>
</tr>
<tr>
<td>12</td>
<td>Minute</td>
<td>Second</td>
</tr>
</tbody>
</table>

Figure 6
5.2.12.2 Time data area CPU 928B, CPU 948

The data word numbers are relative details. The actual position of the area is determined by
the call parameters: UDAT = DB No., DW No. of FB 86: MELD:UHR.

<table>
<thead>
<tr>
<th>DW</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>internal tags</td>
</tr>
<tr>
<td>1</td>
<td>current time</td>
</tr>
<tr>
<td>2</td>
<td>time operating range</td>
</tr>
</tbody>
</table>

Figure 7

Current time in time data area:

<table>
<thead>
<tr>
<th>DW</th>
<th>Word/Left</th>
<th>Word/Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>15 14 13 12 11 10 9 8</td>
<td>7 6 5 4 3 2 1 0</td>
</tr>
<tr>
<td>4</td>
<td>Seconds</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>Format</td>
<td>Hours</td>
</tr>
<tr>
<td>6</td>
<td>Day of month</td>
<td>Day of week</td>
</tr>
<tr>
<td>7</td>
<td>Year</td>
<td>Second</td>
</tr>
</tbody>
</table>

Figure 8

Current time in setting area:

<table>
<thead>
<tr>
<th>DW</th>
<th>Word/Left</th>
<th>Word/Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>15 14 13 12 11 10 9 8</td>
<td>7 6 5 4 3 2 1 0</td>
</tr>
<tr>
<td>8</td>
<td>Seconds</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>Format</td>
<td>Hours</td>
</tr>
<tr>
<td>10</td>
<td>Day of month</td>
<td>Day of week</td>
</tr>
<tr>
<td>11</td>
<td>Year</td>
<td>Second</td>
</tr>
</tbody>
</table>

Figure 9
5.2.12.3 Time data area CPU 946, CPU 947

The data word numbers are relative details. The actual position of the area is determined by the call parameters: UDAT = DB No., DW No. of FB 86 : MELD:UHR.

<table>
<thead>
<tr>
<th>DW</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>internal tags</td>
</tr>
<tr>
<td>1</td>
<td>current time</td>
</tr>
<tr>
<td>2</td>
<td>time operating range</td>
</tr>
</tbody>
</table>

Figure 10

Current time in time data area:

<table>
<thead>
<tr>
<th>DW</th>
<th>Word/Left</th>
<th>Word/Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>10 sec.</td>
<td>1 sec.</td>
</tr>
<tr>
<td>6</td>
<td>10 hrs.</td>
<td>1 hr.</td>
</tr>
<tr>
<td>7</td>
<td>10 days</td>
<td>1 day</td>
</tr>
<tr>
<td>8</td>
<td>10 years</td>
<td>1 year</td>
</tr>
</tbody>
</table>

Figure 11

Current time in setting area:

<table>
<thead>
<tr>
<th>DW</th>
<th>Word/Left</th>
<th>Word/Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>10 sec.</td>
<td>1 sec.</td>
</tr>
<tr>
<td>10</td>
<td>10 hrs.</td>
<td>1 hr.</td>
</tr>
<tr>
<td>11</td>
<td>10 days</td>
<td>1 day</td>
</tr>
<tr>
<td>12</td>
<td>10 years</td>
<td>1 year</td>
</tr>
</tbody>
</table>

Figure 12
5.2.12.4 Clock data format for message blocks

The data word numbers are relative details. The actual position of the area is determined by the call parameters: ZUHR = DB No., DW No. of **FB 86 : MELD:UHR**.

If chronological message acquisition functionality is to be used with S5 alarm logging, the data DB 80, DW 190 have to be entered in parameter ZUHR.

The date and time are made available by function block **FB 86 : MELD:UHR** for message processing in binary code:

**Current time in setting area:**

<table>
<thead>
<tr>
<th>Meaning</th>
<th>Data word</th>
<th>Bit</th>
<th>Validity</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/100 second</td>
<td>1</td>
<td>0-6</td>
<td>0 to 99 (0 - 990 msec)</td>
<td>In one 10 msec reference</td>
</tr>
<tr>
<td>Seconds</td>
<td>1</td>
<td>7-12</td>
<td>0 to 59</td>
<td></td>
</tr>
<tr>
<td>Minutes</td>
<td>0</td>
<td>0-5</td>
<td>0 to 59</td>
<td></td>
</tr>
<tr>
<td>Hours</td>
<td>0</td>
<td>6-10</td>
<td>0 to 23</td>
<td></td>
</tr>
<tr>
<td>Day</td>
<td>2</td>
<td>0-4</td>
<td>1 to 31</td>
<td></td>
</tr>
<tr>
<td>Month</td>
<td>2</td>
<td>5-8</td>
<td>1 to 12</td>
<td></td>
</tr>
<tr>
<td>Year</td>
<td>2</td>
<td>9-15</td>
<td>0 to 127 (1990-2117)</td>
<td>Year + 1990</td>
</tr>
</tbody>
</table>

Figure 13

**DW3: time**

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Hours Minutes

**DW4: time**

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Seconds Milliseconds

**DW4: date**

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Year Month Day

Figure 14
5.2.13 Interface description

To use the S5 time synchronization software, the user has to:

- fill out the call parameters of **FB 86 : MELD:UHR** as described in section 5.2.11 Call parameters of FB 86 : MELD:UHR
- open the data areas in the PLC.

Example configuration

Let us assume a CPU 944 with two PU interfaces. The S5 time synchronization is required to be set up for S5 alarm logging without the DCF77 clock on this CPU.

**Data areas:**
- Time synchronization message frame: DB 100, DW 20 - DW 30
- Clock data area of the S5 system clock: DB 100, DW 31 - DW 47
- Message block data*: DB 80, DW 190 - DW 192

* Use of this data area is imperative when using SIMATIC S5 alarm logging.

On specifying the channel parameters - for example, SINEC H1, the required data block (DB 100, DW 20 - DW 30) has to be entered in the system when specifying 'time synchronization:'.

You have to make sure that DB 80 of DW 0 through DW 255 and DB 100 of DW 0 of DW 47 are opened.

Dump from OB 1:

```
......
: SPA  FB 86
Name : MELD: UHR
CPUT : KF +1
DCF7 : KF +0
QTYP : KF +0
QSYN : KY 100, 20
UDAT : KY 100, 31
ZINT : KF +0
ZUHR : KY 80, 190
ZSYN : KF +0
etc.
```
5.2.14 Interaction with WinCC alarm logging

The following must be taken into account with regard to the interaction of WinCC alarm logging with the S5 message block:

256 has to be specified in the S5’s send block as the number of data words to be transferred.

A new connection has to be set up in the Control Center in the S5Trsp channel. Specify the type Fetch-passive at the item Connection/Read function.

Two raw data tags have to be created for each PLC for data exchange with alarm logging. The first is responsible for receiving messages.

Their addressing has to be set as follows: data area : DB, DB No. : xx, addressing word, DW : 0, raw data type : event

The second is required for sending acknowledgement information.

Their addressing has to be set as follows: data area : DB, DB No. : 80, addressing word, DW : 90, raw data type : event

Connect the event tag in alarm logging to the receive raw data tag (the bit information is meaningless in this instance).
Connect the acknowledgement tag to the send raw data tag (the bit information is meaningless in this instance).

Enter the file S5STD.NLL as the Format DLL.

Tip: Using the interconnection wizard, you can connect all the messages concerned in one operation.

Only positive fixed-point numbers are allowed for process values. Floating point values are not supported.

<table>
<thead>
<tr>
<th>S5</th>
<th>WinCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>prozess value</td>
<td>prozess value 1</td>
</tr>
<tr>
<td>job description</td>
<td>prozess value 2</td>
</tr>
<tr>
<td>batch description</td>
<td>prozess value 3</td>
</tr>
<tr>
<td>reserve</td>
<td>prozess value 4</td>
</tr>
</tbody>
</table>
5.3 Format DLL interface to AlarmLogging and TagLogging

Objective

The AlarmLogging and TagLogging applications acquire the process data via the WinCC data manager. Depending on the communication type for the process,

- different channel DLLs are involved in data transfer,
- the process data are stored in message frames (raw data tags) of different structures.

AlarmLogging and TagLogging are required to process the process data, however, irrespective of the type of communication concerned, in exactly the same way. For this reason, a separate Format DLL is used for every type of communication which knows the precise structure of the message frames concerned and derives from it a generally valid "process data form" for AlarmLogging and TagLogging.

A Format DLL basically belongs to a channel DLL; like it, it should be possible to insert and remove it simply into and from the overall system. Still, it does not have a direct interface to the associated channel DLL.

This document describes the integration and interface of every Format DLL to the WinCC applications AlarmLogging and TagLogging. It originated during drafting of the S7PMC Format DLL, and for this reason the expression "S7PMC Format DLL" is for the most part synonymous with the expression "Format DLL".

Basic process

The S7PMC Format DLL is a passive group of programs which has interfaces only to the applications AlarmLogging and TagLogging. The S7PMC Format DLL processes S7PMC-specific functions for AlarmLogging and TagLogging.

AlarmLogging and TagLogging log in with a start call at the Format DLL. On doing so, certain parameters are transferred in a start structure to the Format DLL and their characteristics are received by means of IDs.

Two data transfer directions are required to process the S7PMC functions RUNTIME mode:

- OS to PLC: (sending of logon/logoff requests, acknowledgements)
- PLC to OS: (reception of messages and archive data)

With an initialization call, TagLogging/AlarmLogging announces the configured archive variable names and message numbers to S7PMC DLL. The Format DLL (WinCC) has to log on at the PLC for these objects. The initialization call can be processed at any point in time.

The Format DLL is called by AlarmLogging/TagLogging to uninitialized in order to return resources etc.
### 5.3.1 Shared interface to AlarmLogging and TagLogging

The general functions of the Format DLL, which are identical for AlarmLogging and TagLogging, are grouped in a shared interface. The function names all begin with ‘NORM...’. (prefix for AlarmLogging-specific functions: ‘Mld...’, prefix for TagLogging-specific functions: ‘Pde...’).

The language switch is only required for format DLLs that contain a dialog box.

**MESS/PDE**
- Initialization: NormDLLStart
- Language Switching: NormSetLanguage
- Determine Name: NormGetDLLName
- Event triggers the writing of a raw data tag
- Write: NORM_SEND_PROC
- Write: NORM_SEND_PROC
- Write: NORM_SEND_PROC
- End of Processing
- Deinitialization: NORMDLLStop

to the PLC

**Common Interface**

**NormDLL**
- 1) The language switch is only required for format DLLs that contain a dialog box
- e.g. Writing registration telegrams, acknowledgments, etc. to the PLC

**MELD = AlarmLogging**
**PDE = TagLogging**
AlarmLogging-specific extras

**Runtime**

![Diagram showing the flow of messages and functions related to AlarmLogging-specific extras.]

**Extended configuration dialog**

![Diagram showing the flow of messages and functions related to the extended configuration dialog.]

---

**BOOL MldRegisterMsg**

NORM_SEND_PROC

**BOOL MldSendMsg**

NORM_SEND_PROC

**BOOL MldReceiveMsg**

MSG_RECV_MSG_PROC

**BOOL MldShowDialog**

NORM_SEND_PROC

---

If not already done, register the message class to receive data.

Number of Acknowledgments, Lock/Enable

Telegrams to the PLC

---

Number of returned single messages

---

If not already done, register the message class to receive data.

---

If not already done, register the message class to receive data.
5.3.2 TagLogging-specific extras

Runtime

Extended configuration dialog
5.3.3 API functions of a WinCC Format DLL

The Format DLL is divided into the following sub-areas:

- Initialization of the Format DLL
  - Initialization by the operating system while the Format DLL is being loaded (LibMain)
  - Polling the properties of a Format DLL
  - Polling the name of the Format DLL
- Shut down of the Format DLL
  - Shut down by TagLogging and AlarmLogging
  - Unloading by the operating system
- Add ins to the configuration
  - Dialog extension during message configuration
  - Dialog extension during archive tag configuration
- Online services
  - Registration of all Format DLL-specific objects (messages, archive tags)
  - Language switch
- Standardization
  - Standardization of messages
  - Standardization of archive tags

5.3.3.1 Initialization of the Format DLL

Initialization during the load operation

The applications AlarmLogging and/or TagLogging load a WinCC Format DLL with the help of the LoadLibrary system call. Following that, the Format DLL is loaded by the operating system and initialized by its standard mechanisms. All the entry addresses of the Format DLL are defined.
### 5.3.3.2 Polling the properties of a Format DLL

AlarmLogging and TagLogging log in at the relevant Format DLL by means of the NormDLLStart call. It is intended for the exchange of information between the Format DLL and the application.

**NormDLLStart**

```c
#include <winccnrm.h>

BOOL NormDLLStart(
    LPVOID lpUser,
    BOOL bModeRuntime,
    PNORM_STARTSTRUCT pcis,
    PCMN_ERROR lpError);
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lpUser</td>
<td>Pointer to application data, forward unchanged to Callback</td>
</tr>
<tr>
<td>bModeRuntime</td>
<td>TRUE when the Format DLL is started in RUNTIME mode, FALSE in Configuration Mode; is not currently evaluated by the Format DLL</td>
</tr>
<tr>
<td>pcis</td>
<td>Pointer to start structure.</td>
</tr>
<tr>
<td>lpError</td>
<td>Pointer to default WinCC error structure</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Return</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>No error</td>
</tr>
<tr>
<td>FALSE</td>
<td>Error in API function, description of error cause via the pointer lpError</td>
</tr>
</tbody>
</table>
NORM_STARTSTRUCT

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>I/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>dwSize</td>
<td>Size of structure in bytes</td>
<td>A</td>
</tr>
<tr>
<td>lpstrProjectPath</td>
<td>path of the currently selected project</td>
<td>I</td>
</tr>
<tr>
<td>NORM_SEND_PRO</td>
<td>Ptr to Callback function of the application through which the Format DLL sends a raw data tag via the DM to the PLC.</td>
<td>I</td>
</tr>
<tr>
<td>pfWriteRwData</td>
<td>_Ptr to Callback function of the application through which the Format DLL sends a raw data tag via the DM to the PLC.</td>
<td>I</td>
</tr>
<tr>
<td>dwAppID</td>
<td>Application ID:</td>
<td>I</td>
</tr>
<tr>
<td></td>
<td>1 = AlarmLogging</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 = TagLogging</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 = USER (reserved for additional appls., not currently used)</td>
<td></td>
</tr>
<tr>
<td>dwLocaleID</td>
<td>Current language setting at time of call</td>
<td>I</td>
</tr>
<tr>
<td>dwNormCap</td>
<td>Properties of the Format DLL in accordance with the table below</td>
<td>A</td>
</tr>
</tbody>
</table>

The Callback function for sending raw data tags to the WinCC Data Manager is supplied as follows:

```c
typedef BOOL(*NORM_SEND_PROC)(
    LPDM_VAR_UPDATE_STRUCT    lpDmVarUpdate,
    DWORD                     dwWait,
    LPVOID                    LpUser,
    LPCMN_ERROR               lpError );
```

Parameter | Description
---|---
lpDmVarUpdate | Pointer to raw data tag
dwWait | Identification of whether the application should wait until completion of the write call or not:
| WAIT_ID_NO  | with SET_VALUE
| WAIT_ID_YES | with SET_VALUE_WAIT
LpUser | Pointer to application data, noted upon call NormDLLStart
lpError | Pointer to default WinCC error structure

Return | Description
---|---
TRUE | No error
FALSE | Error in API function, description of error cause via the pointer lpError
A bit is assigned to every property in accordance with the table below.

<table>
<thead>
<tr>
<th>DEFINE</th>
<th>Bit Mask</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>NORMCAP_DIALOG</td>
<td>0x00000001</td>
<td>Set Format DLL features special dialog box</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deleted Format DLL does not feature a dialog box</td>
</tr>
<tr>
<td>NORMCAP_REENTRANT</td>
<td>0x00000002</td>
<td>Set Format DLL is re-enterable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deleted Format DLL is not re-enterable</td>
</tr>
<tr>
<td>NORMCAP_MSG_FREE_LOCK</td>
<td>0x00000004</td>
<td>Set Login/logoff is possible for messages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deleted Logon/logoff is not possible for messages.</td>
</tr>
<tr>
<td>NORMCAP_ARC_FREE_LOCK</td>
<td>0x00000008</td>
<td>Set Logon/logoff is possible for archive tags.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deleted Logon/logoff is not possible for archive tags.</td>
</tr>
<tr>
<td>NORMCAP_MSG_GENERIC</td>
<td>0x00000010</td>
<td>Set Messages can be generated generically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deleted Messages cannot be generated generically.</td>
</tr>
<tr>
<td>NORMCAP_ARC_GENERIC</td>
<td>0x00000020</td>
<td>Set Archive tags can be created generically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deleted Archive tags cannot be created generically.</td>
</tr>
</tbody>
</table>

5.3.3.3 Polling the name of the Format DLL

NormGetDLLName

```c
#include <winccnrm.h>
LPTSTR NormGetDLLName( void );
```

<table>
<thead>
<tr>
<th>Return</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LPTSTR</td>
<td>Pointer to a string which contains the name of the Format DLL in plain language; the name depends on the current language setting.</td>
</tr>
</tbody>
</table>
5.3.4 Shutting down the Format DLL

**Shut down by TagLogging and AlarmLogging**

TagLogging and AlarmLogging inform the Format DLL when the applications are being closed. The resources are then returned properly in the Format DLL.

```c
#include <winccnrm.h>

BOOL NormDLLStop (void);
```

<table>
<thead>
<tr>
<th>Return</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>Function successful</td>
</tr>
<tr>
<td>FALSE</td>
<td>Error in API function</td>
</tr>
</tbody>
</table>

**Unloading by the operating system**

No special precautions are necessary.

5.3.4.1 Configuration add-ins

Specific details are necessary for S7PMC objects. These details are first requested in a dialog box using standard means (without MFC) and enter directly into either the WinCC message number or the name of the archive tag. This means that the Format DLL does not have to store and manage these details itself. To guarantee the uniqueness of a message number throughout a project, an assignment between the message number or archive tag and the associated raw data tag is necessary. This assignment information is an integral part of the message number or archive tag name.

5.3.4.2 Dialog box extension when configuring S7PMC messages

The Format DLL has an API function for defining the S7PMC-specific message number. This function is called by CS alarm logging upon assigning parameters to single messages belonging to a S7PMC Format DLL. The message number assigned by the S7PMC Format DLL is the number which consists of two parts:

**Part 1:**

The number which uniquely identifies a PLC CPU throughout a project (raw data tag number)

**Part 2:**

The number belonging to the message from a PLC point of view and uniquely identifying it within a PLC CPU (Format DLL-specific)
The following selection has to be made in the configuration dialog box to compile the message number:

**Structure of an S7PMC message number (32 bit)**

<table>
<thead>
<tr>
<th>Segment 1</th>
<th>Segment 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>rd_nr</td>
<td>rcm_r</td>
</tr>
<tr>
<td>1 (1Bit)</td>
<td>10 (Bit)</td>
</tr>
<tr>
<td>rcm_r</td>
<td>3  (Bit)</td>
</tr>
<tr>
<td>10 (Bit)</td>
<td>16 (Bit)</td>
</tr>
<tr>
<td>3  (Bit)</td>
<td>16 (Bit)</td>
</tr>
</tbody>
</table>

**Regarding Part 1**

Every message belongs to a raw data tag which identifies a PLC CPU. In order to be able to perform the assignment raw data tag – message number, the following definition was established.

The name of the raw data tag for S7PMC - and all connection types with Format DLL - has the following permanent structure:

@rd_alarm#rd_nr

@rd_alarm# Permanent integral part of the name of a raw data tag for Format DLLs
rd_nr Decimal number between 0 and 1023 for identification of a raw data tag (without leading zeros)

The most significant bit of the message number is set in the case of message numbers which are assigned by Format DLLs (externally). These messages may be processes only by the associated Format DLLs, meaning that the message number cannot be modified via the configuration dialog box of AlarmLogging.

**Regarding Part 2**

This part of the message number can be assigned by the Format DLL concerned. For the S7PMC, it has the following meaning:

MKI Message class; one of the classes has to be selected:
SCAN (1)
ALARM/NOTIFY (2)
ALARM_8P/ALARM_8 (2)
LTM (3)

Sub-Nr Submessage number applicable only to ALARM_8 and ALARM_8P:
1 to 8

PMC-ID PMC message number (block input parameter EV-ID):
1 to 16386
for message classes SCAN and ALARM/NOTIFY and ALARM_8P/ALARM_8
1 to 7
for message class LTM
MldShowDialog

```c
#include <winccnrm.h>

BOOL WINAPI MldShowDialog(
    HWND hwnd,
    LPMSCSDATA_GENERIC lpmCS,
    LPDM_PROJECT_INFO lpDMProjectInfo,
    LPCMN_ERROR lpError
);
```

### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hwnd</td>
<td>Window handle</td>
</tr>
<tr>
<td>lpmCS</td>
<td>Pointer to single message data</td>
</tr>
<tr>
<td>lpDMProjectInfo</td>
<td>Pointer to project information structure</td>
</tr>
<tr>
<td>lpError</td>
<td>Pointer to default WinCC error structure</td>
</tr>
</tbody>
</table>

### Return Description

<table>
<thead>
<tr>
<th>Return</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>Function successful</td>
</tr>
<tr>
<td>FALSE</td>
<td>Error in API function, description of error cause via the pointer lpError</td>
</tr>
</tbody>
</table>

#### 5.3.4.3 Dialog box extension when configuring archive tags

The Format DLL has an API function for defining the S7PMC-specific archive tag name. This function is called by CS TagLogging CS upon assigning parameters to archive tags belonging to an S7PMC connection. The archive tag name assigned by the AS7PMC Format DLL is a name consisting of several components and contains, among other things, the number belonging to the archive on the PLC. With this algorithm, the S7PMC tag numbers are uniquely contained in the WinCC archive tag description, resulting in Runtime mode in the quickest possible assignment.

TagLogging guarantees that the archive tag names are all unique.

**Structure of an S7PMC archive tag name** (not longer than 18 bytes)

- character
- rw_id
- x
- ar_id

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Length in Bytes</th>
<th>Assigned By</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>character</td>
<td>9</td>
<td>TagLogging</td>
<td>Fixed character string, which is assigned by TagLogging, consists of the name of the Format DLL and # as the data delimiter - for example, for S7PMC: NRMS7PMC, does not appear on the user interface</td>
</tr>
<tr>
<td>rw_id</td>
<td>8</td>
<td>TagLogging/</td>
<td>Raw data ID in hexadecimal characters (including leading zeros), resulting in unique</td>
</tr>
</tbody>
</table>
Format DLL interface

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Length in Bytes</th>
<th>Assigned By</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>1</td>
<td>Format DLL CS portion</td>
<td>S7PMC-specific ID for differentiating between BSEND and AR_SEND: ‘A’ = AR_SEND, ‘B’ = BSEND</td>
</tr>
<tr>
<td>ar_id</td>
<td>4</td>
<td>Format DLL CS portion</td>
<td>ID as hex characters (including leading zeros) Depending on ID x: S7PMC-specific archive number AR_ID or S7-specific R_ID upon BSEND</td>
</tr>
</tbody>
</table>

Example of an archive tag name for an S7PMC: #00000001#A#0014

**PdeShowDialog**

```c
#include <winccnrm.h>

BOOL WINAPI PdeShowDialog(
    LPVOID hwnd,
    LPTSTR lpszArcVarName,
    DWORD dwArcVarNameLength,
    LPDM_VARKEY lpVarKey,
    LPCMN_ERROR lpError
);
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hwnd</td>
<td>Window handle</td>
</tr>
<tr>
<td>lpszArcVarName</td>
<td>Pointer to string field for storing Format DLL-specific archive tag name portion</td>
</tr>
<tr>
<td>dwArcVarNameLength</td>
<td>Maximum length of Format DLL-specific name portion</td>
</tr>
<tr>
<td>lpVarKey</td>
<td>Pointer to Varkey of raw data tags</td>
</tr>
<tr>
<td>lpError</td>
<td>Pointer to WinCC error structure</td>
</tr>
</tbody>
</table>

**Return**

<table>
<thead>
<tr>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>Function successful</td>
</tr>
<tr>
<td>FALSE</td>
<td>Error in API function, description of error cause via the pointer lpError</td>
</tr>
</tbody>
</table>
5.3.4.4 Online services

Register all messages

This function is necessary because the Format DLL does not have configuration information about the relevant messages. But messages are not sent by the PLC until the application (WinCC) has logged on for receiving messages. AlarmLogging currently calls the function MldRegisterMsg for every relevant message and thus transfers configuration information for the single message to the Format DLL. Apart from a message description, the Format DLL receives a pointer to the raw data tag (connection) that is assigned to this message. This means that the Format DLL can create a table in main memory at runtime, with which the S7PMC-specific logon message frames can be structured.

MldRegisterMsg

```c
#include <winccnrm.h>

BOOL WINAPI MldRegisterMsg(
    LPDM_VARKEY lpDMVarKey,
    LPDWORD lpMsgNumber,
    DWORD DwNumMsgNumber,
    LPCMN_ERROR lpError
    );
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lpDMVarKey</td>
<td>Pointer to Varkey of raw data tags</td>
</tr>
<tr>
<td>lpMsgNumber</td>
<td>Pointer to field with single message numbers</td>
</tr>
<tr>
<td>dwNumMsgNumber</td>
<td>Number of single message numbers</td>
</tr>
<tr>
<td>lpError</td>
<td>Pointer to WinCC error structure</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Return</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>Function successful</td>
</tr>
<tr>
<td>FALSE</td>
<td>Error in API function, description of error cause via the pointer lpError</td>
</tr>
</tbody>
</table>
5.3.4.5 Register all archive tags

This function is necessary because the Format DLL does not have configuration information about the relevant archive tags. The function PdeSendMsg is therefore called for a certain number of relevant archive tags and thus the configuration information and TagLogging additional information made known for the archive tags. More than archive tag of a connection can be registered with a single call. TagLogging transfers one double word per archive tag as additional information to the Format DLL, which is retained in Format DLL memory. This additional information is required by TagLogging as soon as archive tags have to be processed (in the Callback function TagLogging_ARCHIVE_CALLBACK).

This means that the Format DLL can create a table in main memory at runtime, with which the S7PMC-specific logon message frames can be structured for the archives concerned. The logon message frames are required to announce to the PLC readiness to receive for the archive number concerned. Not until after logon has been successful does the PLC send archive data to the application (WinCC).

PdeSendMsg

```c
#include <winccnrm.h>

BOOL WINAPI PdeSendMsg(
    NORM_SEND_PROC lpfnCallBack,
    DWORD dwFunctionId,
    LPSZ_ARC_VAR_NAME lpszArcVarName,
    LPDWORD lpdwData,
    DWORD dwNumArchVarName,
    LPDM_VARKEY lpVarKey,
    LPVOID lpUser,
    LPCMN_ERROR lpError
);
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lpfnCallBack</td>
<td>Pointer to Callback routine with which the raw data tag structured by the Format DLL has to be transferred to the DM.</td>
</tr>
<tr>
<td></td>
<td>If zero, the Callback routine has to be called from the Ini structure.</td>
</tr>
<tr>
<td></td>
<td>The function address from the Ini structure is not identical with this parameter.</td>
</tr>
<tr>
<td>dwFunctionId</td>
<td>Function ID FUNC_ID_REGISTER (refer to table below), the same function applies to all tags listed.</td>
</tr>
<tr>
<td>lpszArcVarName</td>
<td>Pointer to a pointer field whose elements refer to the names of the tag variables.</td>
</tr>
<tr>
<td>lpdwData</td>
<td>Pointer to a field whose elements contain additional data for the archive tags, can also be zero.</td>
</tr>
<tr>
<td></td>
<td>The additional value belonging to an archive tag is applied without being modified to internal lists of the Format DLL with the function</td>
</tr>
<tr>
<td></td>
<td>FUNC_ID_REGISTER (logon archive tag) and forwarded when necessary to TagLogging_ARCHIVE_CALLBACK.</td>
</tr>
<tr>
<td></td>
<td>Without meaning with the other function IDs.</td>
</tr>
<tr>
<td>dwNumArchVarName</td>
<td>Number of archive tag names that have to be processed</td>
</tr>
<tr>
<td>lpVarKey</td>
<td>Pointer to Varkey of raw data tags</td>
</tr>
</tbody>
</table>
### 5.3.4.6 Language change

The configuration dialog must be language-dependent; this means that Format DLL must know the currently set language. The language setting is also specified in the start structure during start-up. Dynamic language switch has to be forwarded to the Format DLL as well by AlarmLogging. The call for this is

**NormSetLanguage**

```
#include <winccnrm.h>

BOOL NormSetLanguage(
    DWORD dwLocaleID,
    LPCMN_ERROR lpError
);
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dwLocaleID</td>
<td>Current language setting at time of call</td>
</tr>
<tr>
<td>lpError</td>
<td>Pointer to default WinCC error structure</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Return</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>Function successful</td>
</tr>
<tr>
<td>FALSE</td>
<td>Error in API function, description of error cause via the pointer lpError</td>
</tr>
</tbody>
</table>
5.3.5 Formatting

If an application has logged on at the PLC to receive messages or archive data, it receives these data by means of the raw data tag concerned. The Format DLL logs on during registration. Data message frames can be sent by the PLC from that time on. Data message frames are packed in raw data tags and are forwarded to the Format DLL via the channel DLL, the data manager and the application concerned (in this instance, TagLogging or AlarmLogging); the Format DLL is responsible for the type of raw data tag. The Format DLL interprets the incoming data and constructs messages and/or archive data from them.

5.3.5.1 Derivation of single messages

The contents of a raw data tag (of a message frame) may store n single messages. The Format DLL has to interpret this S7PMC-specific message frame and forward the resultant single messages to AlarmLogging.

The message number (EV_ID) of S7PMC is part of the WinCC message number. Up to ten process values can be delivered by S7PMC in a single message. The "string" type is allowed as a process value. This process value type is not supported by AlarmLogging; supplementary values of that kind have to be rejected by the Format DLL.

The MldReceiveMsg function is invoked by AlarmLogging every time the status of the raw data tag has changed; this means when the Faulty status following OK or the other way round is determined by DM. The change of status of the raw data tag (corresponding to a connection) is of importance only for the S7PMC Format DLL. Further details are provided in the section entitled "Processing upon change of status".

MldReceiveMsg

```c
#include <winccnrm.h>

BOOL WINAPI MldReceiveMsg(
    MSG_RECEIVE_MSG_PROC lpfMsgReceive,
    LPDM_VAR_UPDATE_STRUCT lpDMVar,
    LPVOID lpUser,
    LPCMN_ERROR lpError );
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lpfMsgReceive</td>
<td>Pointer to Callback routine with which the single message structured by the Format DLL has to be transferred to AlarmLogging.</td>
</tr>
<tr>
<td>lpDMVar</td>
<td>Pointer to raw data tag</td>
</tr>
<tr>
<td>lpUser</td>
<td>Pointer to user data, transferred unmodified to Callback</td>
</tr>
<tr>
<td>lpError</td>
<td>Pointer to WinCC error structure</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Return</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>Function successful</td>
</tr>
<tr>
<td>FALSE</td>
<td>Error in API function, description of error cause via the pointer lpError</td>
</tr>
</tbody>
</table>
The Callback function for sending single messages to AlarmLogging is supplied as follows:

```c
typedef BOOL(*MSG_RECEIVE_MSG_PROC)(
  LPMSG_RTCREATE_STRUCT lpMsgCreate,
  DWORD dwNumMsg,
  LPVOID lpUser,
  LPCMN_ERROR lpError );
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lpMsgCreate</td>
<td>Pointer to a WinCC message</td>
</tr>
<tr>
<td>dwNumMsg</td>
<td>Number of single messages</td>
</tr>
<tr>
<td>lpUser</td>
<td>Pointer to application data</td>
</tr>
<tr>
<td>lpError</td>
<td>Pointer to default WinCC error structure</td>
</tr>
</tbody>
</table>

The message and alarm concept of WinCC AlarmLogging and S7PMC makes provision for messages being acknowledged irrespective of their configuration. The acknowledgement information is known to AlarmLogging but also has to be managed in the message acknowledgement memory of the PLC. To achieve this, AlarmLogging sends acknowledgement message frames to the PLC via the Format DLL corresponding to the connection.

On the basis of these input data, the S7PMC Format DLL constructs the corresponding S7PMC message frames, which are forwarded by means of the AlarmLogging Callback function NORM_SEND_PROC to the DM.

The same procedure applies when a single message is disabled/enabled again by AlarmLogging: this means that its generation at the source on the PLC has to be inhibited/released again.

**MldSendMsg**

```c
#include <winccnrm.h>

BOOL WINAPI MldSendMsg(
  NORM_SEND_PROC lpfnMsgSend,
  LPMSG_SEND_DATA_STRUCT lpSendData,
  DWORD dwNumData,
  LPVOID lpUser,
  LPCMN_ERROR lpError );
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lpfnMsgSend</td>
<td>Pointer to AlarmLogging Callback routine with which the raw data tag constructed by the Format DLL has to be transferred for writing to the PLC. The parameters are described in section entitled &quot;Polling the properties of a Format DLL&quot;.</td>
</tr>
<tr>
<td>lpSendData</td>
<td>Pointer to send data; its structure is described further below</td>
</tr>
</tbody>
</table>

5.3.5.2 Acknowledging, disabling/to enabling messages

The message and alarm concept of WinCC AlarmLogging and S7PMC makes provision for messages being acknowledged irrespective of their configuration. The acknowledgement information is known to AlarmLogging but also has to be managed in the message acknowledgement memory of the PLC. To achieve this, AlarmLogging sends acknowledgement message frames to the PLC via the Format DLL corresponding to the connection.

On the basis of these input data, the S7PMC Format DLL constructs the corresponding S7PMC message frames, which are forwarded by means of the AlarmLogging Callback function NORM_SEND_PROC to the DM.

The same procedure applies when a single message is disabled/enabled again by AlarmLogging: this means that its generation at the source on the PLC has to be inhibited/released again.
Parameter | Description
--- | ---
dwNumData | Number of single requests for processing
lpUser | Pointer to user data, transferred unmodified to Callback
lpError | Pointer to WinCC error structure

**Return** | **Description**
--- | ---
TRUE | Function successful
FALSE | Error in API function, description of error cause via the pointer lpError

**Structure of Alarm Logging send data (single request)**

<table>
<thead>
<tr>
<th>Tag</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>DWORD dwVarID</td>
<td>Raw data tag ID of DM</td>
</tr>
<tr>
<td>DWORD dwNotify</td>
<td>Notify possible values</td>
</tr>
<tr>
<td></td>
<td>MSG_STATE_QUIT     Acknowledge message</td>
</tr>
<tr>
<td></td>
<td>MSG_STATE_LOCK    Disable message</td>
</tr>
<tr>
<td></td>
<td>MSG_STATE_UNLOCK  Enable message</td>
</tr>
<tr>
<td></td>
<td>MSG_STATE_QUIT_EMERGENCY Acknowledge all messages</td>
</tr>
<tr>
<td>DWORD dwData</td>
<td>With QUIT, LOCK, UNLOCK --&gt; message number</td>
</tr>
<tr>
<td></td>
<td>With EMERGENCY-ACK   --&gt; Unused</td>
</tr>
</tbody>
</table>

**5.3.5.3 Processing upon change of status**

The change of status of a connection (raw data tags) has to be notified to the Format DLL. This is performed by the MIdReceiveMsg function.

<table>
<thead>
<tr>
<th>Status Change From - To</th>
<th>Processing in the S7PMC Format DLL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faulty - OK</td>
<td>Pass to the PLC logon message frames for all S7PMC messages categories for which at least one message has been configured. Logon is performed for specific S7PMC message categories. The Format DLL already knows all the configured messages on account of their registration.</td>
</tr>
<tr>
<td>OK - Faulty</td>
<td>The Format DLL has to reject active jobs which have already been sent to the PLC but could not be fully processed any more owing to a change of status (acknowledgements missing).</td>
</tr>
</tbody>
</table>
5.3.5.4 Message update of the S7PMC Format DLL

In the case of message update, the S7PMC Format DLL reads the message status of all the messages notified to it by means of registration and sends it as a single message to AlarmLogging. This means that it is possible to build on a consistent message picture upon system start-up.

A message update is necessary when
- a change of status from Faulty to OK has been detected (that is the implicit case upon system start-up as well)
- the PLC sends a "message update message frame" to the PLC. This message frame is sent to every logged on node when, for example, message overflow is determined when messages are acknowledged or released by other nodes.

During a message update, the PLC sends the message acknowledgement states and the disable IDs. The supplementary values and the time are not sent. The Format DLL supplies the time of the single message in this case with the current system time or writes the ID MSG_STATE_UPDATE to the message status.

5.3.5.5 Formatting archive tags

The Format DLL makes two functions available for TagLogging:
- derivation of individual archive tag values from the contents of a raw data tag
- disabling/to enabling archive tags

5.3.5.6 Derivation of individual archive tag values

The contents of a raw data tag (of a message frame) may store archive tag values. The Format DLL has to interpret this S7PMC-specific message frame and forward the resultant archive tag values to TagLogging.

Process value converters can also be sent for an archive tag. The S7PMC Format DLL then performs the requisite conversion from process value to archive tag value. This process involves scaling functions which already exist in WinCC. The precise procedure has still to be determined.

The PdeReceive function is invoked by TagLogging every time the status of the raw data tag has changed; this means when the Faulty status following OK is or the other way round is determined by DM. The change of status of the raw data tag (corresponding to a connection) is of importance only for the S7PMC Format DLL. Further details are provided in the section entitled "Processing upon change of status".
PdeReceive

```
include <winccnrm.h>

BOOL PdeReceive (                  
    LPDM_VAR_UPDATE_STRUCT        lpDmVarUpdate,  
    TagLogging_ARCHIVE_CALLBACK   lpfnCallBack,   
    LPVOID                        lpUser,         
    LPCMN_ERROR                   lpError            
);
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lpDmVarUpdate</td>
<td>Pointer to raw data tag</td>
</tr>
<tr>
<td>lpfnCallBack</td>
<td>Pointer to Callback routine with which the Format DLL transfers the</td>
</tr>
<tr>
<td></td>
<td>individual archive tag values to TagLogging.</td>
</tr>
<tr>
<td>lpUser</td>
<td>Pointer to user data, transferred unmodified to Callback</td>
</tr>
<tr>
<td>lpError</td>
<td>Pointer to WinCC error structure</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Return</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>Function successful</td>
</tr>
<tr>
<td>FALSE</td>
<td>Error in API function, description of error cause via the pointer lpError</td>
</tr>
</tbody>
</table>

The Callback function for sending individual archive tag values to TagLogging is supplied as follows:

```
BOOL (*PDE_ARCHIVE_CALLBACK) (                  
    LPTSTR        lpszArcVarName,  
    double        doValue,         
    SYSTEMTIME*   lpstTime,       
    DWORD         dwFlags,         
    DWORD         dwData,          
    LPVOID        lpUser,          
    LPCMN_ERROR   lpError          
);
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lpszArcVarName</td>
<td>Archive tag value as from raw data ID</td>
</tr>
<tr>
<td>doValue</td>
<td>Archive tag value</td>
</tr>
<tr>
<td>lpstTime</td>
<td>Pointer to time stamp derived from the useful data of the raw data tag</td>
</tr>
<tr>
<td>dwFlags</td>
<td>IDs whose precise meaning still has to be defined.</td>
</tr>
<tr>
<td>dwData</td>
<td>Additional date that was also provided upon registration, transferred</td>
</tr>
<tr>
<td></td>
<td>without modification</td>
</tr>
<tr>
<td>lpUser</td>
<td>Pointer to user data, applied without modification by function call</td>
</tr>
<tr>
<td>lpError</td>
<td>Pointer to WinCC error structure</td>
</tr>
</tbody>
</table>
### 5.3.5.7 Disabling/enabling archive tags

With this function, TagLogging avails itself of the possibility in S7PMC of controlling the reception of archive tag values. The S7PMC Format DLL then creates a call to log off the archive concerned or to log it on again and forwards this call via NORM_SEND_PROC to the DM.

From the point of view of the S7PMC Format DLL, disabling/enabling of archive tags is virtually identical to the functions which are required for registering an archive tag. For both functions, the same function is called in the Format DLL (PdeSendMsg). A distinction is made between registration and disabling/enabling by means of the function ID dwFunctionId: with disabling/enabling, the supplementary data are meaningless for each archive tag lpdwData. Refer to the section entitled "Register all archive tags".

### 5.3.5.8 Processing upon change of status

The change of status of a connection (raw data tag) must be notified to the Format DLL; this is done by using the function PdeReceive.

<table>
<thead>
<tr>
<th>Status Change From - To</th>
<th>Processing in the S7PMC Format DLL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faulty - OK</td>
<td>Logon message frames for all archive tags of all connections. The Format DLL already knows all the configured archive tags on account of their registration.</td>
</tr>
<tr>
<td>OK - Faulty</td>
<td>The Format DLL has to reject active jobs which have already been sent to the PLC but could not be fully processed any more owing to a change of status (acknowledgements missing).</td>
</tr>
</tbody>
</table>
5.4 Creating picture modules for WinCC

This chapter does not exist any more. It is replaced by the documentation for the WinCC Option: *IndustriaIX*. 
5.5 Global Library

- Button Picture
- Buttons 3D
- Buttons Language
- Controller
- Conveyor
- DIN30600
- E-Symbols
- ISA_Symbols
  - isa_s55a
  - isa_s55b
  - isa_s55c
  - isa_s55d
  - isa_y32a
  - isa_y32b
  - isa_y32c
  - isa_y32d
  - isa_y32e
  - isa_u32f
  - isa_u32g
  - isa_y32h
  - isa_y32i
- Keyboards
- Miscellaneous
- Miscellaneous
- Motors
- Motors 3D
- PC / PLC
- Pipe
- Pumps
- Scaling
- Shut_off_devices
- Shut_off_valves
- SMART Objects
  - Display
  - Inci_Deci Buttons
  - Meters
  - Pipes
  - Slider Panels
  - Tanks
  - Toggle Buttons
  - Valves
- Textfields
- Valve
- Valve 3D
- Windows
- Project Library
5.5.1 Shut-off devices

01 02 03 04 05 06 07
08 09 10 11 12 13 14
15
5.5.2 Shut-off valves

01  02  03  04  05  06  07
08  09  10  11  12  13  14
15  16  17  18  19  20  21
22
5.5.3 Smart objects

5.5.3.1 Displays

- 8-Bit Display
- 8-Bit Display + I/O Field
- Digital output

5.5.3.2 Slider panels

- 1_Slider
- 2_Slider
- 4_Slider

5.5.3.3 Incr_Decr buttons

- Decrement_1
- Decrement_Step
- Increment_+1
- Increment_+Step

5.5.3.4 Pipes

- 3D Pipe angle
- 3D Pipe horizontal
- 3D Pipe vertical
5.5.3.5 Tanks

Tank1  Tank2  Tank3  Tank4
5.5.3.6 Toggle buttons

5.5.3.7 Valves

5.5.3.8 Meters
5.5.4 Button pictures

- Acknowledgement
- Alarm logging
- Alarm logging
- Archives
- Archives
- Arrow
- Arrow
- Arrow back
- Arrow down
- Arrow left
- Arrow right
- Arrow up
- Camera
- Chinese Star
- Curve
- Curve
- Diagnosis
- Help
- Horn
- Horn
- Info
- Language
- Password
- Password
- Plant_CONF.0
- Plant_CONF.1
- Print job
- Print job
- Shut down
- Shut down
- User Administrator
- User Administrator
- World
5.5.5 Buttons 3D

01 02 03 04 05 06 07
08 09 10 11 12 13 14
15 16 17 18 19 20 21

Text
5.5.6 Buttons language

Language D-USA  Language en

Change Language

- german
- english (U.S.)
- french
- spanish
- italian
- chinese
5.5.7 DIN30600

Diagram of various symbols and icons related to DIN30600.
5.5.8 E symbols
5.5.9 Windows

1 2 3 4 5 6
5.5.10 Conveyors

1  2  3  4  5  6
5.5.11 ISA symbols

5.5.11.1 isa_s55a

5.5.11.2 isa_s55b

5.5.11.3 isa_s55c
5.5.11.4  isa_s55d

5.5.11.5  isa_y32a

5.5.11.6  isa_y32b

5.5.11.7  isa_y32c
5.5.11.12 isa_y32h

5.5.11.13 isa_y32i
5.5.12 Keyboards

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>Keyboard char</th>
<th>Keyboard Nr.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

```
<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q</td>
<td>W</td>
<td>E</td>
<td>R</td>
<td>T</td>
<td>Z</td>
<td>U</td>
<td>I</td>
<td>O</td>
<td>P</td>
</tr>
<tr>
<td>A</td>
<td>S</td>
<td>D</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td>X</td>
<td>C</td>
<td>V</td>
<td>B</td>
<td>N</td>
<td>M</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SHIFT</strong></td>
<td><strong>SHIFT</strong></td>
<td>[space]</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```
5.5.13 Motors

01
02
03
04
05
06
07
08
09
10
11
12
13
14
15
16
17
5.5.14 Motors 3D

B3  B5  Motor001  Motor002  Motor003  Motor004  Motor005

Motor006  Motor007
5.5.15 PC / PLC

PC  PLC S7 400  Screen WinCC1  Screen WinCC2
5.5.16 Pumps
5.5.17 Controller

DR 21

SIPART DR 21

PV  SP

OUT-Y

999.9

99
5.5.18 Pipes

01 02 03 04 05 06 07
08 09 10 11 12 13 14
15 16 17 18 19 20 21
22 23 24 25
5.5.19 Scaling
5.5.20 Text fields

Siemens Wincc  Text  Text-Password...
5.5.21 Valves
5.5.22 Valves 3D

Valve1  Valve2  Valve3  Valve4
Index

A

Abbreviations, 4-42
Access
   authorization, 3-56
   reading WinCC data, 5-9
to database, 3-49
Access security, 3-15  3-19  3-47
taking over the rights, 3-72
Accessing
database, 3-61
Acknowledgement
   messages, 3-80
Actions, 4-7
   creating, 4-3  4-11
   editor for, 4-8
   exporting, 4-14
   folder, 3-43
   importing, 4-14
   in WinCC, 4-4
   modifying, 4-6
   reusing, 4-6
   selection, 3-29
   specifying, 3-9
taking over, 3-60
testing, 4-13
   update cycles, 3-26
   updating in the picture, 3-23
   upon Open Picture, 5-4
ActiveX, 2-2  2-3  3-51  3-99
Addition, 4-24
Addressing
   indirect, 3-6  3-92
Adjustment
   computer properties, 3-52
Alarm
   dynamizing, 4-7
   general info on specification, 3-20
   in the control concept, 3-15
Alpha cursor, 3-15  3-78
Analog values
   displaying, 3-11
time, 3-99
ANSI, 4-3
API, 2-4  3-61  3-62  3-100
Application, 3-23
   Close, 3-46
   Integrating external applications, 2-3
   interface (API), 3-61
   Own, 2-2
Application window, 3-80  3-84
Application Window, 2-3
Application windows, 3-57
Archiving, 1-1  2-2  3-2  3-49
   archiving times, 3-23
   configuring, 3-54
Arithmetics, 4-24
Array, 4-35
Arrow keys, 3-79  3-82
ASCII, 4-16
Assignment lists, 3-62
Authorization, 3-51
Backup, 3-42
   WinCC data, 3-49
Basic, 2-2  3-99
   basic project, 3-54
Basic arithmetic operations, 4-28
Basic Process Control, 3-16  3-77  3-84
Basis
   basic project, 3-71
   for importing, 3-63
Bit map
taking over, 3-57
Bit message procedure, 3-20
Bit operations, 4-32
Boolean algebra, 4-26
Brackets, 4-5  4-41  4-66
Building
   picture buildup, 3-89
   links, 3-97
   picture buildup, 3-23
Bus system, 3-18
Buttons
   in the trend window, 3-84
Call
   functions, 4-5
Callback function
   for check-back message of the status of a
   write request, 5-66
Callback function for transferring read process values, 5-66
C-API, 2-4
Change
   with tag trigger, 3-27
Changing
of states, 3-35
picture cycle, 3-30
project properties, 3-52
trigger, 3-29
user cycle, 3-25
window cycle, 3-30
Channel
DLL, 3-51, 3-62
DLLs, 3-66
S7 PMC, 3-101
Character
string, 4-5
permissible characters in picture names, 3-7
permissible characters in tag names, 3-6
permissible in project name, 3-4
ChnStart, 5-63
Client, 2-4
Color
change, 4-75
colors in the project, 3-11
definition, 3-17
recognizing, 3-11
Color table, 5-15
Communication, 3-18, 3-56
between individual tasks, 3-27
changing online, 3-101
influence on updating, 3-26
interfaces, 3-51
process, 3-23
Computer
changing type, 3-100
folder for, 3-43
hot key, 3-80
settings, 3-46
Concept, 2-4
control, 3-12, 3-15
data backup, 3-48
prototype pictures, 3-90
Condition
in loops, 4-41
Conditional
case statement, 4-52
if statement, 4-50
statements, 4-41
Configuration
data of the, 3-42
dialog, 3-23, 3-51, 3-57, 3-93
dialog box, 3-28, 3-37
dynamization, 3-37
mode, 3-45
stipulations for, 3-2
Configuration Data, 2-3
Connection
indirect, 3-89
link list, 3-65
logical, 3-62
new, 3-89
serial with CP525, 5-14
setting up, 3-101
to tags, 3-92
to the process, 3-18
UPS, 3-48
Constraint	picture name, 3-7
Content
function body, 4-5
Contents, 1-2
pointers, 4-34
project folders, 3-42
Control, 3-12
event-driven, 3-18
trend window, 3-84
user errors, 3-10
via keyboard, 3-35
Control concept, 3-15
Control objects, 3-78
Controllable
control objects, 3-78
message window, 3-80
trend window, 3-84
Convention, 1-3
Conversion
dynamic dialog to C action, 4-1
single-user - multi-user, 3-54
Coros, 3-68
Creating
file with script, 4-57
message structure, 3-71
structure tag, 4-70
Cursor
alpha, 3-15
Alpha, 3-78
Customization
data for tag import, 3-66
picture updating, 3-23
Cycle time, 3-26

D
Data
backing up, 3-50
Configuration Data, 2-3
Data, 2-4
Data Maintenance, 2-3
data type, 4-34
import, 3-49
import from S5 or S7, 3-62
Data backup
requesting, 3-23
reusing, 3-54
separation, 3-42
storage, 3-4, 3-21
update, 3-18

Data export
concept for, 3-48
using C action, 5-12

Database
access with ISQL, 5-10
accessing with Access, 5-9
accessing with Excel, 5-6
accessing with Scope, 5-11
backup, 3-49
change, 3-54
Query Language, 2-4
reconstruction, 3-41
selection in, 5-13

DDE, 2-2
Declaration, 4-11, 4-66
Decrementation, 4-24

Default
contents of WinCC default folder, 3-39
cycles, 3-27
folder, 3-4
installation path, 3-39
language, 3-40
settings, 3-3, 3-23, 3-24
Trigger, 3-33

Definition
C structures, 4-65
notation of pointers, 4-34

Demands, 3-10
Development, 2-2
Development environment, 3-43, 3-99, 4-3
Diagnose
Scope, 5-5
Diagnostics, 4-2, 4-13
file for importing, 3-63
files, 3-39

Dialog
configuration, 3-23, 3-57
Dialog box
Configuration, 3-37
Direct connection, 3-77
Direct link, 3-23, 3-37, 3-91, 3-96
Displaying
source code, 4-77
Division, 4-24
DLL, 4-1, 4-7

Documentation
1-1, 1-2, 3-2
Drive

for data backup, 3-49
Dynamic
changing the object properties, 3-35
instance, 3-94
linking of tags, 3-92
Dynamic dialog, 3-23, 3-27, 3-37
Dynamic wizard, 3-93
Dynamic Wizard, 3-23, 3-28, 3-37, 3-89
Dynamics
type, 3-27
Dynamization
configuration, 3-37
in WinCC, 3-35
objects, 3-37
types, 3-23
user object, 3-93
Dynamizing
events, 3-36
properties, 3-35

E
Editor, 4-5, 4-8
Einlesen
S5 7 S7 Variablen, 3-61
EN 60073, 3-17
Endless loops, 4-42
Entry
means, 3-15
Error
messages, 3-52
operator errors, 3-42
troubleshooting, 3-39

Errors
error message, 3-52
operator errors, 3-42
troubleshooting, 4-6

Event
driven, 3-18
dynamizing, 3-36
function header of an, 4-4
trigger, 3-23, 3-31, 3-33
Excel, 3-6, 3-21, 3-64, 3-66, 3-68, 3-71
reading data with MSQuery, 5-6

Execute
tag import - export, 3-64
Execution
of scripts, 3-31
Exit
input, 3-79
WinCC, 3-45, 3-48
Export, 3-6, 3-41, 3-49, 3-59, 3-63
actions, 4-14
functions, 4-14
Index

Extension
for actions, 3-60
WinCC files, 3-42

F
Fcclose, 4-57
Fgets, 4-63
Fields, 4-35, 4-66
FILE, 4-56
Files
file operations in C, 4-56
in default folder, 3-39
in project folder, 3-42
Float, 4-16
Floating-point numbers, 4-16
Folder
data in WinCC folder, 3-40
for Startup, 3-45
project folder, 3-4
Project Folder of WinCC, 3-42
project library, 3-60
structure of WinCC, 3-21, 3-39
tools for WinCC, 3-62
Font
color, 3-17
size, 3-2, 3-13
type, 3-2
Fprintf, 4-57
Frame
time frame, 3-84
Fscanf, 4-57
Function key, 3-73
Functionality, 1-1
Alarm Logging toolbar, 3-84
picture modules, 3-95
Tag Logging toolbar, 3-86
Functions
access security, 3-47
API, 3-61
body, 4-5
creating, 4-11
editor, 4-8
exporting, 4-14
header, 4-4
importing, 4-14
in WinCC, 4-4
internal, 3-26, 4-6
operator, 3-19
project, 3-43, 4-6
standard, 3-39, 3-72, 4-5
structure, 4-4
taking over project functions, 3-72
testing, 4-13

G
Generate
Regenerate Header, 3-53, 3-57, 3-72, 3-98
Graphic
library, 3-91
Graphics
tools, 3-41
Group
tag group, 3-5
user group, 3-19, 3-72
user groups, 3-57

H
Hardcopy, 3-86
Header
generating, 4-11
Hiding
information, 3-11
Hierarchy
ccontrol, 3-15
in plants, 3-74
picture, 3-77
HMI, 1-1, 2-2, 2-5, 3-18, 3-45
Hot key, 3-74, 3-75, 3-80, 3-88

I
IF, 4-42, 4-50
Implementation, 1-2
Import, 3-6, 3-49, 3-61, 3-63
actions, 4-14
functions, 4-14
Importing
actions, 4-14
Incrementation, 4-24
Information
finding, 3-4
hiding, 3-11
in the picture, 3-10
Informix, 2-4
Ingres, 2-4
Initialization of a channel unit
parameter for the WinCC data manager, 5-66
Input
by means of a keyboard, 3-73
in I/O field, 3-78
standardised, 5-5
Installation
tools, 3-41
UPS, 3-48
WinCC, 3-51
WinCC installation path, 3-39
Instance, 3-94
creating, 3-94
Integer, 4-17
Integrating
OCX, 3-89
Interface
API, 3-61
Internal
functions, 3-26 3-39

K
Keyboard
control, 3-35
function keys, 3-76
hot key, 3-86
operation, 3-15
working with, 3-73
Keys
configured, 3-67
c control buttons, 3-57
function keys, 3-73
hot key, 3-75
in the message window, 3-82
key assignment, 3-79
key combination, 3-45
key settings, 3-79
keys section, 3-12 3-17

L
Language, 3-67
C, C++, 4-34
taking over, 3-67
Library
default, 3-40
project, 3-50 3-58 3-60
text, 3-67
License checks, 3-39
Link
to process tags, 3-97
Log
files, 3-39 3-44
Logic, 4-24
comparison, 4-24
Login, 3-88 3-102
Logoff, 3-102
Logout, 3-88
Loops, 4-41
Do while, 4-41
for, 4-42
While, 4-41

M
Management, 3-1
Measured value
acquisition, 3-54
archiving, 3-23
swapping, 3-41
taking over, 3-71
updating, 3-18
Memory, 4-35 4-66
Message
Alarm Logging, 3-17
message class, 3-17 3-69
message list, 3-80
Message window, 3-56 3-80 3-84
Messages, 2-3
backing up, 3-49
bit message procedure, 3-20
defining colors, 3-17
error, 4-13
message file, 3-69
message picture, 3-81
message procedure, 3-20
reading in, 3-69
sequenced reporting, 3-20
system messages, 3-39
taking over, 3-67 3-68
Modify
project functions, 4-6
Modifying
standard functions, 4-5
Modularity, 2-2
Module
Integrating, 2-2
Modules
picture module technology, 3-89
preconfigured, 3-58
Mouse
action for hot key, 3-75
dynamizing events, 3-36
working without a mouse, 3-73
Multiplication, 4-24
Multi-user
system, 3-13 3-48 3-51 3-54

N
Network, 3-49 3-51
Number, 4-5
decimal, 4-17
floating-point number, 4-16
integers, 4-16
number format, 4-13

O
OCX, 2-3, 3-51, 3-80, 3-99
        picture module, 3-89
        registration, 3-41, 3-99
ODBC, 2-2
OLE, 2-2
        links, 3-51
Online
        configuration, 3-100
        Opening, 3-15
Operable
        functions with access security, 3-47
Operating system, 3-18, 3-46, 3-48
Operating System, 2-2
Operation, 1-3, 3-15
Operating Sequence, 1-3
Operator Interface, 2-3
Operators, 4-24
Option Group
        controlling via a keyboard, 3-79
Options, 3-16, 3-41, 3-42, 3-77, 3-84
Oracle, 2-4
Order
        tab, 3-78
Orders
        tab, 3-15
Output
        in diagnostics window, 4-2
        standardised, 5-3
        test output, 4-13
Overview pictures, 3-15

P
Parameters
        default, 3-43
        diagnostics, 3-101
        for picture names, 3-7
        for printf, 4-17
        for project names, 3-4
        for screen resolution, 3-13
        for tag names, 3-6
        link, 3-62
        shutdown, 3-48
Password, 3-19, 3-47, 4-6
Performance, 1-1, 3-2, 3-18, 3-37, 3-54, 4-1
Picture
        buildup, 3-23, 3-89
        change, 3-74

changing cycle, 3-30
cycle, 3-25
hierarchy, 3-77
information in the picture, 3-10
message picture, 3-81
module technology, 3-89
names, 3-7
object, 3-35
Open, 3-57
opening, 3-15, 3-80, 3-84, 3-98
picture window buildup, 3-96
picture window contents, 3-57
reducing data volume, 4-6
size, 3-13
taking over of, 3-55
updating, 3-23
Plant picture
        dynamization, 3-37
        working without a mouse, 3-73
Platform, 2-2
Pointer instrument, 3-11, 3-94
Pointers, 4-34
        in C, 4-34
Prerequisite, 1-2
Printf, 4-2, 4-13, 4-17
Process
        communication, 3-23
        connection, 3-18
        control, 3-12
        hierarchy of control, 3-15
        tags, 3-92
Process data, 3-23
Process Data, 2-4
        Archiving, 2-2
Program
        for database, 3-41
        for taking over data, 3-62
        special, 3-61
Startup, 3-45
        supplementary programs, 3-51
        tools, 3-6
Programming Interface, 2-4
Project
        automatic startup, 3-45
        backing up, 3-49
Copy, 3-51
        create a function, 4-11
        cross-project functions, 3-40, 4-5
        environment, 3-42
        example project, 3-3
        folder, 3-42, 4-12
        functions, 4-6
        library, 3-60, 4-14
        maintenance-friendly, 3-26
Properties of a channel unit
- Access to a remote tag, 5-67, 5-74
- Client functionality, 5-67, 5-74
- Diagnostic options, 5-67, 5-74
- Edit channel properties, 5-67, 5-74
- No registration of WinCC tags, 5-67, 5-74
- Online registration of logic operations, 5-67, 5-74
- Online registration of WinCC tags, 5-67, 5-74
- Process values in INTEL byte sequence, 5-67, 5-74
- Reentrant, 5-67, 5-74
- Separate cycle management, 5-67, 5-74
- Separate life character monitoring, 5-67, 5-74
- Separate restart display, 5-67, 5-74
- Time slave, 5-67, 5-74
- Time-of-day master, 5-67, 5-74
- Write to bit addresses, 5-67, 5-74
- Write to byte addresses, 5-67, 5-74

Property
- dynamize on object, 3-26
- function header of a, 4-4
- object, 3-24

Prototype, 3-89, 3-90, 3-93, 3-95

Q
Querying
- keyboard code, 3-77

R
Range
- range of values, 3-37
- value range, 4-16
Reading in
- messages, 3-69
Recommendation
- for update cycles, 3-27
Reconstruction
- database, 3-41
Reference
- in picture modules, 3-91, 3-98
- in pictures, 3-56
- text reference, 3-68
Registering
- OCX, 3-41, 3-99

Registration
- OLE, OCX, 3-51
Requesting
- data, 3-23
- data from data manager, 3-26
- event of an object, 3-36
Requirements, 1-1
Resolution
- screen, 3-13
Restriction
- for data transfer, 3-56
- tag name, 3-6
Restrictions
- in online configuration, 3-100
Result
- dynamization, 3-38
- outputting, 4-17
Return value, 4-4, 4-54
Ring buffer
- for pictures, 3-15
Runtime, 3-93, 3-98
- control during, 3-78
- cursor, 3-79
- data, 3-43
- dynamization, 3-35
- dynamization during, 3-35
- restrictions in online configuration, 3-100
- settings for, 3-46
- specifications for, 3-2

S
Sample project, 3-54
- C Course, 4-2
- language, 3-3
- screen resolution, 3-13
Sample Project, 1-1
Scope, 5-5
- accessing the WinCC database, 5-11
Screen resolution, 3-13
Scripts, 3-9
- development environment, 4-3
- editors for, 4-8
- executing, 3-31
- for wizard, 3-40
- language, 4-1
- syntax, 4-3
Section
- keys section, 3-17
- screen, 3-12
- workspace, 3-14
Select, 3-28
Selecting
tags, 3-5
Selection, 1-3 3-29 3-81
messages, 3-20
pictures for status displays, 3-57
trigger, 3-23
Sequenced reporting, 3-20
Setting up connection, 3-101
folder structure, 3-21
Shutdown, 3-48
Single-user system, 3-13 3-48 3-54
SmartTools, 3-6 3-41 3-51 3-62
Solution automatic project startup, 3-45
Solution Approach, 1-1
Solution Approach, 2-2
Solution Suggestion, 1-1
Source code displaying, 4-77
Special character, 3-7 4-17
Specifications for taking over data, 3-66
SQL, 2-3 2-4
database, 3-46
programming, 3-62
tools, 3-41
Standard C, 4-3
functions, 3-50 4-5
keys, 3-76
Start screen, 4-1
WinCC automatically, 3-45
Startup automatic, 3-45
entry in the folder, 3-45
system messages on, 3-39
Startup list, 4-12
State change, 3-20
displaying states, 3-11
on exiting, 3-45
Statement conditional, 4-41 4-50
Status status display, 3-57
String, 4-35 4-40
Structure, 1-2
C structure, 4-66
Configuration Manual, 1-2
control concept, 3-16
creating structure for messages, 3-71
database, 3-54
for data storage 3-21
functions, 4-4
picture names, 3-7
text lists, 3-64
WinCC, 2-2
WinCC project folder, 3-42
WinCC system folder, 3-39
Structures, 4-65
Structuring corporate standard, 3-2
tag management, 3-5
tags, 3-5
Subtraction, 4-24
Swapping messages, 3-41
Switch, 4-43
Sybase, 2-3 3-46
Symbol exporting, 3-60
for type of dynamization, 3-35
stored under, 3-40
taking over, 3-57
Syntax, 4-3
text error, 4-13
messages, 4-13
System automatic startup, 3-45
environment, 3-39
Layout, 3-50
load, 3-23 3-27 3-34
messages, 3-39
Modules, 2-2
multi-user, 3-13 3-51 3-54
operating system, 3-18
Platform, 2-2
single-user, 3-13 3-54
Software, 3-51
tags, 3-6 3-56

T
Tab order, 3-78
Tab orders, 3-15
Table window, 3-56 3-84
Tags archive tags, 3-85
displaying information in the picture, 3-90
import - export, 3-49
importing from S5/S7, 3-62
in C, 4-15
in scripts, 3-6
link, 3-37
message about missing, 3-39
name, 4-16
<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>permissible names</td>
<td>3-6</td>
</tr>
<tr>
<td>references in pictures</td>
<td>3-56</td>
</tr>
<tr>
<td>simulation</td>
<td>3-44</td>
</tr>
<tr>
<td>specification</td>
<td>3-5</td>
</tr>
<tr>
<td>structure of the exported lists</td>
<td>3-64</td>
</tr>
<tr>
<td>taking over</td>
<td>3-61</td>
</tr>
<tr>
<td>transferring to external storage</td>
<td>3-62</td>
</tr>
<tr>
<td>trigger</td>
<td>3-23, 3-25, 3-27, 3-33</td>
</tr>
<tr>
<td>types</td>
<td>4-16</td>
</tr>
<tr>
<td>value range</td>
<td>4-16</td>
</tr>
<tr>
<td>Target group</td>
<td>4-1</td>
</tr>
<tr>
<td>Task change of task</td>
<td>3-26</td>
</tr>
<tr>
<td>task bar</td>
<td>3-46</td>
</tr>
<tr>
<td>Tasks</td>
<td>1-1</td>
</tr>
<tr>
<td>project team</td>
<td>3-54</td>
</tr>
<tr>
<td>Template</td>
<td></td>
</tr>
<tr>
<td>for private projects</td>
<td>3-3</td>
</tr>
<tr>
<td>message window</td>
<td>3-81</td>
</tr>
<tr>
<td>pictures</td>
<td>3-95</td>
</tr>
<tr>
<td>Terms</td>
<td>2-5</td>
</tr>
<tr>
<td>Text display</td>
<td>3-11</td>
</tr>
<tr>
<td>identifying on the screen</td>
<td>3-11</td>
</tr>
<tr>
<td>lists</td>
<td>3-64</td>
</tr>
<tr>
<td>multilingual</td>
<td>3-67</td>
</tr>
<tr>
<td>text library</td>
<td>3-102</td>
</tr>
<tr>
<td>text lists</td>
<td>3-61, 3-79</td>
</tr>
<tr>
<td>Time cycle</td>
<td>3-23, 3-26, 3-32</td>
</tr>
<tr>
<td>Time trigger</td>
<td>3-31</td>
</tr>
<tr>
<td>Tool tip</td>
<td>3-14</td>
</tr>
<tr>
<td>Toolbar</td>
<td></td>
</tr>
<tr>
<td>Alarm Logging</td>
<td>3-80, 3-83</td>
</tr>
<tr>
<td>Tag Logging</td>
<td>3-84</td>
</tr>
<tr>
<td>Tools</td>
<td></td>
</tr>
<tr>
<td>database</td>
<td>3-49</td>
</tr>
<tr>
<td>graphics</td>
<td>3-41</td>
</tr>
<tr>
<td>languages</td>
<td>3-67</td>
</tr>
<tr>
<td>OCX</td>
<td>3-51</td>
</tr>
<tr>
<td>SQL</td>
<td>3-41</td>
</tr>
<tr>
<td>tag import - export</td>
<td>3-62</td>
</tr>
<tr>
<td>tag import/export</td>
<td>3-6</td>
</tr>
<tr>
<td>WinCC</td>
<td>3-41</td>
</tr>
<tr>
<td>Transaction-Secured</td>
<td>2-3</td>
</tr>
<tr>
<td>Transferring to external storage</td>
<td></td>
</tr>
<tr>
<td>tags</td>
<td>3-23</td>
</tr>
<tr>
<td>time controlled</td>
<td>3-32</td>
</tr>
<tr>
<td>Truth table</td>
<td>4-26</td>
</tr>
<tr>
<td>Turning off</td>
<td></td>
</tr>
<tr>
<td>runtime cursor</td>
<td>3-79</td>
</tr>
<tr>
<td>U</td>
<td></td>
</tr>
<tr>
<td>UNIX</td>
<td>2-4</td>
</tr>
<tr>
<td>Updating</td>
<td></td>
</tr>
<tr>
<td>cycles</td>
<td>3-18</td>
</tr>
<tr>
<td>setting options</td>
<td>3-23</td>
</tr>
<tr>
<td>types of</td>
<td>3-26</td>
</tr>
<tr>
<td>UPS</td>
<td>3-48</td>
</tr>
<tr>
<td>User</td>
<td>2-3, 3-10</td>
</tr>
<tr>
<td>authorization</td>
<td>3-102</td>
</tr>
<tr>
<td>groups</td>
<td>3-19, 3-72</td>
</tr>
<tr>
<td>rights</td>
<td>3-19</td>
</tr>
<tr>
<td>taking over the rights</td>
<td>3-72</td>
</tr>
<tr>
<td>User Data Records</td>
<td>2-3</td>
</tr>
<tr>
<td>User archive</td>
<td>3-56, 3-100</td>
</tr>
<tr>
<td>dynamizing</td>
<td>4-7</td>
</tr>
<tr>
<td>taking over</td>
<td>3-71</td>
</tr>
<tr>
<td>User cycle</td>
<td>3-25, 3-32</td>
</tr>
<tr>
<td>User interface</td>
<td>3-2</td>
</tr>
<tr>
<td>specifying</td>
<td>3-10</td>
</tr>
<tr>
<td>User library</td>
<td>3-76</td>
</tr>
<tr>
<td>User object</td>
<td>3-93, 3-94, 3-97, 3-98</td>
</tr>
<tr>
<td>in picture module technology</td>
<td>3-89</td>
</tr>
<tr>
<td>taking over</td>
<td>3-58</td>
</tr>
<tr>
<td>wizard</td>
<td>3-95</td>
</tr>
<tr>
<td>Users</td>
<td></td>
</tr>
<tr>
<td>user-defined time cycles</td>
<td>3-24</td>
</tr>
<tr>
<td>V</td>
<td></td>
</tr>
<tr>
<td>VDE 0199</td>
<td>3-17</td>
</tr>
<tr>
<td>Visual</td>
<td></td>
</tr>
<tr>
<td>Basic</td>
<td>2-2, 3-99</td>
</tr>
<tr>
<td>C</td>
<td>4-13</td>
</tr>
<tr>
<td>C++</td>
<td>2-2, 3-99</td>
</tr>
<tr>
<td>Visualization</td>
<td>2-2</td>
</tr>
<tr>
<td>station</td>
<td>3-23</td>
</tr>
<tr>
<td>W</td>
<td></td>
</tr>
<tr>
<td>While</td>
<td>4-41</td>
</tr>
<tr>
<td>WinCC</td>
<td></td>
</tr>
<tr>
<td>actions</td>
<td>3-9</td>
</tr>
<tr>
<td>alarm message reporting</td>
<td>3-20</td>
</tr>
<tr>
<td>API</td>
<td>3-61</td>
</tr>
<tr>
<td>automatic startup</td>
<td>3-45</td>
</tr>
</tbody>
</table>
Index

control concept, 3-15
copy project, 3-51
data backup, 3-49
default folder, 3-39
default settings, 3-3
dynamization, 3-35
Exit, 3-48
folder structure, 3-42
log files, 3-39
project environment, 3-42
project name, 3-4
scripts, 3-9
Structure, 2-2
system environment, 3-39
tag management, 3-5
taking over action, 3-60
Taking over tags, 3-61
tools, 3-41
update cycle, 3-24
user interface, 3-10
Version 1.10, 3-70

Window

changing windows, 3-80
cycle, 3-25, 3-26, 3-30
diagnostics, 4-2, 4-13
error window, 4-13
Windows, 2-2
Windows 95, 3-18
Windows NT, 3-18
Wizard
adopting a script, 3-101
files in default folder, 3-40
for dynamizing objects, 3-37
for picture updating, 3-23
in user objects, 3-93
read in Coros messages, 3-69
reading in S5/S7 tags, 3-61
Working
using function keys, 3-74
with a keyboard, 3-77
without a mouse, 3-73
Workspace, 3-14
Wrebuild, 3-41
Wunload, 3-41